Installation and System Configuration
Version 7.0
# Contents

## Chapter 1: Getting Started with Installation

<table>
<thead>
<tr>
<th>Information You Need</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Requirements</td>
<td>2</td>
</tr>
<tr>
<td>Additional Sources of Information</td>
<td>3</td>
</tr>
<tr>
<td>Customer Support</td>
<td>4</td>
</tr>
<tr>
<td>Choosing an Installation Method</td>
<td>5</td>
</tr>
<tr>
<td>Starting the Installation</td>
<td>6</td>
</tr>
<tr>
<td>Prerequisites for Installation</td>
<td>6</td>
</tr>
<tr>
<td>Opening the Installation Screen</td>
<td>6</td>
</tr>
<tr>
<td>Third-Party Utilities and Program Updates</td>
<td>7</td>
</tr>
</tbody>
</table>

## Chapter 2: Overview of Installation

<table>
<thead>
<tr>
<th>Sage MAS 500 Structure</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sage MAS 500 Architecture</td>
<td>10</td>
</tr>
<tr>
<td>Sage MAS 500 Databases</td>
<td>11</td>
</tr>
<tr>
<td>Client Systems</td>
<td>12</td>
</tr>
<tr>
<td>Additional Internet and Intranet Interfaces</td>
<td>13</td>
</tr>
<tr>
<td>Security</td>
<td>13</td>
</tr>
<tr>
<td>Sage MAS 500 Installation</td>
<td>14</td>
</tr>
<tr>
<td>Installation Process</td>
<td>14</td>
</tr>
<tr>
<td>Upgrade Process</td>
<td>15</td>
</tr>
<tr>
<td>Registration Process</td>
<td>16</td>
</tr>
</tbody>
</table>
Contents

Registration Grace Period............................................................. 19
Number of Systems per License ................................................... 20
Additional Software to Install...................................................... 21

Chapter 3:  Express Installation.................................................23
  Introducing Express Installation.................................................. 24
  Prerequisite Steps ......................................................................... 26
  Running Express Installation....................................................... 27
  Installing on a System with an Existing Installation .................. 29
  Changing or Removing Express Installation ............................... 31
  Continuing Setup......................................................................... 32

Chapter 4:  Database Creation and Upgrade .........................33
  Using the Database Express Installation.......................................34
    Running the Database Express Installation.......................... 34
  Installing the Database Utilities................................................37
    Preliminary Steps ......................................................................... 38
    Demo Data ................................................................................... 39
    Installation Flow Chart ................................................................. 40
    Installing the Database Utilities.................................................. 41
  Creating New Databases ..............................................................45
    Starting the Database Creation Utility ......................... 45
    Which Databases to Create......................................................... 46
    Database Naming Requirements................................................. 46
    Default Administrative Logon .................................................. 48
    Procedure for Creating Databases ......................................... 49
  Upgrading Existing Databases .................................................53
    Overview of the Upgrade Process .............................................. 53
    Upgrading Customized Databases .......................................... 54
    Adding Databases to an Existing Installation ...................... 55
    Preliminary Steps ......................................................................... 56
    Starting the Database Upgrade Utility .............................. 58
    Comparing Databases ................................................................. 59
    Upgrading Databases ................................................................. 62
  Establishing a Maintenance Plan .................................................66
    Starting the Database Maintenance Wizard .......................... 66
    Setting Up Database Maintenance ........................................... 67
Chapter 5: Client Installation .................................................. 73

Preliminary Steps ..................................................................... 74
Options for Installing Client Software ...................................... 74
Preliminary Steps for Upgrades ................................................. 75
Prerequisite Steps for Clients on SQL Server ............................ 75
Prerequisite Steps for Manufacturing ....................................... 76
Use of Windows Installer ......................................................... 76
Preinstallation Checklist for Client Installation ......................... 76
Installing the Client Software ............................................... 78
Installing Client Software ....................................................... 78
Registering the DLL File for Microsoft Office .......................... 82
Changing the Installation ......................................................... 83
Terminal Services Installation ................................................. 85
Precautions on Using Terminal Services .................................. 85
Using Add/Remove Programs ................................................. 85
Using the Change User Function ............................................. 86
Completion of Client Installation .......................................... 88
Sage MAS 500 Shortcuts ......................................................... 88
ODBC, Registry, and OLE DB Additions .................................. 89
Installing Crystal Reports Designer ........................................ 90
Overview .................................................................................. 90
Prerequisites ........................................................................... 90
Installing Crystal Reports Designer ........................................ 91

Chapter 6: Registration and Security .................................... 93

Starting Sage MAS 500 as an Administrator ............................ 94
Default Logon .......................................................................... 94
Logging on to Sage MAS 500 as an Administrator ..................... 95
Registering the Software ......................................................... 97
Prerequisite Steps .................................................................. 97
Registration Procedure ......................................................... 99
Registration Renewals ............................................................ 104
Troubleshooting Automatic Registration ................................. 105
## Contents

### Setting Up Companies and Modules
- Information Used in Setting Up Companies
- Setting Up the Company
- Activating Modules
- Editing Companies
- Deleting Companies

### Setting Up Users
- Setting Up Security Groups
- Setting Up Users for Sage MAS 500
- Security Options
- Changing User Settings

### Chapter 7: Managing and Protecting Databases
- Using the Database Synchronization Utility
- Precautions
- Starting the Database Synchronization Utility
- Using the Utility
- Connecting the Client
- Options for Copying or Moving Databases
- Copying Data Between Companies
- Single-User Unique Set on Same SQL Server
- Multiuser Duplicate Set on Same SQL Server
- Multiuser Duplicate Set on a Separate SQL Server

### Chapter 8: System Configuration and Management
- Desktop Customizations
- Prerequisites for Making Administrative Customizations
- Changing and Saving Task Menus
- Setting Task Menus for Users
- Adding Custom Reports
- Search Form Customization
- System Management
- Setting the Business Date
- Monitoring System Usage
- Viewing System Settings
## Appendix A: Working with Reports

<table>
<thead>
<tr>
<th>System Manager Reports</th>
<th>158</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Activity Log</td>
<td>158</td>
</tr>
<tr>
<td>Maintenance Audit Log</td>
<td>159</td>
</tr>
<tr>
<td>Company Profile Report</td>
<td>160</td>
</tr>
<tr>
<td>Company User Group Permissions Report</td>
<td>160</td>
</tr>
</tbody>
</table>

### System Manager Lists

<table>
<thead>
<tr>
<th>List</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>User List</td>
<td>161</td>
</tr>
<tr>
<td>Security Group List</td>
<td>162</td>
</tr>
<tr>
<td>Company List</td>
<td>162</td>
</tr>
<tr>
<td>Site Profile List</td>
<td>162</td>
</tr>
<tr>
<td>Assisted Company Setup List</td>
<td>163</td>
</tr>
</tbody>
</table>

## Appendix B: Working with Microsoft Project Link

### Integration with Project Accounting

- Setup
  - Microsoft Project Setup

## Appendix C: Working with Sage MAS 500 Alerts

- SQL Server Agent
- SQL Server Mail

## Appendix D: Protocol Issues

<table>
<thead>
<tr>
<th>Protocol Issue</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Named Pipes over TCP/IP</td>
<td>174</td>
</tr>
<tr>
<td>Multi-Protocol over TCP/IP (Port 1434)</td>
<td>176</td>
</tr>
<tr>
<td>TCP/IP Sockets over TCP/IP Protocol</td>
<td>178</td>
</tr>
</tbody>
</table>

## Appendix E: Silent Installation

### Using Silent Installation

<table>
<thead>
<tr>
<th>Silently Installing Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>When to Use Silent Installation</td>
<td>182</td>
</tr>
<tr>
<td>Precautions</td>
<td>182</td>
</tr>
<tr>
<td>Installing with Defaults</td>
<td>183</td>
</tr>
<tr>
<td>Installing with Parameters</td>
<td>184</td>
</tr>
</tbody>
</table>

### Defaults and Parameters

- Client Installation: 186
Sage Software, Inc., the recognized leader in accounting software for mid-sized businesses, welcomes you to Sage MAS 500 ERP, business software that provides superior power, flexibility, and integration with your existing line of business applications.

This chapter provides information you need to start the installation and shows how to start the installation programs.

**In this chapter**
- Information You Need .......................... 2
- Choosing an Installation Method ............. 5
- Starting the Installation ......................... 6
Information You Need

Introduction

Sage MAS 500 is a powerful and feature-rich product that requires a number of steps to install.

This *Installation and System Configuration* guide describes the procedures for installing and configuring the system. It also includes procedures for the System Manager module, which is part of the installation and configuration process.

It is strongly recommended that you read this guide and additional sources of information before proceeding with the installation.

**Tip:** If you are viewing this document online in Adobe Acrobat, click any of the blue text to jump to the indicated heading or Web site.

System Requirements

Compatibility and Resource Guide

Read the *Sage MAS 500 Compatibility and Resource Guide* for information about system requirements, supported platforms, and recommended configurations. View the document on the Sage Software Web site at this address:

http://support.sagesoftwareonline.com/mas500/support/documents/compatibility.htm
Additional Sources of Information

Introduction

This section lists other Sage MAS 500 documentation you should read.

Implementation Planning guide

The Implementation Planning guide contains planning information that will help you perform a smooth implementation. The guide includes:

- Implementation process outline
- Implementation project guidelines
- Planning system security information
- Setup options for the modules
- Assisted Company Setup and conversion instructions

Additional installation guides

The following components have separate installation guides:

<table>
<thead>
<tr>
<th>Product</th>
<th>Installation Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>eCustomer, eSalesforce, eExecutive, and eTimesheets</td>
<td>Internet Applications guide</td>
</tr>
<tr>
<td>Web Reports</td>
<td>Web Reports guide</td>
</tr>
</tbody>
</table>

Customization Tools documentation

If you plan to customize the software, read the documentation provided with Sage MAS 500 Customization Tools to determine the extent of the customization and to plan how the customizations will be added.
# Customer Support

## Introduction
You can get customer support through the Sage Software Web site or telephone.

## Web site
The address of customer support is [www.sagesoftware.com/support](http://www.sagesoftware.com/support).

## Telephone
Contact customer support at the following telephone numbers:

<table>
<thead>
<tr>
<th>Country</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States and Canada</td>
<td>(800) 944-5481</td>
<td>(800) 378-6560</td>
</tr>
<tr>
<td>Other</td>
<td>(949) 788-5367</td>
<td>(949) 753-6084</td>
</tr>
</tbody>
</table>
Choosing an Installation Method

Overview

Introduction

There are several methods for installing the software. Use the flowchart to select the installation program you need to run. For installation instructions, see Starting the Installation on page 6.

Start

Are you only installing the client on this computer?

Yes

Run Express Installation (Chapter 4)

No

Are you installing a whole system on one computer?

Yes

Run the Client Installation (Chapter 6)

No

Are you upgrading databases on this system?

Yes

Install the Database Utilities (Chapter 5)

No

Are you copying and moving databases, or installing multiple database sets?

Yes

Create or upgrade databases (Chapter 5)

No

Run the Database Express Install to create databases (Chapter 5)

Finish
Starting the Installation

Overview

Introduction

This section shows how to start the installation and use the window that launches installation software.

Prerequisites for Installation

Internet Explorer requirement

If you are using Web Reports or the Internet Applications, you need Microsoft Internet Explorer. See the Web Reports and Internet Applications guides for more information. If you do not have a Web browser on your system, you can install the copy of Microsoft Internet Explorer provided on the Sage MAS 500 CD-ROM.

Opening the Installation Screen

Procedure

To start the installation, insert the Sage MAS 500 Installation CD-ROM into the CD-ROM drive. If Autorun is enabled for your CD-ROM drive, the Installation screen appears automatically.

If the program does not start immediately, use Windows Explorer and open the file Default.hta in a Web browser.

Using the Installation window

The Installation window appears. Click the button on the left to select the installation program or document to use.

Viewing guides

A number of documents are also provided in Adobe Acrobat format. These documents require Acrobat Reader 4.0 or higher.
Getting Started with Installation

Documentation about software installations

This *Installation and System Configuration* guide describes how to use the express installation of databases and all components, and the standard client and database utilities installation. For instructions on installing other Sage MAS 500 software, see the following guides:

- CRM Data Export and Internet Applications: See the *Internet Applications* guide.
- Web Reports: See the *Web Reports* guide.
- Schema Browser: See the *Development Utilities* guide of the Customization Tools.

Third-Party Utilities and Program Updates

Introduction

The installation window also enables you to install service packs and product updates required by Sage MAS 500.

The following third-party utilities and program updates are included on the Sage MAS 500 CD-ROM. Refer to the software manufacturer if you encounter any problems applying these updates.

Microsoft SQL Server Digital Dashboard

Install Microsoft SQL Server Digital Dashboard if you are using eExecutive. See the *Internet Applications* guide for instructions.

Internet Explorer Version 6.0

Internet Explorer version 6.0 is recommended for eExecutive, Web Reports, eCustomer, eExecutive, and eTimesheets.

Microsoft Data Access Components 2.6

Microsoft Data Access Components (MDAC) 2.6 is automatically installed during the Sage MAS 500 Client installation. You can also install MDAC 2.6 directly from the Sage MAS 500 CD-ROM. The MDAC installation contains the core components (ADO, OLE DB, and ODBC) and additional OLE DB providers and ODBC drivers for various data stores. Use these components to integrate information from a variety of both relational (SQL) and nonrelational sources.
| **RegClean** | Use the RegClean utility to remove program references when uninstalling Sage MAS 500 client versions prior to 4.0. |
| **Scripting** | The scripting components support the Customizer module. The Sage MAS 500 client installation automatically installs the portions of the scripting components required for Customizer. |
| **Microsoft Service Packs** | Use the links on the Installation screen to go to the appropriate pages of the Microsoft Web site where you can download or order the service packs. |
Overview of Installation

This chapter provides an overview of the installation process. This section will give you an understanding of how Sage MAS 500 works so that you can plan your installation.

In this chapter
Sage MAS 500 Structure ................................. 10
Sage MAS 500 Installation .............................. 14
Chapter 2

**Sage MAS 500 Structure**

**Overview**

**Introduction**

To help you in planning and preparing to install Sage MAS 500, this section explains the architecture used by the system and an overview of the processes for installing or upgrading a new system.

**Sage MAS 500 Architecture**

**Description**

Sage MAS 500 is a two-tier client/server application. The following figure shows an overview of the system, which is explained in the following sections.
Sage MAS 500 Databases

Types of databases
The core of the system are the databases containing the Sage MAS 500 information. A set of three databases are used that are interdependent and have a one-to-one relationship with each other:

- Application: This database contains three types of information.
  - System information shared by all modules (for example, user identification, security groups, and company information) and seed data used to activate modules.
  - Financial information shared by companies. More than one company can use the same database.
  - Information used by the eTimesheets application.
- eCustomer (formerly Internet Applications): This database replicates data used by eCustomer so that it can be accessed more quickly by users from the Web. Data is updated to and from Sage MAS 500. For more information, see the Internet Applications guide.
- Project Link: This database is used by Microsoft Project to access Project Accounting data.

Transaction logs
As with all SQL Server databases, the Sage MAS 500 databases have transaction logs.

Database maintenance
Treat all of the databases as one unit when performing maintenance. For example, all databases should be backed up at the same time.
SQL Server databases

Along with the Sage MAS 500 databases, you should also be aware of SQL Server databases that affect the access performance and security of Sage MAS 500 data:

- **tempdb**: The tempdb database is used for temporary data storage while data is being written to and from databases. For best performance, set the database sizes as recommended in Chapter 3, *System Requirements*.

- **master**: The master database contains all system-level information and identifies the presence of all databases on the SQL Server, including the Sage MAS 500 databases.

**Warning**: If the master database becomes corrupted, you can lose your data. Back up the master database and do not modify it manually.

### Client Systems

**Description**
The client systems serve as the front end to the Sage MAS 500 data. The client systems are connected to the server through a TCP/IP-compatible network, which can include local-area networks and remote connections.

**Parts of client systems**
To use the data, the systems need the Sage MAS 500 client software. The client software consists of the following:

- Applications (including COM objects and system DLLs) for accessing Sage MAS 500 data
- Crystal Reports runtime for generating reports
- Online Help

**Methods of installing client software**
You can install the client software in the following ways:

- Install the Sage MAS 500 client software directly on the system.
- Access the Sage MAS 500 client software through a system with Terminal Services.
## Additional Internet and Intranet Interfaces

**Description**
Web Reports and the Internet Applications enable users to access Sage MAS 500 data through the Internet or an internet by using a Web browser. For more information, see the *Web Reports* and *Internet Applications* guides.

## Security

**Description**
Several security measures are used to protect your crucial and confidential business data at the server and client.

**Security groups**
Security groups enable you to grant access to modules and tasks. For example, you can create a security group to grant invoice entry clerks read/write access to invoice entry windows and no access to any of the other features. You then grant access to individual users by assigning them to security groups.

**Logon requirements**
Users must log on to use Sage MAS 500. You can use either SQL Server authentication where users need to enter their SQL Server user name and password each time they start the software, or you can use Windows authentication that logs users on using their Windows user name and password.

To enable a user to log on to Sage MAS 500 using Windows authentication, set up the user in a Windows domain. When you add the user to Sage MAS 500, the system records the domain and logon name. A Windows authenticated logon is also created in the SQL Server.

After users have logged on Sage MAS 500 for the first time with Windows authentication, they can start the software without seeing the logon window.

**Application role**
You can set Sage MAS 500 to use an application role to grant access to databases only when the user is in the software. This is explained in *Chapter 6, Registration and Security*. 
Chapter 2

Sage MAS 500 Installation

Overview

Introduction

This section provides overviews of the installation and upgrade processes. Full procedures are described in the other chapters of this guide.

Installation Process

General steps

This section provides an overview of the steps you perform when you install Sage MAS 500 for the first time, or install it on a new server. Installation includes the following general steps, which are described in detail in this guide:

1. Complete tasks for planning and assessing system requirements. Make any upgrades that are necessary.

2. Create Sage MAS 500 databases by doing either of the following:
   - Run Express Installation to create databases and install the client software on the same system.
   - Run the Database Express Installation to create databases without installing software.
   - Install the Database Utilities and run the Database Creation Utility.

   See Choosing an Installation Method on page 5 to determine which installation method to use.

3. If you have not used Express Installation, use the Client Installation wizard to install the client software.

4. Run the Desktop Configuration Utility to set the database and server to access from the client software.

5. Run System Manager to register the software and grant access rights to your users.
Upgrade Process

General steps

If you are upgrading an existing system, follow a different set of steps from a fresh installation. These are described in detail in this guide. The following lists the general steps for performing an upgrade:

1. Prepare for the upgrade by doing the following:
   - Review the system requirements as shown in Chapter 3, System Requirements. The hardware and software requirements have changed.
   - Review the new software features described in the Release Notes. The new features may affect how you change the configuration and implementation of the software.
   - Back up your databases.
   - Upgrade SQL Server, if necessary.

2. Run the Database Utilities Installation to install components on your local drive for updating databases. When the Server Install is finished, you are prompted to run the Database Creation Utility. Click No.

3. Run the Database Upgrade Utility to upgrade the database to the new version. If your database schema has been customized, use the Database Upgrade Utility to run a comparison between your database and a standard database or another database. The utility can also generate custom database update scripts that can be used to retain your schema modifications.

4. Upgrade the client software by clicking Client Install. You can install the client software on each system or from a network share.

   **Note:** If you are upgrading Manufacturing versions previous to 6.1, uninstall the Manufacturing client software before installing the new client software. See Prerequisite Steps for Manufacturing on page 76.
5 Run the Desktop Configuration Utility to set the database and server to access from the client software. The Desktop Configuration Utility is in the Sage MAS 500 Utilities group in the Windows Start menu.

6 Run System Manager to register the software and grant access rights to your users.

Registration Process

Introduction

When you install a Sage MAS 500 database, the database can be used for evaluation purposes for 45 days. To use the database, it must be registered. You can register the database at any time. The registration process registers all the modules you purchased.

This section provides an overview of the registration process. For instructions on performing registration, see Chapter 6, Registration and Security.

About the registration system

When you purchase Sage MAS 500, Sage Software records information about the license you purchased in a central registration database. You submit a registration request to Sage Software to retrieve an encoded string that gives you access to the software according to your license.

With your package, you receive a packing slip with the following information:

- Customer number
- System Manager serial number
- System Manager unlocking key

If you are upgrading, use the customer number, System Manager serial number, and System Manager unlocking key from your current version of Sage MAS 500. If you are unable to get this information, contact Customer Support.
You enter this information into Sage MAS 500, which generates a registration request string based on your system and the software you have installed. The registration request string is sent back to Sage Software, either automatically or manually at the registration site. Sage Software returns a registration string that you enter into the software. This string gives you access to the modules and the number of users, companies, and other settings defined in your license.

The following figure shows the registration process:
Methods of registration

The following methods of registration are available:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>When to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The system sends registration information to Sage Software and automatically updates the system with the registration information.</td>
<td>If you want registration updates to be sent automatically.</td>
</tr>
<tr>
<td>Manual</td>
<td>Visit the registration Web site. Copy the Registration Request Message generated in the Maintain Site window and paste the Registration Message generated on the page.</td>
<td>If you do not have continuous Internet access and SQL Server scheduling. If automatic registration does not work because of a firewall that blocks messages. If you prefer full control over the registration process.</td>
</tr>
</tbody>
</table>

Registration renewal

You need to register the software again when it is time to renew your maintenance and support agreement. If you decide not to renew the maintenance and support agreement, you still need to register again to continue using the software after the registration grace period. You receive a new string that enables you to continue using the software, but you cannot install patches and updates.

Registration and hardware changes

The registration processes uses the SQL Server name, database name, the MAC address, customer number, SM serial number, and SM unlocking key to uniquely identify your installation. If any of this information is altered, the registration message becomes invalid and the system becomes unregistered.
During the logon, you will receive notification about your system's registration status and the number of days left in the registration grace period. If you do not register the system within the grace period, it will become unusable. (See *Number of Systems per License* on page 20 for an explanation about test systems.) Contact Sage Software to reinstate your production license.

Registration and fail-over clustering
If you configure your SQL Server for fail-over clustering, install the Sage MAS 500 Database Utilities on each fail-over SQL Server. This enables a production system to stay registered when a node is down because of failure or maintenance.

Registration Grace Period

Introduction
You have 45 days in which to register the software after the Sage MAS 500 databases have been installed. The 45-day grace period also applies after the registration expires. You need to renew registration within 45 days of the expiration of the maintenance and support agreement to continue using the software, whether or not you plan to continue the agreement.

Handling of unregistered modules
If Sage MAS 500 is not registered or if the registration has expired, a message window similar to the following appears when you log on.

![Message Window]

Click OK to continue to open the software.

If this message window appears even though the registration was renewed, Sage MAS 500 may have been unable to access the Sage Software registration system through the Internet.
Perform a manual registration or register from another client system. For more information, see Registration Procedure on page 99.

Access during the grace period

During the grace period, the following access is available to you:

- All modules available for activation.
- Data Migrator and DataPorter can only be used for demo data companies.
- Five concurrent users

**Note:** You must register the system in order to use Data Migrator and DataPorter. These features are not available during the grace period.

After the grace period

If you have not registered the modules within the 45-day grace period, you cannot access modules or the data in them until you register them. After that, you only have access to the modules you have registered, and you will lose any data you entered in modules you did not register. Therefore, do not activate modules you do not intend to register.

**Number of Systems per License**

Introduction

The number of systems you can have depends on your license type. To register a system, enter the customer number, SM serial number, and SM unlocking key, or the indicated word in the Maintain Site window. (See Registration Procedure on page 99 for instructions.)

As an end-user, you are automatically assigned a total of two systems:

- One production system
- One test system

Both systems have the same number of users, companies, eSalesforce users, and other settings granted by the license.
Overview of Installation

If you have a developer support license, you are assigned a development system in addition to the two end-user systems.

Production licenses
Use your production license for your actual production system accounting data. To register this production system, enter the customer number, SM serial number, and SM unlocking key from the packing list.

Test licenses
Use a test license for testing or training. It cannot be used for a production system. A test system by default is identical to the production license, except that a watermark appears on all reports.

Selecting a license type
To select a license type for an installation, use Maintain Site in System Manager. For information, see Registration Procedure on page 99.

Additional Software to Install

Introduction
With Sage MAS 500, you may have purchased other applications provided on the Sage MAS 500 CD. Instructions for installing these applications are in the following locations:

- For a new installation of the Crystal Report Designer, see Installing Crystal Reports Designer on page 90.
- To install the Internet Applications eCustomer, eTimesheets, eExecutive, and eSalesforce, see the Internet Applications guide.
- To install Web Reports, see the Sage MAS 500 Web Reports Installation guide.
- For a new installation or upgrade to FRx, refer to the FRx Installation Guide, which you can obtain from the FRx folder on the Sage MAS 500 third-party CD-ROM.
Abra Link is distributed by Sage Abra on their product CD-ROM. Fixed Assets Link is distributed by Sage FAS on their product CD-ROM. These integration links will import data directly into General Ledger Journal Transactions.

The FAS Asset Accounting Interface requires the installation of the Fixed Assets SDK located on the Sage MAS 500 Integration Tools and Utilities CD-ROM. You must have the Sage FAS windows client installed on your PC prior to installing the Fixed Assets SDK. After installation, activate the Fixed Assets Link in Maintain Companies to enable the integration.
Express Installation

Express installation installs the client software, default databases, and the Internet Applications on a single computer. This chapter explains when to use express installation and how to use it.

In this chapter
- Introducing Express Installation ........................................... 24
- Prerequisite Steps ................................................................. 26
- Running Express Installation ................................................. 27
- Installing on a System with an Existing Installation .................. 29
- Changing or Removing Express Installation .............................. 31
- Continuing Setup ................................................................. 32
## Introducing Express Installation

### Introduction
This section provides information that you need about express installation, including when to use it, when not to use it and use the standard installation method instead, and what is installed.

For more information about when to use Express Installation, see *Choosing an Installation Method* on page 5.

### When to use express installation
Use express installation if you are setting up a system on a single computer. This single-computer system can be used in the following ways:

- Demonstration
- Training
- Production for Small Business Edition only

### When to use standard installation
Use standard installation for these situations:

- Upgrading a Sage MAS 500 system
- Setting up training or evaluation system over several client and server computers
- Customizing the installation, such as using a different set of database names
- Installing software and databases in a different path from the default

To perform this installation, run separate installation programs for the database, client software, and Internet Applications.

### When to use both express and standard installation
You can also use both express and standard installation for a single system. For example, you can use express installation to install databases and Internet Applications on the Web server and then use the standard client installation on each workstation.
Express Installation

**What is installed**

Express installation installs and configures the following on the system:

- Sage MAS 500 client software with all modules.
- Database Utilities.
- For the Internet Applications:
  - All files for Internet Applications Web sites.
  - IIS applications for eCustomer, eExecutive, eSalesforce, and eTimesheets.
  - Web Reports.
  - COM+ application for eCustomer with MAS_500_USER as the user and a randomly generated password.
  - Data link files (.udl) for the Internet Applications with IAppUser as the user and a randomly generated password. IAppUser is also added as a user to the _iapp database.

See the *Internet Applications* and *Web Reports* guides for more information.

- If the system does not have SQL Server, Microsoft Data Engine (MSDE) is installed. If SQL Server is installed, express installation uses it and does not install MSDE.
- Databases MAS500_app and MAS500_iapp, which contain demo data as described in *Demo Data* on page 39. These are installed as follows:
  - If SQL Server is on the system, the databases, logons, and users are installed on it.
  - If SQL Server is not on the system, express installation automatically installs MSDE and then install the databases, logons, and users on it.

If databases were created from a previous Express Installation, you have the option of keeping the existing databases and installing new ones, deleting the current version and installing new versions, or leaving the existing databases alone and not installing new databases.
Chapter 3

- Remote Client, a Microsoft Internet Information Server (IIS) application that can be used for running the client software through a Web browser and Microsoft Terminal Services Advanced Client. This feature requires you to use Express installation on a Web server; see Prerequisite Steps on this page for details.

For information on running the software with Terminal Services Advanced Client, see Completion of Client Installation on page 88.

**Prerequisite Steps**

**System requirements**
Verify that the system where you are running express installation meets the hardware and software requirements. For more information, refer to the *Sage MAS 500 Compatibility and Resource Guide* located on the Sage Software Web site:

http://support.sagesoftware.com/mas500/support/documents/compatibility.htm

Note the following additions and exceptions described in this section.

**Drive requirements**
Because express installation installs all client, database, and Internet Application components, you need 1.1 GB of free drive space. If you also need to install MSDE, you need an additional 50 MB drive space.

**Software requirements**
The system also requires the following software:

- Digital Dashboard and Microsoft Message Queue (MSMQ). See the installation instructions in the *Internet Applications* guide.

- Windows Terminal Services, if you are using the Remote Client. See the Microsoft documentation for installation instructions.
Terminal Services configuration

You might need to configure Terminal Services to support multiple users. For more information, see the Sage MAS 500 Compatibility and Resource Guide located on the Sage Software Web site at this address:

http://support.sagesoftwareonline.com/mas500/support/documents/compatibility.htm

Running Express Installation

Introduction

You are now ready to run express installation. Follow the steps in this section.

Procedure

To run the express installation, do the following:

1. Log on as an administrator of the computer with a trusted connection to the SQL Server.
2. Insert the Sage MAS 500 Installation CD-ROM into the CD-ROM drive.
3. If Autorun is enabled for your CD-ROM drive, the Installation screen appears automatically. On the left side of the window, click All Components under Express Installation.

Note: If Autorun is not enabled, launch the Express installation directly. In Windows Explorer, go to the Express folder on the Sage MAS 500 Installation CD-ROM. Run Setup.exe to start the Express installation.
Chapter 3

4 The following window appears:

Click Next to continue.

5 Review the license agreement that appears on the screen. Then, select “I accept the terms in this license agreement” and click Next to continue.

6 You have the following options for setting up:
   ▶ Complete: Installs all components on drive C.
   ▶ Custom: Enables you to select the drive and folder where files will be installed.

Select the option and click Next.

If you selected Custom, go to the next step. If you selected Complete, go to step 8.

7 On the Custom screen, click Change to change the drive and path where the files will be installed. Click Disk Usage to see how much space is available on your drives and how much space will be used by the database installation software. Note that some files will be installed on drive C.
Express Installation

8 Click Install to install the software. A status bar indicates the progress. To cancel the installation, click Cancel.

Registration for express installation

When you install a Sage MAS 500 system with express installation, it has a 45-day grace period for registration. For information, see Registration Grace Period on page 19.

Installing on a System with an Existing Installation

Description

If you are running express installation on a system where it has been previously installed, the following window appears:

Click Remove to delete the current version of the software.
When Express Installation comes to the process for creating the new databases, you have the option of saving or deleting existing databases before creating the new ones. The following window appears:

Select the option and click Next.
Changing or Removing Express Installation

Description

You can change or remove express installation by using Add/Remove Programs from the Control Panel:

Changing an express installation

Click Change, and you have options to modify, repair, or remove the express installation. (For more information about these options, see Changing the Installation on page 83.)

Removing express installation

To remove express installation, click Remove from Add/Remove Programs. This removes all of the Sage MAS 500 programs on the system but keeps the databases.
Continuing Setup

**Procedure**

Your system is now ready. To complete the setup, see the following sections:

- To register the system and set up companies and users: *Chapter 6, Registration and Security* of this guide.

- To customize the system: *Chapter 8, System Configuration and Management* of this guide.

- To set Internet Applications options and customize Web site pages: See the *Internet Applications* guide.

- To configure Web Reports: See the Web Reports guide, including the section on configuring the server. Follow the procedures in this guide before using Web Reports.

- To set up options for each module: See the Help system.
This chapter shows you how to create new Sage MAS 500 databases and upgrade existing ones. You can create databases in the following ways:

- Run the Database Express Install to create a complete database set without installing the Database Utilities.

- Install the Database Utilities to install or upgrade databases according to the settings you choose.

To help you choose which method to use, see Choosing an Installation Method on page 5.

In this chapter

Using the Database Express Installation .................. 34
Installing the Database Utilities ......................... 37
Creating New Databases ................................. 45
Upgrading Existing Databases ............................. 53
Establishing a Maintenance Plan .......................... 66
Using the Database Express Installation

Overview

Introduction
Use the Database Express Installation to create a complete set of databases, including application, eCustomer, and Project Link, without installing additional software on your server.

Run the Database Express Installation on the system where you plan to create the databases. To create databases on a remote SQL Server, install the Database Utilities.

Running the Database Express Installation

Procedure
Follow these steps to run the Database Express Installation:

1. Start the Database Express Installation by doing any one of the following:
   ▶ From the installation window, click New Databases.
   ▶ From Windows Explorer, go to the \DatabaseExpress folder on the Installation CD-ROM and run Setup.exe.
The Database Express Installation window appears.

Click Next to continue.

2 Review the license agreement that appears on the screen. Select I accept the terms in this license agreement and click Next to continue.

3 You are prompted to specify information about the databases you are installing at the following window:

Do the following:

- At the SQL Server field, select the SQL Server on the system.
At the Database Name Prefix field, type the base name for the databases. See Database Naming Requirements on page 46 for an explanation.

Click Next to continue. If there are databases previously created on the selected server, you have options for saving or removing them. Go to step 4.

If there are no databases on the server, go to step 5.

4 The following window appears if there are databases previously created on the selected server:

Select the option for your existing databases. You can save or delete the existing databases before creating new databases, or you can keep the existing databases and not create new ones. Click Next to continue.

5 Click Install to create the databases. To cancel the installation, click Cancel.
Installing the Database Utilities

Overview

Introduction

To create or update databases, you need to install the Database Utilities either directly onto the server or on a client workstation.

For information about requirements for installing the software, refer to the Sage MAS 500 Compatibility and Resource Guide located on the Sage Software Web site:

http://support.sagesoftware.com/mas500/support/documents/compatibility.htm

Also, read the information in this section to verify that the system meets the necessary requirements.

Where to install the Database Utilities

Note the following when deciding where to install the Database Utilities and databases:

- The server where you install the databases can be located anywhere on the network, as long as the SQL Server is visible using SQL Server Enterprise Manager.

- If you configure your SQL Server for fail-over clustering, install the Sage MAS 500 Database Utilities on each fail-over SQL Server. This enables a production system to stay registered even when a node is down because of failure or maintenance.
## Preliminary Steps

### Procedure

This section provides information you need before starting the database installation. This includes preliminary steps and a flow chart to follow for installing new or updating existing databases.

Before you create or update databases for Sage MAS 500, do the following:

- Log on to the server as local Administrator.
- Start the SQL Server service.
- Uninstall previous versions of the Sage MAS 500 Database Utilities, service packs, and updates before installing the new version of the Database Utilities.

If you need to move or copy databases as part of your database creation or upgrade procedures, see Chapter 7, *Managing and Protecting Databases* for instructions.

### Distributed Management Objects requirement

The system where you install the Database Utilities needs to have Distributed Management Objects (DMO). To install DMO, install the client software provided with SQL Server. See the SQL Server documentation for instructions.

### Use of Windows Installer

All Sage MAS 500 installation programs use Microsoft Windows Installer. If you already have Windows Installer, the version of Windows Installer that is already on your system is used. If you do not already have Windows Installer, it is installed by Sage MAS 500. It may take a moment to install the Windows Installer before the Sage MAS 500 installation starts.
Demo Data

Description
You have the option of installing demo data when you create new databases. If you plan to install demo data, note the following information in this section.

Demo data companies
When you install demo data, seven demonstration companies are added to the database for your use: CAD, COA, CON, DKS, SGE, SLS, and SOA.

Use the following demo companies for different types of evaluation and testing:

- All modules: The Systems of America (SOA) company contains an extensive amount of data in all of the Sage MAS 500 modules that you can use for testing or viewing.

- Advanced Consolidations: Consolidation Company (CON) is the sample company to use with the Advanced Consolidations module.

- Manufacturing: Consultants of America (COA) and SOA contains Manufacturing demo data. Use these companies for training and when following the examples in the Manufacturing Help system.
Installation Flow Chart

**Flow charts** The procedures you follow in this chapter depend on whether you are creating new databases or upgrading existing ones. The following chart shows the general steps for these procedures.

1. **Start**
   - Install Database Utilities
   - Are you upgrading existing databases?
     - No: Run Database Creation Utility to create new databases
     - Yes: Back up databases
       - Which version of SQL Server do you have?
         - 2000: Run Database Upgrade Utility to upgrade databases
         - 6.5 or 7.0: Upgrade to SQL Server 2000
           - Are you running Internet Applications?
             - Yes: Run Database Creation Utility to create Internet application database
             - No: Run the Database Maintenance wizard
# Installing the Database Utilities

## Introduction

This section describes how to install the Database Utilities by using the Database Utilities Installation wizard.

## Starting the installation

Start the Database Utilities Installation wizard by doing any one of the following:

- From the installation window, click Database Install. (For information about starting installation, see *Starting the Installation* on page 6.)


- From the command line, either in the Run window or the Command Prompt. This allows you to select whether to run the Database Creation or Database Upgrade Utility after installing the Database Utilities. Enter either of these commands:

  - **Setup.exe /VINSTALLDATABASE=1**
    Launch the Database Creation Utility at the end of the installation. The Database Creation Utility runs automatically if no parameter is specified.

  - **Setup.exe /VUPGRAGEDATABASE=1**
    Launch the Database Upgrade Utility at the end of the installation.
Chapter 4

Database Utilities wizard window

When the installation starts, the following window appears:

Uninstallation of prior versions

If you already have the Database Utilities on your system, the installation wizard detects them and gives you the option to remove them before you install the new software. Click Remove to uninstall the old software. The wizard then starts the installation process.

Procedure

Click Next to start the installation and follow these steps:

1. Review the license agreement that appears on the screen. Select I accept the terms in this license agreement and click Next to continue.

2. When you are prompted to enter your information, the fields display the name and organization recorded in the Windows Registry. You can change this information as desired. You can also select whether the software is available to all users or just yourself. Click Next to continue.

3. You have the following options for setting up:
   - Complete: Installs all database components into C:\Program Files\Sage Software\Sage MAS 500 Database Utilities.
   - Custom: Enables you to select the drive and folder where files will be installed and what will be installed.
Select the option and click Next.

If you selected Custom, go to the next step. If you selected Complete, go to step 5.

4 If you selected Custom, the following window appears:

To install the software in the default folder, click Next to continue.

To install the software in a different folder, click Change to select the folder from a window. Click Next to continue.

**Note:** All of the features listed in the window must be installed. None of the items can be removed from the installation list.

5 Click Install to install the software. A status bar indicates the progress.

To cancel the installation, click Cancel.
When the Database Utilities are finished installing, the following utility starts:

- If you launched the Database Utilities Installation directly from the Installation CD-ROM or from the menu on the left side of the Installation window, the Database Creation Utility starts.

- If you launched from a command prompt, the utility you specified with the variable appears. If you didn’t specify a variable, the Database Creation Utility starts.

The logon window to start the utility appears. The following is the logon window for the Database Creation Utility:

If you do not want to run the utility, click Cancel. To continue with the utility, do the following:

1. Select the server where you want to install or upgrade the databases.
2. Type the system administrator logon name and password.
3. Click Proceed.
4. Continue the database installation or update process by going to the following section:
   - If you are creating new databases, see the next section, Creating New Databases on page 45.
   - If you are updating existing databases, see Upgrading Existing Databases on page 53.
When you are finished creating or updating the databases, you can install the client software as shown in Chapter 5, *Client Installation*.

## Creating New Databases

### Overview

#### Introduction

Follow the procedures in this chapter if you are creating new Sage MAS 500 databases. Some of the situations for when to create a new database include the following:

- Creating new production databases for a new installation.

- Creating demo databases for evaluation, testing, or training. In this procedure, you set an option that creates the databases and automatically loads them with demo data.

- Creating blank databases into which you will import data from another source.

Do not use these procedure if you are upgrading an existing database. Instead, see *Upgrading Existing Databases on page 53* for information.

### Starting the Database Creation Utility

#### Description

Use the Database Creation Utility to create databases. Database creation is a lengthy process and can take up to one hour, depending on the server configuration. Plan accordingly before starting the database creation process.
Starting the Database Creation Utility

If you are prompted to start the program after the Database Utilities have been installed, click Yes to continue.

You can also start the Database Creation Utility at any time from the Windows Start menu. From the Start menu, select Programs > Sage Software > Sage MAS 500 > Utilities > Database Creation Utility.

Which Databases to Create

Database requirements

You must create at least a system and application database to use Sage MAS 500. Both databases must be on the same SQL Server.

Additional databases

You also need to install databases that apply to the modules you are using. For example, if you are using eCustomer, you must also create the eCustomer database. These databases must be created on the same SQL Server as the system and application databases.

In order to use the additional databases, you need to activate the associated module to populate the data in the database. For more information, see Setting Up Companies and Modules on page 106.

For an explanation of the databases used by Sage MAS 500, see Sage MAS 500 Databases on page 11.

Note: You can create more than one database set on the same SQL Server. For information, see Chapter 7, Managing and Protecting Databases.

Database Naming Requirements

Introduction

Note the following information in naming Sage MAS 500 databases. By following these requirements, you will make your databases easier to identify and manage, thus avoiding problems.
Database Creation and Upgrade

Base names and endings

A database name includes a base name and an ending. The base name identifies the database set and ending identifies the type of database.

![Diagram of base name and ending]

The following standard endings are used:

<table>
<thead>
<tr>
<th>Type of database</th>
<th>End name with</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>_app</td>
<td>MAS500_app</td>
</tr>
<tr>
<td>eCustomer</td>
<td>_iapp</td>
<td>MAS500_iapp</td>
</tr>
<tr>
<td>Project Link</td>
<td>_pl</td>
<td>MAS500_pl</td>
</tr>
</tbody>
</table>

Naming requirements

Database names must meet the following requirements:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Valid Examples</th>
<th>Invalid Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>No spaces</td>
<td>new_company_app</td>
<td>new company_app</td>
</tr>
<tr>
<td></td>
<td>NewCompany_app</td>
<td>new company_app</td>
</tr>
<tr>
<td></td>
<td></td>
<td>newcompany_app</td>
</tr>
<tr>
<td>No SQL reserved characters</td>
<td>dollarco_app</td>
<td>$co_app</td>
</tr>
<tr>
<td>and wildcards.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>First character alphabetical</td>
<td>company1_app</td>
<td>1company_app</td>
</tr>
<tr>
<td>Standard ending (_app, _iapp, _pl)</td>
<td>acctg_app</td>
<td>acctg_app_new</td>
</tr>
<tr>
<td></td>
<td>acctg_iapp</td>
<td>acctg_eCustomer</td>
</tr>
<tr>
<td></td>
<td>acctg_pl</td>
<td>acctg_Link</td>
</tr>
</tbody>
</table>
Chapter 4

**Transaction log names**

The file names of transaction logs have the same name as the database with the letter L at the end. (For example, the transaction log for MAS500_iapp is MAS500_iappl.)

**Default Administrative Logon**

**Description**

As you create the database set, you are prompted to enter a default admin logon. This logon is used the first time you run Sage MAS 500 so that you can set up the system, grant users access, and perform other administrative tasks.

It is recommended that you create a new logon instead of using an existing SQL Server user. The default administrative logon for Sage MAS 500 is also a SQL Server administrative logon.

The default admin name and password you specify in the Database Creation Utility is saved in the Sage MAS 500 database set. Sage MAS 500 maintains its own table of user names and passwords.

**Default settings**

The Database Creation Utility provides the following default settings:

- Default Admin name: admin
- Password: (no password)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Valid Examples</th>
<th>Invalid Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum 30 characters, including ending</td>
<td>nsbayseafood_app</td>
<td>northshelterbay</td>
</tr>
<tr>
<td></td>
<td></td>
<td>seafoodcompany_app</td>
</tr>
</tbody>
</table>
Defining a logon

If you do not want to use these defaults, type a user name and password when prompted by the Database Creation Utility. Entering a new logon and password automatically creates the administrator in SQL Server.

**Warning:** Make a note of the default administrative logon name and password. You will not be able to log on to Sage MAS 500 for the first time without them.

### Procedure for Creating Databases

**Procedure**

Follow these steps to use the Database Creation Utility:

1. Log on to the server where you are creating the databases. Use the SQL Server password. The following window appears:

2. Select the databases to create. (See *Which Databases to Create* on page 46 for more information). Depending on whether you are performing a new installation or expanding an existing one, do the following:
   - For a new installation, System and application must be selected.
If you are adding databases to an existing installation, select only the databases you are adding and then select the application database to which you are attaching the databases. For an explanation, see Adding Databases to an Existing Installation on page 55.

**Warning:** Do not use database names that already exist. Creating a new database with the same name as an existing one overwrites it.

Also set the following options:

- Default admin name and password. For an explanation, see Default Administrative Logon on page 48.
- Select the regional setting for the database.

**Important:** Verify that the regional setting on client workstations match the regional setting you set for the database.

- To use demo data, select Load demo data. Do not select the option if you are using the database for production data, importing data from another source, or do not want to use demo data. For a description, see Demo Data on page 39.
3 The next window enables you to specify the database sizes and names. There is a tab for each type of database you are creating.

Complete the window as follows:

- In the Application tab, type the name of the database followed with _app to indicate that it is an application database with system information. The database names on the other tabs change to match the base name of the application database and use the appropriate extension for each type. (See Base names and endings on page 47.) You can change the database names if needed.

- The path and file name fields display the drive and path on the SQL Server for the physical database and log files. When you type the database name, the file names change to match it. (See the SQL Server documentation for information about these files.)
Type the sizes for the database and log. For more information, refer to the *Sage MAS 500 Compatibility and Resource Guide* located on the Sage Software Web site:

http://support.sagesoftware.com/mas500/support/documents/compatibility.htm

**Tip:** To make the databases easier to manage, give all of them the same base name.

**4** When you have set up all of the databases, click Proceed to start the database creation process. Allow for sufficient time for the process to complete.

**5** When the database creation process is finished, you have the option of running the Database Maintenance wizard to set up periodic maintenance for the databases. If you do not run the wizard at this time, you can do so later. For information, see *Establishing a Maintenance Plan* on page 66.
## Upgrading Existing Databases

### Overview

**Description**
Follow the procedures in this section if you plan to upgrade existing databases to this version of Sage MAS 500. Before proceeding, verify that you have installed the Database Utilities, including upgrade scripts for the version of Sage MAS 500 currently installed.

**Supported upgrades**
The Database Utilities can update databases from version 4.0 and higher directly to this version. To upgrade databases for versions earlier than 4.0, first upgrade them to version 4.0 or higher, and then upgrade them to this version.

### Overview of the Upgrade Process

**General steps**
Upgrading databases consists of the following general steps:

1. Post any outstanding batches in your production companies. The upgrade cannot proceed with unposted batches.
2. Back up the databases, triggers, and stored procedures, especially if you have customizations.
3. Upgrade to SQL Server 2000, if needed.
4. Start the Database Upgrade Utility, the program you use to upgrade the databases.
5. If necessary, compare the databases and generate scripts for the upgrade. See *Comparing Databases on page 59* for information.
6. Perform the upgrade. The system uses the scripts to update tables, stored procedures, and triggers and copy the data into the modified databases.
Chapter 4

Upgrade and recompile customized stored procedures or triggers after the database upgrade process. If you are using third-party products, create or upgrade to the version that supports this version of Sage MAS 500.

**Time requirements**
The database upgrade process takes considerable time, especially with large databases. Schedule the upgrade to have the least impact on your users.

## Upgrading Customized Databases

### Introduction
If you have customized databases, the Database Upgrade Utility can generate scripts that identify schema changes and update the databases to work with these changes.

### Using database comparisons
To find schema changes, run a comparison of the database to upgrade to find the schema changes. You have the following options for performing the comparison:

- Compare your database against the standard databases for a release.
- Compare two databases. Use this option to identify modifications made between two previously created database sets.

### Generated upgrade scripts
From the comparison, the Database Upgrade Utility generates database upgrade scripts:

- usc_sys.sql for the application database with system information
- usc_appl.sql for the application database with financial information

The scripts created are saved in the \Program Files\Sage Software\Sage MAS 500 Database Utilities\DBUpgrade folder in a subfolder with the name of the version currently used by the database.
To use them for database upgrade, rename the files to sc_app.sql and sc_sys.sql, respectively.

You can generate a script if you are comparing databases with the version immediately before it. For example, if you have version 6.1 databases, you can generate a script if you do a comparison with 6.2.

**Effects of upgrades on customized objects**

The Database Upgrade Utility overwrites customizations in native Sage MAS 500 objects, including triggers and stored procedures. Tables outside of native Sage MAS 500 objects are not affected, but objects such as custom triggers appended to native Sage MAS 500 objects might be dropped. Therefore, back up all customized objects before performing the upgrade. Add the customizations, as needed, manually into the new triggers and stored procedures installed with the new version.

### Adding Databases to an Existing Installation

**Introduction**

To add an eCustomer or Project Link database or an application database with eTimesheets information to an existing database installation, upgrade the existing databases to the current version and then add the new databases. This procedure is explained in this section.

**Procedure**

Follow these steps:

1. Upgrade your existing databases by using the Database Upgrade Utility as shown in Upgrading Databases on page 62. This upgrades the databases to the new version and enables the application database to work with the new databases.

2. Start the installation of the new database by running the Database Creation Utility as shown in Creating New Databases on page 45.

3. Log on to either the SQL Server where your upgraded system and application databases are located or into a different SQL Server.
Chapter 4

4 When you come to the window where you select which databases you are creating, select only the databases you are adding.

For example, if you are adding an eTimesheets database to existing system, application and eCustomer databases, do the following:


► Select eTimesheets.

**Warning:** Do not use database names that already exist. Creating a new database with the same name as an existing one overwrites it.

5 Select the application database to which the new databases are to be attached at the Link to App DB field. This field is available only if the System and application check box is cleared. Click Proceed to continue.

6 In the Database Information window that appears, type the information for each database you are adding. Only the tabs of the databases you are adding become enabled. Click Proceed to create the databases.

7 Activate the modules for the databases you have added to populate the data in them and enable them to be used. For instructions, see *Setting Up Companies and Modules* on page 106.

**Preliminary Steps**

**Introduction**

Before upgrading the databases, complete the tasks shown in this section.
Because your databases contain crucial information, it is important that you do the following before upgrading:

- Post all batches in all of your current modules and companies. If you have posted Sales Order batches, verify that they have been made into open AR batches and posted through AR.

- Back up the databases and test the backup. Keep the backup copy until you are sure the upgraded databases are working properly. See the documentation for Enterprise Manager or the backup utility for instructions on backing up the databases.

  The Database Upgrade Utility also prompts you to back up the databases before proceeding with the upgrade.

- Do a test upgrade on copies of your production databases before you perform the actual upgrade. You can test and verify the upgrades before performing the upgrade on your production data.

For instructions on copying databases, see Chapter 7, Managing and Protecting Databases.

If you are using Microsoft SQL Server 7.0 or earlier, upgrade the Sage MAS 500 databases to SQL Server 2000 before upgrading the databases to this version of Sage MAS 500. For more information about system requirements, see the Sage MAS 500 Compatibility and Resource Guide located on the Sage Software Web site at this address:


You must do an actual upgrade of the databases from one version of SQL Server to another. Do not just restore the backup files from the old version of SQL Server to the new one or use sp_attach_db to attach database files from the old version of SQL Server to the new one and then upgrade them to a new version of Sage MAS 500.
Chapter 4

Follow these steps:

1. Make backups of your databases.
2. Upgrade Microsoft SQL Server to version 2000 as shown in the SQL Server documentation. Note the following:
   - For best results, use the Direct Pipeline method for upgrading.
   - Be sure to include both the system and application databases when you upgrade.

Starting the Database Upgrade Utility

Procedure

If you are prompted to start the program after the Database Utilities have been installed, click Yes to continue. You can also start the Database Upgrade Utility from the Windows Start menu. From the Windows Start menu, select Programs > Sage Software > Sage MAS 500 > Utilities > Sage MAS 500 Database Upgrade Utility.

Run the Database Upgrade Utility as follows:

1. When prompted, log on to SQL Server containing the databases. Use your sa password.

The Database Upgrade Utility window appears:

Tip: You can use the toolbar for common commands. Place the pointer over a button for a moment to see a tooltip.
## Comparing Databases

### Introduction
The comparison feature enables you to generate upgrade scripts by comparing the database you are upgrading to a standard database for that release or against another database. The comparison shows differences in the schema and does not examine customized procedure code.

### Determining if you need to do a comparison
There are some situations when you do not need to run the comparison. Refer to the following chart:

<table>
<thead>
<tr>
<th>Type of database upgrade</th>
<th>Comparison needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database set has no customizations.</td>
<td>No. Skip to <em>Upgrading Databases on page 62.</em></td>
</tr>
<tr>
<td>You need to compare the database against a standard database set for this release.</td>
<td>Optional, because the upgrade can generate a script against a standard database set as it does the upgrade. To review the upgrade script before you perform the upgrade, perform the comparison as shown in this section.</td>
</tr>
<tr>
<td>You need to compare the database against another set of customized databases.</td>
<td>Yes.</td>
</tr>
<tr>
<td>You want to modify the upgrade scripts.</td>
<td>Yes. Use the comparison to generate scripts to customize.</td>
</tr>
</tbody>
</table>

For more information about upgrading customized databases, see *Upgrading Customized Databases on page 54.*

### Time for performing the comparison
This comparison process takes a considerable amount of time, depending on the size of the databases and amount of customizations. Allow sufficient time for the process to complete.
Follow these steps to run the database comparison:

1. From the Tools menu, select Compare Databases. The following window appears:

![Database Upgrade Utility Window]

Complete the window as follows:

- At the Upgrade From database fields, select the databases to compare.

- To use the standard database for comparison, select the Compare with Pre-processed Database Information check box. The version of the Sage MAS 500 used for that database automatically defaults to the Compare with Version field. If the version is not correct, select the correct version.

**Warning**: At the Compare with Version field, select the version you are currently using, not the version to which you are upgrading. If you select the wrong version, the upgrade information will be incorrect, creating errors in the upgraded databases.
To compare the databases you are upgrading to another database, clear the Compare with Pre-processed Database Information check box. Select the databases you are comparing at the Upgrade To fields.

To have the Database Upgrade Utility generate the upgrade scripts, select the Generate Database Upgrade Script check box. This check box is available only if you are comparing a database with databases or the version immediately before it (such as 6.2 to 6.3). If the comparison is greater than one version (such as 6.1 to 6.3), this check box is not available.

2 Click Proceed. The following changes occur in the Database Upgrade Utility window:
   ▶ The left pane shows the objects in the database.
   ▶ The right pane shows any differences identified in a database object.
   ▶ A status bar shows the progress of the comparison process.

3 Review the changes identified by the database comparison. To get a complete report, from the Reports menu, select Schema Changes.
Chapter 4

Upgrading Databases

Procedure

When you are ready to upgrade the databases, follow these steps:

1. From the Tools menu, select Upgrade Existing Databases. The following window appears:

2. Select the system and application database to upgrade. The Database Version field displays the version of Sage MAS 500 used for that database.

3. Indicate how you want to upgrade the databases by doing the following.

   **Warning:** Follow the instructions in this step carefully. If you choose the wrong selections for your type of upgrade, you can lose your data, customization, or customized scripts.

<table>
<thead>
<tr>
<th>Upgrade you are performing</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database has no customizations.</td>
<td>Verify that the Update To Version field displays the correct version of Sage MAS 500. Select the Use pre-generated Sage MAS 500 Database upgrade script check box.</td>
</tr>
<tr>
<td>Upgrade you are performing</td>
<td>What to do</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Database set has customizations, you are not comparing against another customized database set, and you want to generate scripts while performing the upgrade.</td>
<td>Verify that the Update To Version field displays the correct version of Sage MAS 500. Clear the Use pre-generated Sage MAS 500 Database upgrade script check box.</td>
</tr>
<tr>
<td>You want to use scripts you generated in <em>Comparing Databases on page 59</em></td>
<td>In the \Program Files\Sage Software\Sage MAS 500 Database Utilities\DBUpgrade folder, look for the folder for the version currently used by the database. Find the files usc_app.sql and usc_sys.sql and rename them to sc_app.sql and sc_sys.sql, respectively. (See <em>Upgrading Customized Databases on page 54</em> for more information.) Verify that the Update To Version field displays the correct version of Sage MAS 500. Select the Use pre-generated Sage MAS 500 Database upgrade script check box.</td>
</tr>
</tbody>
</table>
4 Click Proceed. You are shown the last time that you have backed up the databases and prompted whether to back up the databases, continue with the upgrade without performing a backup, or cancel. Respond to the prompt as follows:

- Click Backup Now to back up the databases before continuing the upgrade. The Database Maintenance wizard appears. (For more information, see *Establishing a Maintenance Plan on page 66.*) To use another backup utility, close the Database Maintenance wizard by clicking Exit and run the utility. When you are finished with the backup, go back to the Database Upgrade Utility window and continue the upgrade.

- If you have already backed up the databases, click Continue. The upgrade starts.

- If you do not want to continue the upgrade, click Cancel.

<table>
<thead>
<tr>
<th>Upgrade you are performing</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>The current databases are more than one version prior to the version you are upgrading to (such as 6.1 when the version you are upgrading to is 6.3).</td>
<td>The Use Pre-generated Database Upgrade Script check box is automatically selected and can only be viewed. If you want to use a script generated by a comparison, In the \Program Files\Sage Software\Sage MAS 500 Database Utilities\DBUpgrade folder, rename usc_app.sql to sc_app.sql and usc_sys.sql to sc_sys.sql. (See <em>Upgrading Customized Databases on page 54</em> for more information.)</td>
</tr>
</tbody>
</table>
When the database upgrade is completed, the Database Upgrade Utility displays a log of the operations that occurred.

To save a report of the operations, from the Reports menu, select Schema Changes. The report is saved to the \Program Files\Sage Software\Sage MAS 500 Database Utilities\DBUpgrade\StrtChng.txt file. To view the report, click Yes when you are prompted to open the file.

Review the DBError.log file generated by the upgrade process. This is saved in the \Program Files\Sage Software\Sage MAS 500 Database Utilities\DBUpgrade folder. It contains information about the upgrade and any errors encountered in the process.

When the database upgrade process is finished, you have the option of running the Database Maintenance wizard to set up periodic maintenance for the databases. If you do not run the wizard at this time, you can do so later. For information, see the next section, *Establishing a Maintenance Plan* on page 66.
Establishing a Maintenance Plan

Overview

Introduction

When the databases have been created or upgraded, you have the option of scheduling and performing the following database maintenance tasks:

- Validation
- Optimization
- Backup

You use the Database Maintenance wizard to set up and schedule these tasks. All database objects are maintained.

Starting the Database Maintenance Wizard

When you are prompted to start the wizard

You have the option of starting the Database Maintenance wizard in the following situations:

- Upon completion of the Database Creation Utility or Database Upgrade Utility.
- Before starting a database upgrade so that you can use the wizard to back up the databases before continuing.

You can also start the wizard at any time by using the procedure shown in this section.

Starting the wizard

To start the Database Maintenance wizard, do the following:

1. From the Windows Start menu, select Run.
2. Click Browse to locate CreateDB.exe. The .exe file is located at C:\Program Files\Sage Software\Sage MAS 500 Database Utilities\DBInstall. Select the file and click Open.
In the Run window, the Open field displays the file name and path for CreateDB.exe. Add /M to the end of the line as shown, and click OK:

"C:\Program Files\Sage Software\Sage MAS 500 Database Utilities\DBInstall\CreateDB.exe" /M

The Sage MAS 500 Database Install Login window appears. Type the password and click Proceed. The following window appears.

### Setting Up Database Maintenance

**Fields to complete**

Complete the Database Maintenance wizard as follows:

- **Application database**: Select the database for which to schedule maintenance tasks.

- **Data Validation**: Select this check box to have the system run consistency tests on the databases. The system runs DBCC CHECKDB to report on data and index page consistency, and DBCC CHECKCATALOG to report on the consistency of the system tables.
Chapter 4

- **Data Optimization**: Select this check box to optimize table indexes for improved performance. The system rebuilds the table indexes using the free space percent value as the inverse of the index fill factor. This option also updates the index statistics used in the compilation of stored procedures.

- **Backup Options**: Select the Perform Scheduled Backups To check box to perform periodic backups. Select the drive and path to store the backup files and whether to delete backup files older than the selected number of weeks.

  **Note**: Do not select a folder on the same drive as your database. The server must always have access to the folder selected. The file names of the backup files are created at run time as the database name with a current date (YYYYMMDD) extension.

- **Plan Frequency**: Select the task to be performed daily, weekly, or monthly. Select the start time at the At Time field. For weekly tasks, select the day of the week at the On Day field.

  **Tip**: If you have a large number of transactions, select the task to be performed daily. Schedule the tasks at off hours.

- **Generate Report To**: Enter the path to which the results of the maintenance activities will be created. A valid path is required at this field.

- **E-Mail To**: Select an established SQL Server Operator to whom completion messages will be sent. For more information on how to create SQL Server Operators, see the *Microsoft SQL Server Online Help* topic, “Creating an Operator.”

---

**Starting the backup**

To back up the databases immediately, click Backup Now. The system backs up the selected databases using the settings you selected.
Accepting the changes

When you have completed the desired maintenance plan, click Create Plan. You can create a maintenance plan for another database or click Exit.

**Note:** The Create Plan button is unavailable when you launch the Database Maintenance wizard prior to backing up the databases. At that point of the upgrade process, the wizard is provided only for backing up the databases. You have the option of running the Database Maintenance wizard to set up a maintenance plan after the database upgrade is complete.

### Running and Viewing Scheduled Tasks

**Introduction**

When you click Apply to save a maintenance plan, it is added to the schedule tasks for the SQL Server Agent. You can view and change the maintenance plan jobs in Enterprise Manager.

The SQL Server Agent also processes automatic registration and data update tasks for the Internet Applications.

**Viewing maintenance plans**

To view the maintenance plan in Enterprise Manager, follow these steps:

1. In the Tree pane, expand the listing for the SQL Server. Expand the Management folder, and then the listing for SQL Server Agent.
2. Click Jobs. The jobs appear in the right pane, as shown in the following figure:

![Image of jobs in the right pane]

3. Locate the maintenance plan generated by the Database Update wizard. Scroll across the right pane to get an overview of the status of the maintenance plan.

   To get more details about the plan or change settings, right-click it, and from the menu that appears, select Properties. The following window appears:

![Image of the Properties window for a maintenance plan]
Changing a maintenance plan

Use the maintenance plan Properties window to change settings such as the following:

- Servers where the job is run
- SQL commands used in the job
- Schedule for processing jobs
- E-mail notifications when a job fails or finishes

Troubleshooting maintenance plans

You can use the maintenance plan Properties window to correct problems or improve performance in processing.

For example, if it takes too long to process a job, it might be caused by redundant options in the SQL command. If the command contains both -UpdSts and -RebldIdx, remove either of these options to improve performance. See SQL Server Books Online for information about these options.

Follow these steps to fix this and other errors in the SQL commands for a job.

1. In the maintenance plan Properties window, click Steps.
2. Select the step to change and click Edit. The following window appears.

   ![Edit Job Step Window]

3. Verify that Operating System Command (CmdExec) is selected at the Type field.
4 Type the changes in the Command box.
5 Click the Advanced tab to set options for completed or failed job and select whether to generate an output file. Click OK.

Running maintenance plans

The SQL Server Agent must be running in order for the maintenance plan jobs to be run. If the agent is not running, do the following in Enterprise Manager to start it:

1 In the Tree pane, expand the listing for the SQL Server, and then the Management folder. SQL Server Agent appears below the Management folder as shown:

![Tree pane showing SQL Server Agent]

2 Right-click SQL Server Agent. From the menu that appears, select Start.

For more information about using SQL Server Agent, see SQL Server Books Online.
The following chapter guides you through the process of installing, removing, reinstalling, and upgrading the Sage MAS 500 client software.

In this chapter
- Preliminary Steps ........................................ 74
- Installing the Client Software .............................. 78
- Terminal Services Installation ............................. 85
- Completion of Client Installation ......................... 88
- Installing Crystal Reports Designer ..................... 90
CHAPTER 5

Preliminary Steps

Overview

Introduction

This section describes the steps you need to perform before installing the client software, especially if you are upgrading from a previous version of Sage MAS 500. Also note the use of Windows Installer with the client installation.

Options for Installing Client Software

Description

You have the following options for installing and running Sage MAS 500 client software:

- Install the software directly on each client system by running the installation wizard or by using the silent installation feature to install the software with the parameters you specify.

- Use Terminal Services to run Sage MAS 500 on a dedicated Terminal Services system and connect to it from other machines, instead of installing the software on each system. For information on Terminal Services requirements, see the Sage MAS 500 Compatibility and Resource Guide located on the Sage Software Web site at this address:

  http://support.sagesoftwareonline.com/mas500/support/documents/compatibility.htm

Overview of procedures

Perform the preliminary steps and then use the procedure that applies to your installation. See Changing the Installation on page 83 if you need to reinstall components, change an installation, or uninstall the client software.
# Preliminary Steps for Upgrades

## Introduction

If you are upgrading the client software, you need to uninstall the previous version of the Sage MAS 500 software and the version of Crystal Reports that came with it before you install this version of Sage MAS 500.

## Software that is uninstalled

If you have Sage MAS 500 client software, the installation wizard detects it and gives you the option to remove it before installing the new software. This removes the application and any service packs, monthly updates, and hot fixes. It does not remove user files, form customizations, and any components added to the client. The wizard starts the installation process.

When you remove Sage MAS 500, it also removes the runtime version of Crystal Reports if it is not used by other programs. If you have Crystal Reports Designer, or if Crystal Reports is used by another program, you need to uninstall it manually before installing the new version of Sage MAS 500.

## Preserving customizations

If you have customizations to apply to the version of Sage MAS 500 you are about to install, save the files used to create the customizations in a separate folder before continuing.

# Prerequisite Steps for Clients on SQL Server

## Description

Before installing, reinstalling, or upgrading the Sage MAS 500 client on a workstation or server running SQL Server, shut down all SQL Server services, including SQL Server, SQL Executive, and DTC.
Prerequisite Steps for Manufacturing

Upgrade requirements

If you are upgrading from Manufacturing versions prior to 6.1, uninstall the following:

- Previous version of the Sage MAS 500 Manufacturing software
- Patches and hot fixes
- ScheduleBoardX, which is now installed with the Manufacturing client software

This step does not apply if you are upgrading from 6.1.

Use of Windows Installer

Description

All Sage MAS 500 installation programs use Microsoft Windows Installer. If you already have Windows Installer, Sage MAS 500 uses the version that is already on your system.

If you do not already have Windows Installer on a system, it is installed automatically when you run the Setup program.

Preinstallation Checklist for Client Installation

Introduction

Before you begin installing the client software, verify that you have the following information. Complete the following checklist:

Information

<table>
<thead>
<tr>
<th>Information</th>
<th>Where to install the client software</th>
</tr>
</thead>
<tbody>
<tr>
<td>On each client workstation</td>
<td>(Continue following the instructions in this section.)</td>
</tr>
<tr>
<td>Remotely through Terminal Services</td>
<td>(See Terminal Services Installation on page 85 for instructions.)</td>
</tr>
</tbody>
</table>

SQL Server

______________________________

76 Installation and System Configuration
### Information

<table>
<thead>
<tr>
<th>Type of client installation</th>
<th>Installation of new client workstation software</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Upgrading existing client workstation software</td>
</tr>
<tr>
<td>User of the software</td>
<td>All users of the system</td>
</tr>
<tr>
<td></td>
<td>Only the user who installs the software</td>
</tr>
<tr>
<td>Applications to install</td>
<td>All applications are installed.</td>
</tr>
</tbody>
</table>
Chapter 5

Installing the Client Software

Overview

Introduction

Follow the procedures in this section if you are installing the client software directly from the CD-ROM to the local drive.

Installing Client Software

Procedure

This section describes how to install the software by using the Client Installation wizard. To use the silent installation feature, see Appendix E, Silent Installation.

1 Verify that you have logged into the client system as the local Administrator. If not, log off the system and log back in as the local Administrator.

2 Start the client installation by doing either of the following:
   ▶ From the installation window, click Client Install. (For information about starting the installation, see Starting the Installation on page 6.)
   ▶ From Windows Explorer, on the Sage MAS 500 CD-ROM, open the Client folder. Run Setup.exe.

3 You are prompted to install the .NET Framework if it is not already installed. Click OK to continue. You need .NET Framework to run the Sage MAS 500 client software.
4 The following window appears. Click Next to continue.

5 Review the license agreement that appears on the screen. When you are finished, select “I accept the terms in this license agreement” and click Next to continue.

6 When you are prompted to enter your information, the fields display the name and organization as recorded in the Windows Registry. You can change this information, if necessary.

   Depending on your configuration, select the following option:

   ▶ If you are installing on a dedicated client system, you have the option of selecting whether the software is available to all users or just yourself.

   ▶ If you are installing on a Terminal Server, you must select All Users.

   Click Next to continue.
Chapter 5

7 If you are performing a new installation, you are prompted to type the name of the SQL Server you will be using with the client software. Type the name of the server and click Next.

You are not prompted to type the name of a SQL Server if you are upgrading an existing installation. The new client software uses the SQL Server you previously used.

8 You have the following options for setting up:
   - Complete: Installs all client components into a default folder on C.
   - Custom: Enables you to select the drive and folder where files will be installed.

Select the option and click Next.

If you selected Custom, go to the next step. If you selected Complete, skip to step 10.

9 If you selected Custom, the following screen appears:

To change the drive and path where the files will be installed, click Change. Click Disk Usage to see how much space is available on your drives and how much space will be used by the database installation software. Note that some files will be installed on drive C.
Client Installation

**Note:** All modules are installed. The Custom window lists the modules, but none of them can be deselected from the installation.

Click Next to continue.

10 Click Install to start the installation. A status bar indicates the progress. To cancel the installation, click Cancel.

11 You might need to reboot your computer to complete the installation. When prompted, click Yes to reboot.

**Installing CAD viewer software**

To view CAD drawings in Manufacturing, install the optional Dr. DWG ActiveView Pro software. The Sage MAS 500 Installation CD-ROM has a limited-use demo of the software with information on ordering the full product. The demo version expires 30 days after the installation.

You can install the demo software before or after installing the Manufacturing client. Follow these steps:

1 From Windows Explorer, on the Sage MAS 500 Installation CD-ROM, open the Support folder, and then the CAD folder.

2 Run DrDWGactivex.exe.

3 In the dialog box that appears, click Setup. Follow the instructions on the screen to complete the installation.

To purchase the full version of the software, use the order form installed with the demo software. From the Windows Start menu, select Programs > Dr. DWG ActiveView Prof > Dr. DWG-ActiveView Order Form.
Registering the DLL File for Microsoft Office

Description If you are installing Advanced Consolidations and MS Project Link, EnterpriseCOMAddin.dll is installed for processing data exchanges between Sage MAS 500 and Microsoft Excel and Microsoft Project.

During installation, the following happens:

- If Microsoft Office is on the system, the DLL file is installed and registered; no further action is required.
- If Microsoft Office is not on the system, the DLL file is installed but not registered.

Although the DLL is installed and registered if any Microsoft Office application is installed, the Sage MAS 500 application will not work unless the necessary Microsoft Office application is installed. For a list of requirements, refer to the Sage MAS 500 Compatibility and Resource Guide located on the Sage Software Web site:

http://support.sagesoftware.com/mas500/support/documents/compatibility.htm

Procedure You can install Microsoft Office applications after installing the Sage MAS 500 client software, but you need to register EnterpriseCOMAddin.dll manually. Follow these steps:

1. Install Microsoft Excel or Microsoft Project on the client system as shown in the Microsoft documentation.
2. From the Windows Start menu, select Run.
3. At the Open field, type the following command:
   ```
   regsvr32 folder\PL\EnterpriseCOMAddin.dll
   ```
   Where `folder` where the Sage MAS 500 client software is installed (typically C:\Program Files\Sage Software\Sage MAS 500 Client).
Changing the Installation

Introduction
You can remove the Sage MAS 500 software, change the configuration, or reinstall components by running the installation program. When you run an installation on a system that already has the current version of Sage MAS 500 software, the program detects the software and presents an appropriate set of options.

Procedure
Follow these steps to run the client installation to make changes:

1. Start the installation by doing either of the following:
   - From the installation window, click the link for the software installation. (For information about starting installation, see Starting the Installation on page 6.)
   - From Windows Explorer, on the Sage MAS 500 CD-ROM, open the folder with the installation software. Run Setup.exe.
   - From the Windows Start menu, select Settings > Control Panel. In the Control Panel window, double-click Add/Remove Programs. In the Add/Remove Programs window, select the Sage MAS 500 software, and click Add/Remove.

When the installation software starts, click Next to continue.
The following window appears:

Select the option:

- To review settings, click Modify.
- If you experienced problems with the Sage MAS 500 software or need to repair a corrupted installation, select Repair. This reinstalls any missing or damaged files. Click Next to continue.
- To uninstall the software from the system, select Remove. Click Next to continue.

**Note:** Selecting Remove on this screen does not uninstall service packs, monthly updates, and hot fixes you added to the current version of Sage MAS 500. If you are running the installation program to update an older version, clicking the Remove button does remove those items.

A screen appears where you can confirm your action. Click Install (for Modify or Repair) or Remove to proceed.
Terminal Services Installation

Overview

Introduction

If you are using Sage MAS 500 with Terminal Services, see the system requirements in Terminal Services Requirements on page 35. You can then install Sage MAS 500 for multiuser access by doing either of the following:

- Use Add/Remove Programs in Control Panel.
- Use the change user command at the command prompt before and after installing Sage MAS 500.

Precautions on Using Terminal Services

Description

Any changes you make to Sage MAS 500 affect all users on Terminal Services, especially the following:

- If you select Windows authentication, it applies to all other users who connect after this setting is saved.
- Selecting new values for any of the fields or options in the Desktop Configuration Utility in a terminal server session affects all users connecting to Sage MAS 500 through that Terminal Services.

Using Add/Remove Programs

Procedure

Follow these steps:

1. Log on to Terminal Services as the local Administrator.
2. Close all other applications.
3. From the Start menu, select Settings > Control Panel. Double click Add/Remove Programs.
Chapter 5

4 On the Install/Uninstall tab, click Install. You are prompted to specify the installation program. Click Browse to locate the Sage MAS 500 client installation, then click Next.

5 In the Change User Option dialog box, select All users begin with common application settings, then click Next.

6 Install Sage MAS 500 on a local NTFS-formatted drive.

7 In the Finish Admin Install dialog box, click Finish.

Connecting to the Terminal Services section

You are now ready to connect to Sage MAS 500. Review the Terminal Services documentation for information on connecting to, disconnecting from, and logging off of a Terminal Services session.

If you establish a new session under the same Windows user account, and an old session is still open and running Sage MAS 500, attempting to run Sage MAS 500 on the newly established session will fail.

Using the Change User Function

Procedure

Follow these steps:

1 Log on to Terminal Services as the local Administrator.

2 Close all other applications.

3 From the Start menu, select Programs > Accessories > Command Prompt.

4 At the Command Prompt, type the following:

   change user/install

   To see whether execute mode is enabled and .ini file mapping is on, use this command:

   change user/query

5 Install Sage MAS 500 on a local uncompressed NTFS-formatted drive.
6 When the installation is complete, type the following command:

change user/execute

<table>
<thead>
<tr>
<th>Connecting to the Terminal Services section</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are now ready to connect to Sage MAS 500. Review the Terminal Services documentation for information on connecting to, disconnecting from, and logging off of a Terminal Services session.</td>
</tr>
</tbody>
</table>

If you establish a new session under the same Windows user account, and an old session is still open and running Sage MAS 500, attempting to run Sage MAS 500 on the newly established session will fail.
Completion of Client Installation

Overview

Introduction

When the Sage MAS 500 client installation is completed, shortcuts are added to your Start menu and additional software and Registry settings are created to support the client software. These are described in this section.

File locations

The installation copies all components of Sage MAS 500, including programs, Help, and reports, to the Sage MAS 500 Client folder. Within the folder, there are subfolders for each module.

Sage MAS 500 Shortcuts

Start menu

The following shortcuts are created in the Sage MAS 500 program group on the Windows Start menu under Programs:

- Sage MAS 500 Desktop: Starts the client software.
- Utilities: A program group containing shortcuts to the following:
  - Desktop Configuration Utility: Enables you to specify the database used for logging on and other logon options.
  - System Inspector: Shows the files and Registry settings associated with the Sage MAS 500 client software. Use this utility for troubleshooting.

If you already have a Sage MAS 500 Utilities program group from installing the Database Utilities, the shortcuts for the Desktop Configuration Utility and System Inspector are added to it.
ODBC, Registry, and OLE DB Additions

Description
The Sage MAS 500 client installation automatically adds and configures ODBC components, as follows:

- Adds two 32-bit ODBC and SQL Server communications components.
- Adds two User Data Source Names (DSN) to ODBC, acuity-app and acuity-sys, which contain vital information used in accessing the SQL Server where the Sage MAS 500 databases have been created.

Database Connection
Chapter 5

Installing Crystal Reports Designer

Overview

Introduction During installation of the Sage MAS 500 client, the Crystal Reports runtime engine is also installed. This provides you with the ability to print and preview reports in Sage MAS 500.

To modify or create reports, install the Crystal Reports Designer. This component accompanies your Sage MAS 500 software, but you must install it separately. It is included with a local installation license. Contact Business Objects (formerly Crystal Decisions) to purchase a network license.

Prerequisites

Description Before you install the software, do the following:

- Uninstall previous versions of Crystal Reports and Crystal Reports Designer.
- Shut down all running software.
- Have a CD-ROM drive or access to a CD-ROM drive share point and a default print device
## Installing Crystal Reports Designer

**Procedure**

You are now ready to install Crystal Reports for Sage MAS 500.

1. Insert the Sage MAS 500 third-party CD-ROM into your CD-ROM drive.
2. Select Crystal Reports Installation. The installation software checks for any earlier versions of the software and prompts you to remove them before installing the software.
3. Complete the windows in the Installation wizard as prompted.
The final steps in completing the installation are to register the software and grant access rights to users. These functions are part of System Manager, and this chapter provides instructions for using System Manager to perform these tasks.

In this chapter
- Starting Sage MAS 500 as an Administrator ................. 94
- Registering the Software .................................. 97
- Setting Up Companies and Modules ..................... 106
- Setting Up Users ........................................ 112
Starting Sage MAS 500 as an Administrator

Overview

Introduction

To register the software and assign access rights to users, log on to Sage MAS 500 using the admin logon you defined when you created the Sage MAS 500 databases. As administrator, you can set up appropriate security for users on the SQL Server where the Sage MAS 500 databases are located, including users configured for Windows authentication.

This section explains the logons available for administrators. For information about logging on to Sage MAS 500, see the Getting Started guide.

Default Logon

Default admin logon

Use the default admin logon the first time you log on to Sage MAS 500. The admin logon allows you to grant users access rights and perform other administrative tasks.

Use the logon name and password entered in the Database Creation Utility. For an upgraded database set, use an admin logon that was created for the database or the default of admin and no password. For information, see Default Administrative Logon on page 48.

Before modifying passwords and permissions for the admin logon or any other Sage MAS 500 users, see Setting Up Users on page 112.
Logging on to Sage MAS 500 as an Administrator

Description
To start Sage MAS 500, from the Windows Start menu, select Sage MAS 500 Desktop. The Sage MAS 500 logon window appears.

First-time logon
For your first-time logon as admin, complete the window as follows:

- Clear the Use Windows Authentication check box.
- Log on with the admin user name and password. See Default Logon on page 94 for an explanation of which user name and password to use.
- Select the Advanced Options check box. If this check box is selected, the logon window expands and displays the fields for selecting the server and database.
- Verify that the server and database fields display the server and system and application databases to use. If not, select the Change Server/Database check box, and select the server and databases to use. If you do not see the servers or databases you want, click Refresh to list the SQL Servers in the domain and the databases in the selected SQL Server.
- Select the company to use at the Company field.
Chapter 6

- Select the Save Settings as Default check box to log on to the same server and database each time you start Sage MAS 500.

When you are finished, click OK to log on. The Sage MAS 500 Desktop opens. (See the *Getting Started* guide for information on using it.)

**Admin logon with Windows authentication**

If you are logging on with Windows authentication and the admin logon uses SQL Server authentication (which is the case if you use the default Sage MAS 500 logon), use the Desktop Configuration Utility to change to SQL Server authentication and log on as admin. For information about using the Desktop Configuration Utility, see the *Getting Started* guide.
Registering the Software

Overview

Description
After you install Sage MAS 500, register it as shown in this section. For an overview of the registration process, see Registration Process on page 16.

If your Sage MAS 500 is already registered, you must reregister it if you perform any of the following:
- Rename the SQL server
- Rename the Sage MAS 500 database
- Change the network card on the SQL server
- Move the Sage MAS 500 database to another server

Prerequisite Steps

Procedure
Before registering the software, do the following:
- Have all users log off of Sage MAS 500.
- Get the packing list that accompanied your Sage MAS 500 package. The packing list contains your customer number, System Manager serial number, and unlocking key.
- To use automatic registration, verify that the SQL Server Agent is running and ready to run a scheduled event, and that you have a continuously working Internet connection.
Serial number and unlocking keys

The serial numbers and unlocking keys may contain alphanumeric characters, which must be entered in capital letters. Unlocking keys are unique to each system and cannot be used for other installations.

**Important:** Sage MAS 500 will not accept the registration if you use lowercase letters to enter the serial number and unlocking key information.

If you have questions about the unlocking keys, contact the Sage MAS 500 Product Registration Department at (800) 944-5481 or (949) 753-1222.
Registration Procedure

Starting the registration

Follow these steps to register Sage MAS 500:

1. Log on to Sage MAS 500. For more information, see Starting Sage MAS 500 as an Administrator on page 94.

2. In the Tasks pane, select the System Manager Maintenance menu > Maintain Site. The Maintain Site window appears.

3. At the License Type field, select whether you are installing a Demonstration, Developer, Test, or Production system.

4. Enter the Company Name and Contact Name fields.

5. Complete the Registration tab with the information from the packing list:
   - Type the customer number as it appears on the packing list at the Customer Number field.
Type the SM serial number in capital letters as it appears on the packing list at the SM Serial Number field. This field is available only if Production is selected at the License Type field.

Type the System Manager unlocking key in capital letters as it appears on the packing list at the SM Unlocking Key field.

**Important:** Type any letters in uppercase only. If you are upgrading from a previous version, use the customer number, SM serial number, and SM unlocking key from that version. If the customer number has ten digits, enter the first nine digits.

6 Click Save to save the customer number, SM serial number (if entered), and SM unlocking key.

7 Select whether you are performing an automatic or manual registration. For an explanation of these options, see *Registration Process* on page 16. Depending on which method you use, see *Automatic registration* or *Manual registration* to continue the procedure.

### Automatic registration

Before performing automatic registration, do the following:

- Have all other users log off of Sage MAS 500.
- Verify that you have a working Internet connection either at the server or the client where you are performing the registration.

Then, follow these steps:

1 Click Automatic Internet Registration. The system processes the registration and enables automatic updates on a periodic basis.

2 Go to *Verifying and completing the registration* on page 102 for instructions on completing the installation.
Before performing manual registration, verify that you have a working Internet connection. Then, follow these steps:

1. Click Manual Registration.
2. Highlight all of the text in the Registration Request Message box in the Maintain Site window by placing the cursor in the Registration Request Message box and pressing CTRL+A. After the text is selected, press CTRL+C to copy the text to the clipboard.
3. In a Web browser, go to this address:
   http://registration.sagesoftware.com/registration

   The following page appears:

   4. Paste the registration request message at the Registration Request Message field. Place the cursor in the text box next to the Registration Request Message and press CTRL+V.

   5. Click Submit. A registration message appears in the bottom box.

   6. Highlight all of the text at the Registration Message field (CTRL+A) in the Web browser and copy it (CTRL+C) to the clipboard. Close the Web browser.
Chapter 6

7. Return to the Maintain Site window and paste (CTRL+V) the text at the Registration Message field.

8. Click Save in the Maintain Site window to record the message.

9. Go to the next section, **Verifying and completing the registration**, for instructions on completing the installation.

**Verifying and completing the registration**

After you complete the automatic or manual registration, follow these steps to verify and complete it.

1. Click the Registration Log tab. The tab shows registration requests and any errors that occurred.

   ![Registration Log Tab](image)

   Read the log as follows:

   - If a request was successful, the Error Message column is blank. Scroll to the right to view more information about the registration.
   - If an error occurred, a description of it appears to the right of the date and time in the Error Message column.
Note: The log can be printed or exported to Excel. Right-click the log and select Print or Export from the menu that appears.

To purge the log of errors, enter the date at the Purge Errors Prior To field and click Purge Errors. Errors logged before the date entered are purged.

2 Run the Site Profile listing to view the license information and list of registered modules. Click the Print button in the toolbar to generate the report. Confirm that the license information in your system is correct. (For more information about this report, see Site Profile List on page 162.)

Note: You can also view license information by clicking the License tab.

If the settings do not match your license, contact Sage Software for assistance.

3 When you are finished, click Save and Exit to close the window.

4 Close and reopen Sage MAS 500. The settings defined in the license take effect.
Registration Renewals

Introduction
You are prompted to renew registration when your maintenance and support agreement is about to expire. Register again whether or not you plan to continue with the maintenance and support agreement as follows:

- If you are continuing with the maintenance and support agreement, renewing your registration enables you to continue to install patches and updates according to your license agreement.

- If you are not continuing with the maintenance and support agreement, renew your registration so that you can continue using Sage MAS 500. The new registration does not enable you to install patches and updates.

Grace period after registration expires
If you do not renew the registration before it ends, the system enters a 45-day grace period. During this grace period, you have access to the same modules with the same number of users as you did when the software was registered. The exceptions are Data Migrator and Data Porter, which can only be used with demo data companies.

At the end of the grace period, the system becomes unregistered and you will no longer have access to your data.

Procedure
To renew your registration, repeat the registration procedure with the following exceptions:

- Do not change the customer number, System Manager serial number, and System Manager unlocking key. The registration system uses the same information for renewals.

- If you are using automatic registration, the registration renewal is sent automatically when required.
• If you are using manual registration, you have the following options:
  ▶ To renew registration automatically, click Automatic Internet Registration. The registration will continue to be renewed at regular intervals.
  ▶ If you still cannot use automatic registration, renew the registration manually. Click Manual Registration to generate a new registration request message. Repeat the procedure for manual registration as shown in Manual registration on page 101.

**Troubleshooting Automatic Registration**

**Description**
If you have difficulties with automatic registration, do the following:

• Verify that SQL Server Agent is running. If you need to start it, use an administrative logon. For information, see Running and Viewing Scheduled Tasks on page 69.

• Set the automatic registration schedule to the desired interval.

• Run automatic registration from a client workstation with an Internet connection instead of a server.

• Verify that you have a working Internet connection either at the server or the client where you are performing the registration.

• Check for recently installed operating system patches. A patch may interfere with registration data. If you have any problems, contact Sage Software Customer Service.

• Verify that the server license component licreg.dll is installed in the System32 folder on the server or client.

• Use manual registration if automatic registration fails or if you have a firewall that prevents registration through the Internet.
Setting Up Companies and Modules

Overview

Introduction

The next task is to create the companies that you will use in the Sage MAS 500 system and activate the modules to be used with each company.

Multiple companies

You can create more than one company in a set of system and application databases. All of the companies are linked together so that they can be consolidated or used for intercompany transactions. The number of companies you can create in a database set is determined by the license you purchased.

Company setup and security

Company setup is important from a security standpoint for the following reasons:

- You grant users access by company, as well as module and task. For example, you might want an AP clerk to only enter vouchers for one company and not the others.

- You activate modules by company. For example, if you designate a company to be a parent for consolidations, you might only activate the Advanced Consolidations module.

Warning: Only activate the modules that have been registered. You cannot access data in unregistered modules after the grace period has expired. See Registration Grace Period on page 19 for an explanation.
Information Used in Setting Up Companies

When you set up the company, provide the following information:

- Company name, address, phone numbers, and tax IDs. This information is used in reports and transaction documents.

- Home currency for the company. Sage MAS 500 provides a set of predefined currencies. You can set up additional currencies with Multicurrency Management. See the Multicurrency Management guide for more information.

See the Implementation Planning guide for a list of planning tasks to use when setting up companies.
Chapter 6

Setting Up the Company

Procedure

Follow these steps:

1. Log on to Sage MAS 500 as shown in *Logging on to Sage MAS 500 as an Administrator* on page 95.

2. In the Sage MAS 500 Desktop, select the System Manager Maintenance menu > Maintain Companies.

3. At the Company field, type a code for the company you are creating. This code is used to identify the company in Sage MAS 500.

   The company code must start with a letter for consolidations to work properly.

   **Note:** If you are using Internet Applications, the company name entered at the Name field automatically appears on the top of the Web pages. Verify that the company name is entered as you want it to appear on the Web site.

4. Enter the remaining fields. This information is used in financial statements, reports, and other documents generated for that company.

5. Click Save.
Activating Modules

Introduction
You are now ready to activate the modules for that company. Do not activate modules you do not intend to register. You cannot access data in modules that are not registered after the grace period has expired.

Procedure
Follow these steps from the Maintain Companies window.

1. Click Activate Modules. The following window appears:

   ![Activate Modules Window]

2. The window lists all of the modules you have installed. For each module to activate for the company, select the Set Active check box. If a module requires tasks in another module, those specific tasks are activated as well.

3. When you have finished selecting the modules, click Proceed. The system updates the database to support the module. When the process is complete, close the window.

4. If you are finished setting up companies, close the Maintain Companies window, or create or change another company in the Maintain Companies window.
Activating a module does not affect the appearance of modules in LaunchPad. If you try to use a module that is not activated for that company, you get the following message: “Unable to start the selected task. The module associated with this task is not activated.” You can customize the LaunchPad to remove modules that you did not activate for any of the companies. See Desktop Customizations on page 138 for information.

**Fixing modules that are activated but not registered**

If you activate even one module that you did not register, you will not be able to access data in that module after the grace period ends. You cannot deactivate a module after you have activated it.

The only way to stop the system from generating inaccessible data is to reinstall the database. You will lose any data you have entered. Follow this procedure:

1. Run the Database Creation Utility to create a new database set. See Creating New Databases on page 45.
2. Register the modules you purchased.
3. Activate only the modules you registered.

### Editing Companies

**Procedure**

To change company information, do the following in the Maintain Company window:

1. At the Company field, type the company code, or click the Navigator button to select it from a list.
2. Edit the fields and click Save.
   
   The following fields can only be viewed:
   
   - Company: You cannot change the company code.
   - Home Currency: You cannot change the home currency after transactions are entered.
3. Repeat these steps to change another company or close the Maintain Company window.
Deleting Companies

Precaution
If you delete a company, it permanently deletes all data for that company. It cannot be restored, and you cannot undo the deletion. If you mistakenly delete a company, you must use backup files to restore information.

Prerequisites
Before deleting a company, do the following:
- Stop all other activity on Sage MAS 500.
- Back up the databases used by Sage MAS 500.
- Delete all open intercompany transactions for the company you are deleting.
- Look for closed intercompany transactions for that company. If there are any, the company cannot be deleted.
- Allow sufficient time for this process to be completed.

Procedure
To delete a company, do the following in the Maintain Company window:

1. At the Company field, type the company code, or click the Navigator button to select it from a list.
2. Click the Delete (trash can) button.
   A dialog box asks you to confirm. Once you start, the dialog box shows the status of the deletion. When the deletion is finished, the dialog box closes.
3. Repeat these steps to delete another company or close the Maintain Company window.
Setting Up Users

Overview

Introduction

To set up users in Sage MAS 500, follow these general steps:

- Set up security groups for different types of users, such as administrators, clerks, and managers. You can define a default group that applies to all new users, unless you specify a security group for that user.

- Create users. You can create new users directly from Sage MAS 500 or grant access to Sage MAS 500 to existing SQL Server and Windows 2000 domain users. As you create users, you set their access rights.

These steps are described in this section.

**Note:** To create an external user for eCustomer, you do not need to make that person a user in Sage MAS 500. See the *Internet Applications* guide for instructions.

Set Up Security Groups

Description

A security group defines a set of access permissions, which are the rights to view, change, or manipulate data in Sage MAS 500. Users you assign to a security group have the access permissions of that security group. Set up security groups to grant access rights to different modules and tasks for different sets of users.

Ways of setting up security groups

You can set up security groups in the following ways:

- By a specific module: For example, you might assign all Accounts Payable clerks to a security group called “APTASKS” and give that group access only to tasks within the Accounts Payable module.
• By type of task: You can define a group that accesses similar tasks across all Sage MAS 500 modules. For example, you might assign those who analyze your financial data to a group called “REPORTS” and give that group access to all reporting tasks.

• By default: You can create a default security group that is used when users are not granted a specific security group for a company. This default security group should contain permissions only to tasks necessary for all users within all companies.

Prerequisites for setting up security

When you set up security groups, do the following:

• See the module guides for information about which tasks different users need.

• Assign permissions from least permissive to most permissive.

Procedure

Follow these steps to set up security groups:

1 Verify that the company for which to assign security groups is active. For information about logging on to different companies and changing between them, see the Getting Started guide.

2 In System Manager, select the Maintenance menu > Maintain Security Groups. The following window appears:
3 Type a name and description for the security group.

4 You have two options for creating a new security group:
   ▶ Create a new group. By default, a new security group is excluded access from all tasks and security events for all modules. Set up security to the tasks and security events.
   ▶ Copy access rights from another group and make necessary changes. Click Copy From. Select the security group to use as the basis for the group you are creating. You can then change the security setup for your new group.

**Warning:** Do not use the system-defined security group SysAdmin as the basis for the default group. SysAdmin provides high-level security access, such as module activation, which should be carefully restricted.

5 At the Module ID field, select the module for which to assign access rights. You can grant rights to all modules at one time by selecting All.

6 The Tasks tab allows you to grant levels of access to the commands that you can perform with the selected module. For each task, select one of these security levels:
   ▶ Excluded: The user cannot see the task.
   ▶ Display Only: The user can see data in the task but cannot change or use it.
   ▶ Normal: The user can the use task and change the data at all of the fields in the task window.
   ▶ Supervisory: The user has all the normal rights, and has the ability to perform supervisory tasks, such as posting private batches.

Select the level for each task. If you select a different module ID, you are prompted to save the settings.
Tip: To change the permissions of all of the tasks or security events at one time, click the plain gray box in the upper left corner of the Tasks grid. This selects all rows and enables the Default Permission field. Select the security level and click Apply.

7 The Security Events tab allows you to grant access to module-specific overrides in tasks. Security Events handle special circumstances that occur occasionally, such as when a customer exceeds a credit limit or when you need to grant override approval to continue processing data. You may prefer to grant only a few people the permission to override security events. For each security event, you can select either of the following:
   ▶ Yes: User can perform event.
   ▶ No: User cannot perform event.

Select the choice for each security event. If you select a different module ID, you are prompted to save the settings you made.

8 Repeat steps 5 through 7 for each module (if you did not select All).

9 Click Save. You can create another security group or close the window.

Changing security groups
You can change settings for existing security groups. Open the group by typing its code at the Security Group field or click the Navigator button to select it from the list. When you save the changes, they will apply to all users who are assigned to that security group.

Deleting security groups
When you delete a security group, users assigned to that group lose the access rights defined in that group. You can assign users to other security groups to give them access.

Warning: You cannot undo the deletion of a security group.
To delete a security group, open it and click the Delete (trash can) button. A deletion cannot be undone. To reestablish a security group that you have deleted, you must reenter all information for the security group or copy the information from another security group.

## Setting Up Users for Sage MAS 500

### Ways of adding users

You can set up users for Sage MAS 500 in the following ways:

- Add an existing SQL Server user.
- Add an existing Windows user or group, who can be on the same or a different domain. The domain needs to be one to which you have permissions and is accessible from the SQL Server.
- Create a new user who is not already on the SQL Server but has a Windows logon.

### SQL Server access for Sage MAS 500 users

When you add a user to Sage MAS 500, that person is also granted access rights to the SQL Server where the Sage MAS 500 databases are located. You can restrict access to databases on that SQL Server from other applications by using application roles. See **Security Options** on page 121 for more information.

### Restriction in logon names

Do not use reserved SQL Server names, keywords, or characters.

### Requirements for users on the SQL Server

You do not need to create logons in SQL Server before you add them to Sage MAS 500. When you select an existing Windows domain user or group or create a new Sage MAS 500 user in Maintain Users, the SQL Server logon is created automatically. For Windows users who already have a SQL Server associated with them, Sage MAS 500 uses that SQL Server logon.

It is not necessary to create a logon on the SQL Server before adding it to Sage MAS 500.
Procedure

To add users to Sage MAS 500, follow these steps:

1. Verify that the company for which to assign security groups is active. For information about logging on to different companies and changing between them, see the Getting Started guide.

2. In System Manager, select the Maintenance menu > Maintain Users. The following window appears:

![Maintain Users Window](image)
3 Do any one of the following to define or select a user ID:

<table>
<thead>
<tr>
<th>Existing logon</th>
<th>Methods for selecting ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Type the logon name at the User field.</td>
</tr>
<tr>
<td>SQL Server</td>
<td>Do either:</td>
</tr>
<tr>
<td></td>
<td>• Type the SQL Server logon name at the User field.</td>
</tr>
<tr>
<td></td>
<td>• Click Navigator and select the SQL Server logon.</td>
</tr>
<tr>
<td>Windows</td>
<td>Do either of the following:</td>
</tr>
<tr>
<td></td>
<td>• Type the Windows logon name and domain at the User field (such as domain\user). If this is a user on the current domain, type just the logon name; the domain name appears automatically.</td>
</tr>
<tr>
<td></td>
<td>• Click the ellipses (...) button for the Windows User Browser and select the user from the domain. See Selecting the Windows user and domain on page 120 for more information.</td>
</tr>
</tbody>
</table>

Note: If you have logged on with a logon other than the default admin logon, when you click Windows User Browser, you are prompted to enter the system administrator password.

4 Type the user’s name at the Name field.
5 If desired, select a default security group for this user. This security group is used if you do not assign the user to a group for a company. The default group is also assigned to the user automatically when new companies are added to the system.

If you do not assign a default security group, the user needs to be assigned to a security group for each company to which the user has access. If you do not assign the user to a security group for a company when there is no default, that user will be excluded from all tasks within all companies in which permissions have not been granted. You can use this approach to exclude users from a company.

**Note:** You can also control user access by using AppRole and read-only access. See *Security Options* on page 121.

6 To assign the user to a different security group for each company, do the following:

- Select a company code at the Company field.
- Select a security group at the Group field.
- Click OK. The group is added to the list at the bottom of the window. If you change your mind about adding the company and security group to the user, click Undo.

Repeat this step for each company to which to assign the user a security group other than the default.

You can assign users to more than one security group. If the user is in more than one security group for the same company, the system grants the user access permissions of the security group with the highest access permissions per task.

**Note:** You must specify a default security group if you are implementing modifications by group using the Customizer module.
Chapter 6

7. When you are finished assigning security groups to that user, click Save. You can then assign security groups to another user or close the window.

Selecting the Windows user and domain

If you are assigning a Windows user or group, click the ellipses (...) button in the Maintain Users window to select the domain and user or group name. The Domain Users window appears:

Perform the following:

1. At the List Names From field, select the domain where the user or group is located. The list changes to show the users and groups in the domain.

2. Select the user or group. If you select a group, you can click Members to list the members in the group.

3. Click Add. The user or group you selected appears at the Add Name field.

4. Click OK. The Domain Users window closes and the user or group you selected appears at the User field in the Maintain Users window.
Security Options

**Description**
When you add users to Sage MAS 500, they are granted access to the SQL Server where the Sage MAS 500 databases are located. If you have databases from other applications, you can control the access that Sage MAS 500 users have to them. You can also enable read-only access to Sage MAS 500 databases from other applications.

**Using application roles**
The application roles (also known as AppRoles) feature allows users to access Sage MAS 500 databases through the Sage MAS 500 client software, but not other applications. This option creates an application role logon on the SQL Server that enables the application to assume the access rights to complete tasks without granting the user explicit rights. The user can have the access you granted while in Sage MAS 500, but not access to the other application databases on that SQL Server.

**Procedure**
To use application roles, you need to follow these steps in System Manager:

1. In the Maintain Site window, click the Options tab and select the Enable Application Role check box to set up the ApplicationAppRole. Assign a password.
2. When you use Maintain Users to grant user access rights, select the Use Application Role check box to restrict the rights of that user to Sage MAS 500 databases.

For more information about application roles, see the SQL Server Books Online.

**Allow read access**
When the application role is enabled and the Use Sage AppRole option has been selected, users cannot access Sage MAS 500 databases except through the Sage MAS 500 client software. Select the Allow Read Access option to grant users read-only access to Sage MAS 500 databases from other programs.
Another way to add security to the system is by requiring passwords for users. In the Maintain Site window, click the Options tab and select the Require Passwords check box.

### Changing User Settings

**Introduction**

If you need to change settings or delete a user, follow the instructions in this section.

**Changing user security rights**

You can change the security groups to which the user has access at any time. Follow these steps:

1. At the User field, select the user to change. For users set up in the system, Yes is selected at the Is Sage MAS 500 User field.

2. Make the changes. Note the following:
   - To remove the user from a security group, right-click it and select Delete from the menu that appears.
   - To insert a row into the list, right-click where to put the row and select Insert Line. A blank row is inserted above the row you selected. Select the company at the Company field and security group at the Group field, and click OK. The information is inserted into the blank row.

3. Click Save.

**Clearing passwords**

The Maintain User window also enables you to clear the password of users who have forgotten them. This applies only to users with SQL Server authentication.

Open the user information by selecting the user at the User field. Click Clear Password. Users can define a new password in the User Preferences window, which is described in Chapter 8, *System Configuration and Management*. 
Deleting users

When you delete a user from the system, you remove all access rights to all companies in Sage MAS 500 for that user. You are not deleting the user from SQL Server. Deleting user access also does not affect references to that user in Sage MAS 500 data, which preserves the audit trail.

**Important:** A dedicated user, ProcessWebSOUser, is created automatically when you create the Internet Application database. This user is used for adding sales orders to the application database. Do not delete this user. For more information, see the *Internet Applications* guide.

Open the user information by selecting the user at the User field and then click the Delete (trash can) button.

To delete a user from both Sage MAS 500 and SQL Server, delete the user from Sage MAS 500 first. Then, delete the user from SQL Server.
Chapter 6
Managing and Protecting Databases

This chapter shows how to move and copy Sage MAS 500 databases, and synchronize Sage MAS 500 users.

In this chapter
Using the Database Synchronization Utility ............... 126
Options for Copying or Moving Databases ............... 131
Using the Database Synchronization Utility

Overview

Introduction
Use the Database Synchronization Utility after you move or copy Sage MAS 500 databases. This utility enables you to use databases on another SQL Server by adding users in the Sage MAS 500 databases to the new SQL Server and resetting internal database references in the databases.

This section explains how to use the Database Synchronization Utility and configure the client software after moving or copying the databases. See Options for Copying or Moving Databases on page 131 for instructions on how to move or copy databases in different configurations.

Precautions

Introduction
This section lists information you should be aware of before you move or copy databases.

Installation
The Database Synchronization Utility is installed with the Database Utilities. If you have not installed the database software, see Chapter 4, Database Creation and Upgrade for procedures.

Preliminary tasks
Before performing the procedures shown in this chapter, note the following:

Verify that the SQL Server meets the requirements. For more information, refer to the Sage MAS 500 Compatibility and Resource Guide located on the Sage Software Web site:

http://support.sagesoftware.com/mas500/support/documents/compatibility.htm
To perform these procedures, you must have knowledge of SQL Server and systems functions. The operations are, therefore, beyond the general scope of Sage MAS 500 Customer Support. If you are not familiar with these operations, defer the procedure to a knowledgeable professional.

Effects on registration
Registration of Sage MAS 500 is tied to a Sage MAS 500 database set and the SQL Server where it is installed. If you change the database names or place the databases on another SQL Server, you need to reregister. See Registering the Software on page 97.

Starting the Database Synchronization Utility

Procedure
To start the Database Synchronization Utility, follow these steps:

1. From the Windows Start menu, select Programs > Sage Software > Sage MAS 500 > Utilities > Database Synchronization Utility.

2. You are prompted to log on. Select the SQL Server where you put the moved or copied files. Type the sa password for that SQL Server. Click OK.
The following window appears:

![Sage MAS 500 Database Utility]

**Using the Utility**

**Description**

To use the utility, select the databases that you moved or copied to the SQL Server. You then use options to indicate what items to reset, as described in this section.

**Synchronize Sage MAS 500 users**

The Synchronize logons on a new SQL Server check box adds the users created in Sage MAS 500 to the SQL Server where you put the databases. Select this check box if you copy or move databases to a new SQL Server.

When you recreate the users on the new SQL Server, the following options are available:

- The Create new SQL Server logon with no password and clear user password option creates a new SQL Server logon for each user with a null password. The users in the databases are removed and recreated, and their database object permissions are regranted.
Managing and Protecting Databases

- The Create new SQL Server logon with the same name and password option creates a new SQL Server logon for each user with the password defined in Sage MAS 500. The new logons are linked to the users in the databases, and their database objects permissions are retained.

<table>
<thead>
<tr>
<th>Check Sage MAS 500 database name references</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Check database references check box resets the internal name references used by Sage MAS 500 to refer to the other databases in the set. Select this check box when you rename databases or copy them to another server.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Registering the new databases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Databases need to be registered when they are moved to a new server. To register the databases as you sync them, select the Send new registration request check box. Type your existing information or new registration information at the Customer Number, SM Serial Number, and SM Unlocking Key fields.</td>
</tr>
</tbody>
</table>

To develop databases on a test server and then move them to another server when you are ready to use them for production use, first create the databases on the test server using TEST as the System Manager serial number along with your customer number and System Manager unlocking key. When you move the databases and run the Database Synchronization Utility, select the Send new registration request check box and type the same customer number and System Manager unlocking key, but enter the System Manager serial number from your packing slip.

During synchronization, the system performs automatic registration. If automatic registration fails, you need to run manual registration after the database has been synchronized.

For more information about the registration process, see Registration Process on page 16. For the registration procedure, see Registering the Software on page 97.
Connecting the Client

Procedure

After moving or copying databases, change the pointers Sage MAS 500 uses to find the server and clients. Perform these changes by following these steps:

1. Start the Desktop Configuration Utility within ODBC and add any required advanced information for the new server. See Appendix D, Protocol Issues for detailed instructions.

2. Run the Desktop Configuration Utility as shown in Viewing System Settings on page 153.

3. Select the server and click Refresh. Select the system and application database to use.

4. Start the Sage MAS 500 client. (See Starting Sage MAS 500 as an Administrator on page 94 for instructions.) At the logon window, select the Advanced Options check box to verify or change the server and databases to which the client is connecting.
Options for Copying or Moving Databases

Overview

Introduction

This section explains ways for copying or moving Sage MAS 500 databases either to the same SQL Server or another SQL Server.

Copying Data Between Companies

Description

Note the following to make copies of settings used by a company: Assisted Company Setup enables you to copy settings and data from one company to another within the same set of databases. It cannot transfer settings from a company on another database.

To create a company using settings in another database, do the following:

1. Make a copy of the database containing the company you want using the procedures in this section.
2. Create the company on the database.
3. Use Assisted Company Setup to copy settings from the desired company to a new one.
4. If desired, delete the company from which you copied the settings after you have set up the company to your satisfaction.

For information about Assisted Company Setup, see the Implementation Planning guide.
Single-User Unique Set on Same SQL Server

Procedure
You can create more than one Sage MAS 500 database set on the same SQL Server.

To create a second unique database set using the same server with access granted to the “admin” user ID only, follow the steps below. This scenario does not allow a password or password change in either database set for the admin user.

1. Run the Database Creation Utility. See Chapter 4, Database Creation and Upgrade for instructions.
2. From the Database Creation Utility, specify device and database names different from those previously created.

Multiuser Duplicate Set on Same SQL Server

Procedure
You can create a duplicate database set on the same SQL Server with access granted to multiple users.

To create a second duplicate database set using the same server with access granted to multiple users, follow the steps below. This scenario does not enable a password change in either database set for SQL Server users. This does not apply when using Windows authentication.

1. Run Enterprise Manager. Create a new database for the Sage MAS 500 application database by performing the following:
   - Select the server where you want to put the database.
   - From the Action menu, select New > Database.
   - Specify the same file sizes for the database and transaction log as those shown in the production database.
2 Back up the Sage MAS 500 application database. On the Tools menu, select Tools > Backup Database. Then select these options:
- Select the Sage MAS 500 application database to back up.
- Under Backup, select Database - complete.
- Under Destination, add a new backup destination. It can be either a local or mapped hard drive or tape. Verify there is enough space to accommodate the data.
- On the Options tab, select Overwrite existing media, Verify backup upon completion, and Initialize and label media. Assign the proper name and description to the media set.
Click OK to start the backup.

3 Repeat steps 1 and 2 for the production Sage MAS 500 system database.

4 Restore the Sage MAS 500 databases you backed up into the databases you created. From the Tools menu, select Restore Database. Starting with a restore of the application database, specify the settings as follows:
- At the Restore as database field, select the database you created on the destination server as the application database.
- Select From device.
- Select the device where you backed up the production application database.
- Select Restore backup set and Database - complete.
- On the Options tab, select the Force restore over existing database check box and the Restore database files as check box. Enter the drive, path, and file name where the database will be restored.
Click OK to start the restore. When you are finished with the application database, repeat this step to restore and system database.
5. Run the Database Synchronization Utility as shown in *Using the Database Synchronization Utility on page 126*. Log on to the destination SQL Server.

6. Log on and select the new databases created. Select Check database reference, and click Proceed.

### Multiuser Duplicate Set on a Separate SQL Server

**Description**

You can create a duplicate set of databases on a separate SQL Server. You can grant access to either set to multiple users, and this configuration enables the use of passwords and permits password changes for all users.

If all users created use Windows authentication and the new SQL Server does not connect to the same domain, these users will no longer have logon abilities into Sage MAS 500. New Windows or SQL Server users will have to be created.

To make a duplicate set, you back up the original databases and restore the data into new databases you create on the other SQL Server.

In this procedure, the SQL Server on which the databases originate is referred to as the production server. The destination SQL Server is referred to as the destination server.

**Procedure**

Follow these steps. If you need more information about performing these procedures, see the SQL Server documentation.

1. Run Enterprise Manager. Verify that the production and destination servers are registered.

2. Back up the Sage MAS 500 application database. From the Tools menu, select Tools > Backup Database. Then select these options:

   - Select the Sage MAS 500 application database to back up.
Managing and Protecting Databases

- Under Backup, select Database - complete.
- Under Destination, add a new backup destination. It can be either a local or mapped hard drive or tape. Verify there is enough space to accommodate the data.
- On the Options tab, select Overwrite existing media, Verify backup upon completion, and Initialize and label media. Assign the proper name and description to the media set.

Click OK to start the backup. When you have finished backing up the application database, repeat this step to back up the Sage MAS 500 system database.

3 On the destination server, create two new databases: One for restoring the system database and the other for restoring the application database. Make the new databases and their accompanying transaction logs the same size as the ones on the production server.

4 Select the destination server. From the Tools menu, select Restore Database. Starting with a restore of the application database, specify the settings as follows:
   - At the Restore as database field, select the database you created on the destination server as the application database.
   - Select From device.
   - Select the device where you backed up the production application database.
   - Select Restore backup set and Database - complete.
   - On the Options tab, select the Force restore over existing database check box.

Click OK to start the restore. When you are finished with the application database, repeat this step to restore the system and Internet Application databases.

5 Run the Database Synchronization Utility as shown in *Using the Database Synchronization Utility on page 126*. Log on to the destination SQL Server.
In the Database Synchronization Utility, enter the destination databases into which you restored the databases. Select the Synchronize logons on a new SQL Server check box and the Check database references check box. Click Proceed.

The new databases are ready to use.
System Configuration and Management

This chapter shows you how to customize the Desktop and perform system management tasks.

In this chapter
   Desktop Customizations .............................. 138
   System Management ................................. 150
Desktop Customizations

Overview

End-user customizations

End users can customize the Desktop by adding tasks to My Tasks, arranging and changing toolbars, and docking the Desktop to the tops of their screen. These procedures are described in the Getting Started guide.

Administrator customizations

As an administrator, you can make additional customizations to the Desktop:

- Change tasks in the Tasks tab. This determines which tasks are available to the users.
- Select a task menu that applies to all users.
- Create different menus for different users. For example, you can create a task menu for Accounts Payable clerks and assign it to each clerk.

These are described in this section.

When customizations are applied

All customizations to the Desktop take effect the next time you start Sage MAS 500. To apply the customizations, shut down Sage MAS 500 and log back in. The customization changes appear in the Desktop.

Prerequisites for Making Administrative Customizations

Requirement for access rights

In order to make administrative customizations, you need Supervisory or Normal rights for SM Desktop Customizer. For information about setting access rights, see Set Up Security Groups on page 112.
Important: Set all other security groups to Excluded for SM Desktop Customizer. This prevents unauthorized users from making changes that affect all users.

Changing and Saving Task Menus

Understanding tasks menus
You can modify the collection of folders, tasks, and shortcuts in the Tasks tab and save it as a task menu. You can save multiple task menus for different types of users.

Default task menu
Sage MAS 500 provides the following task menus:

- Standard: Default Sage MAS 500 task menu. Use it when restoring a customized Task menu to its original settings.

- Sage MAS 90 and 200 Menu: Uses the same organization as Sage MAS 90 and 200 menus. This task menu is helpful if you are migrating from Sage MAS 90 and 200.

These provided task menus cannot be changed or deleted.

Commands for customizing task menus
Commands for customizing task menus are available from the Tools menu by using the Menu Maintenance toolbar. To open the toolbar, right-click a toolbar and select Menu Maintenance.

Saving task menus
To change the menu in the My Tasks menu and save it, do the following:

1. In the My Tasks menu, add, move, or delete tasks and folders as shown in the Getting Started guide and the Information and Support Center.
Chapter 8

2 From the Tools menu, select Organize Menu > Save As. The Save As window appears:

3 Type a name and description for the task menu. The name can be up to 15 characters, and the description can be up to 30 characters. Select the Use as Site Default check box to use the task menu as default for this site. Click Save.

Opening an existing task menu

To open a task menu, from the Tools menu, select Organize Menu > Open. A task menu can also be accessed by clicking the menu bitmap on the status bar or by double-clicking the menu on the status bar. The following window appears:

Select the task menu and click OK. The task menu changes to the tasks you selected.

Restoring a task menu

To undo modifications to the current task menu made from the previously saved task menu, from the Tools menu, select Organize Menu > Reset. Any changes you have made from the last saved version will be lost.

Changing a task menu

If you need to make further changes to a task menu, from the Tools menu, select Organize Menu > Save. The saves your changes using the same task menu name.
This command is not available when the standard or Sage MAS 90 and 200 task menu is active. Use the Save As command to save the task menu under a different name.

### Deleting a task menu
To delete the open task menu, from the Tools menu, select Organize Menu > Delete. This command is not available when the standard or Sage MAS 90 and 200 task menu is active.

### Setting Task Menus for Users

#### Description
You can select a task menu for all users and assign task menus for individual users.

#### Setting the task menus for all users
In Maintain Site, set the default task menu. This is used for all users for whom you have not assigned a task menu. For security, assign the task menu with the minimum needed menu items.

Do the following:

1. Create and save the task menu to set as default as shown in Changing and Saving Task Menus on page 139.

2. In the Desktop, select the System Manager Maintenance menu > Maintain Site.
On the Maintain Site window, go to the Options tab.

At the Default Task Menu field, select the task menu to use as default. Click Finish and Exit.

Setting a task menu for a user

You can set a task menu for an individual user or user group. Do the following:

1. In the Desktop, select System Manager > Maintenance > Maintain Users.
2. At the User field, select the user or user group to whom you are assigning the task menu.
3. At the Task Menu field, select the task menu you are assigning.
   
   Note: It is recommended that you assign the System menu only to system administrators.

4. Save the settings.

For more information about Maintain Users, see Setting Up Users on page 112.
### Adding Custom Reports

**Description**
You can create custom reports that can be used from the Desktop and Web Reports. You create the report in Crystal Reports Designer and then add it to the Desktop.

**Custom reports**
To see examples of custom reports, see the files in the Sample Custom Reports folder in the Sage MAS 500 client folder. The following sample reports are provided:

- **CustomerListing.rpt**: A simple list of customers selected from one table in the database.

- **CustomerSalesByPeriod.rpt**: A more complex example that selects header and detail records from two separate tables. This report totals sales per customer, and groups sales per fiscal period.

**Creating reports**
Follow the instructions in the Crystal Reports Designer documentation to create a report.

For the database connection, use ODBC with the Sage MAS 500 DSN names, acuity-sys and acuity-app.

The following formulas are available to populate data from the Sage MAS 500 databases and to select data to include in the report. For example, a report can be restricted to include only the records of the company from which the report was run.

- CompanyID
- CompanyName
- UserID
- BusinessDate
- RunDate
- RunTime
- ReportFileName
Create the formulas in Crystal Reports as "". For Web Reports, do not set up the report to prompt for parameters. Reports that will be used by Web Reports must run from a server without direct user intervention.

**Where to place a report**

When you finish a report, you can save it either on your local drive or on the network. If you save it on your local drive, only you will have access to it. To make the report available to other users, save it on a network drive and grant users access to the folder where you saved the report file. If you are saving the file on an NTFS volume, grant NTFS and Share permissions to the users who will use the report. Users who do not have these permissions will not be able to run the report even if they have been granted rights to run it in System Manager.

**Adding reports to the Desktop**

When you add a report to the Desktop, you have the option of having the report available in Web Reports. Follow these steps:

1. In the Explorer Bar, navigate to where you want to place the report.
2. Right-click and select Create New Task > Custom Report. The following window appears:

   ![Add Custom Report](image)

3. Complete the window as follows:
   - Select the module for the custom report.
   - Type the file name at the Custom Report field or click Browse. If the file is on the network, use the UNC path (\server\path) so that users do not need to have the drive mapped to that path.

---

144 Installation and System Configuration
At the Name field, type the name that you want to appear in the Desktop and Web Reports.

At the Task Name field, type a name that will be used internally by Sage MAS 500 to identify the report. This name will be used when you grant security access, create shortcuts elsewhere in the Desktop, and other tasks.

Type a description of the report.

To use this report in Web Reports, select Web Enabled and follow the instructions in the Web Reports guide.

Click OK. The report is added to the Desktop and created as a task in Sage MAS 500.

4 In Maintain Security Groups, create or modify groups to grant access to the custom report you added. The report is listed in the Tasks tab and using the module and task name you assigned. Save the changes you made.

5 In Maintain Users, assign the security group to the users or groups who will be able to run the report. Verify that the user also has access to the folder where the report file is located.

In the Desktop, users who have access to the report can open it like any other report. In Web Reports, users who have access to the report select it by choosing the module to which you assigned the report and then selecting it by its task name.

Search Form Customization

Administrative customizations

Users can customize the Search form by selecting the columns to appear in the grid, setting their column width and order, and then saving the settings in views. Search criteria settings on the Filter tab can be saved with the view. See the Getting Started guide for instructions.
As an administrator, you can control Search form customizations by changing the SQL view by the lookup, or by customizing the lookup view using Maintain Lookup Views. Changing the SQL view is more complex than Maintain Lookup Views but offers the maximum flexibility in customization. For each lookup, you can limit the columns that users can select and create your own views.

**Procedure for maintaining lookups**

Maintain Lookup allows you, as an administrator, to associate a lookup ID with a SQL view. You can use SQL to create your own views that can then be used by a lookup.

**Note:** Sage MAS 500 tasks are dependent on some fields returned from the view. Because of this, you should never remove columns from a SQL view. When creating your own SQL views, start by making a copy of the SQL view used by Sage MAS 500 and then altering the new SQL view to add the new columns or tables.

Follow these steps:

1. From System Manager, select the Maintenance menu > Maintain Lookups. The Maintain Lookups window appears.
2. At the Lookup field, select the lookup to change.
3. At the Current SQL Command field, type or select a SQL view to associate with this lookup. The SQL view currently associated with this lookup automatically displays.

You can also choose to include both ANSI and non-ANSI queries.

**Note:** For all customizations to take affect, users need to close any tasks they are currently running and reopen them.
System Configuration and Management

<table>
<thead>
<tr>
<th>Affects to the underlying SQL query</th>
<th>The following table outlines some of the possible affects to the underlying SQL query in various circumstances:</th>
</tr>
</thead>
<tbody>
<tr>
<td>If...</td>
<td>Then...</td>
</tr>
<tr>
<td>...the customization refers to a column that no longer exists</td>
<td>...the customizations are automatically removed without notification. This allows administrators to change the lookup without causing error messages to appear on end user workstations.</td>
</tr>
<tr>
<td>...the customization impacts the query and causes an error</td>
<td>...the lookup attempts to use the standard (factory) settings to retrieve the data.</td>
</tr>
<tr>
<td>...the SQL query is modified so that critical columns required by the program are missing or the factory definition fails</td>
<td>...an error message displays and no data is returned.</td>
</tr>
</tbody>
</table>
Maintain Lookup Views allows you, as an administrator, to control the customizations that end users make to the Search window. You can also create customized lookups and make them available to users.

Follow these steps:

1. From System Manager, select the Maintenance menu > Maintain Lookup Views. The Maintain Lookup Views window appears:

   ![Maintain Lookup Views window](image)

   - Search for a lookup by its name
   - Search for a lookup by a view name

2. At the Lookup field, select the lookup to change.

3. Select the view for the lookup to which to apply settings.

4. Select the display options for the view.
   - Select the Set as Default check box to use the Lookup View field as the default for this lookup. When users open the Search form, it opens with the default view.
   - Select the Restrict to Display Columns check box to limit which columns a user can add to a view. When a user opens the Lookup View Columns window to select columns, that user can only view the columns you have selected. Select this check box when there are columns with sensitive data that you do not want users to view.
Select the Load Data Immediately check box to load data when the Search window is opened. If search criteria is saved with a view or the Search window, the lookup retrieves the data according to the criteria.

**Note:** Select the Load Data Immediately check box to reduce the number of steps a user must perform in order to find data, if there is only a small dataset to load. Clear this check box for large datasets so that excessive amounts of data are not returned.

5. To change the width and order of columns, click Edit Lookup View. The Search window appears where you can change columns widths by dragging column borders and add or remove columns by clicking the Form Customizer button. Then, save the view. (See the *Getting Started* guide for instructions.)

6. Save the changes.
Chapter 8

System Management

Overview

Introduction

Sage MAS 500 has several system management features that enable you to monitor and manage the usage of the system. These features enable you to do the following:

- Set the business date.
- Monitor who uses the system.
- View system settings.

These are described in this section.

Setting the Business Date

Description

In Sage MAS 500, the business date is the default date for the reports and transactions you generate. (See the Getting Started guide for an explanation of how Sage MAS 500 uses dates.)

End users have some control over what date is used as the business date through the User Preferences command in System Manager. The system date (that is, the date in the client system) can be used as the business date, or the same business date can be used for all modules.

When to change the business date

There are situations to use a different business date, such as when you need to enter a journal entry for a future date. You can change the business date ahead to next month, write the journal entry, and return the business date back to the present month.
Procedure

To change the business date, do either of the following in the Desktop:

- From the File menu, select Change Business Date.
- Double-click the business date at the far right of the status bar.

Depending on the settings in User Preferences, one of the following versions of the window will appear.

- If the Use Same Business Date for All Modules check box is selected, the following window appears.

![Change Business Date](image)

Select the business date and then click the Finish and Exit button (on the left). The date applies to all modules.

- If the Use Same Business Date for All Modules check box is cleared, the following window appears.

![Change Business Date(s)](image)

Select the module and then select the business date for that module. Repeat for each module you need, and then click the Finish and Exit button.
Monitoring System Usage

Ways of tracking usage  Sage MAS 500 has several tools that enable you to track who is using the system.

System Status window  To view who is currently logged into the Sage MAS 500 database you are using, use System Status. In the Tasks pane, select the System Manager Tools menu > System Status.

A window appears that shows the user’s ID and name, when the user logged on, and what companies the person is using. The window appears as follows:

![System Status window](image)

This information is useful when you need exclusive use of Sage MAS 500 or of a company.

Tracker  Tracker shows messages generated by Sage MAS 500 events, such as opening forms and saving data. Any errors appear in the message. Support might ask you to view the Tracker window to help you resolve a problem.
To open the Tracker window, from the Desktop Tools menu, select Display Tracker. The Tracker window appears:

![Tracker window](image)

To close the Tracker window, from the Desktop Tools menu, select Display Tracker again.

### User IDs on reports

You can print the ID of the user who ran a report. This feature is helpful when several people use a shared printer, or you need to track the report generation when deciding who should have access to reports.

Select the System Manager Maintenance menu > Maintain Site. In the Maintain Site window, click the Options tab and select Print User ID on Reports.

### Viewing System Settings

#### Tools for viewing settings

To help you troubleshoot your system, Sage MAS 500 has two tools for viewing system settings:

- Configuration Utility shows the SQL Server and databases you are currently logged into and the location of program files.

- System Inspector shows system and Sage MAS 500 settings, files, and Registry entries.

These tools are described in the following sections.
Chapter 8

Desktop (Client) Configuration Utility

To start the Configuration Utility, from the Windows Start menu, select Programs > Sage Software > Sage MAS 500 > Utilities > Desktop Configuration Utility. The Configuration Utility window appears:

As described in the Getting Started guide, the Configuration Utility can be used for changing the SQL Server and database you are logged on to. If you are using Windows authentication, you can make the logon window reappear by clearing the Use Windows Authentication box. You can also clear the Show Startup Logo check box to remove the Sage MAS 500 logo to improve startup speed over Windows Terminal Services.

**Note:** “Sotaadmin” is no longer used in this utility. If you do not have a windows logon to the SQL Server, a logon dialog will appear.

You can configure the settings for each user or for all users on the system. The application settings are written to the registry for each user in C:\Documents and Settings.
The Configuration Utility also allows you to view the folders used for program and help files for the client system you are using. If you get errors in launching parts of the program or help, this window shows the folders where the files are supposed to go. You can change the path by clicking on path button. Avoid using this feature because you can render the Sage MAS 500 client unusable if you set the folders incorrectly.

If you change settings in the Desktop Configuration Utility while Sage MAS 500 is running, the changes are applied when you close and re-log on to Sage MAS 500.

**System Inspector**

To start the System Inspector, from the Windows Start menu, select Programs > Sage Software > Sage MAS 500 > Utilities > System Inspector. The System Inspector window appears:

The left pane shows the types of information available in System Inspector. Select the type of information, and the data appears in the right pane. If a type has a + in front of it, double-click it to drill down to additional information.
You can save the information by doing either of the following:

- Click the Save button or select Save As from the File menu to save the information in a file.
- Click the Print button or select Print from the File menu to print the information.
System Manager reports provide information about the system, including system activity, security, and system-wide information. You can use reports to maintain a history of system activity or to troubleshoot problems.

This appendix describes the report and inquiry options available in System Manager. For information on Sage MAS 500 report types and features, and how to generate and print reports, see the Getting Started guide.

**Important:** Some reports contain sensitive information. Control access to these reports and keep printouts in a safe location.

**In this appendix**
- System Manager Reports .......................... 158
- System Manager Lists ............................. 161
System Manager Reports

Overview

Definition
Reports present a record of activity over a period of time.

Reports
System Manager reports are generated from the Reports menu.

System Activity Log

Contents
This report provides information on any major event that occurs in your system, such as the addition or deletion of users, intercompany transactions, or unrecoverable errors.

Sorting
You can sort the list by:

- Event Date
- Event Description
- Event Time
- User

Generating
Select System Activity Log from the Reports menu.

Purging
Periodically, purge the System Activity Log to keep it a manageable size. Follow these steps:

1. Back up the data before purging any information.
2 From the Activities menu, select Purge Activity Log. The following window appears:

3 Select the items to purge.
4 Click the Finish and Exit button.

**Maintenance Audit Log**

**Contents**

This report provides information on any major event that occurs in your system, such as the addition or deletion of users, intercompany transactions, or unrecoverable errors.

**Database option**

The report can generate information from the application or system database.

**Sorting**

You can sort the list by:

- Company
- Operation
- System Date
- User

**Generating**

Select Maintenance Audit Log from the Reports menu.
Company Profile Report

Contents
This report provides information for a company, including its address, telephone and fax numbers, Federal ID number, database connections, and home currency. This information is drawn from information you enter in Maintain Companies.

Sorting
You can sort the list by:
- Company
- Company Name

Generating
Select Company Profile from the Reports menu.

Company User Group Permissions Report

Contents
This report provides a list of all companies and their corresponding security groups.

Generating
Select Company User Group Permissions from the Reports menu.
# System Manager Lists

## Overview

**Definition**
Lists contain settings and definitions established for the operation of the system.

**Lists**
System Manager lists are generated from the Maintenance or Reports menu, or by clicking the Print button in the associated task.

- **User List**
- **Security Group List**
- **Company List**
- **Site Profile List**
- **Assisted Company Setup List**

## User List

**Contents**
The User List provides a list of user codes, names, and default security groups.

**Sorting**
You can sort the list by:

- User
- User Name

**Generating**
Produce this list in one of the following ways:

- Select the Reports menu > Other Lists > User Group List.
- In the Maintain Users window, click the Print button.
Appendix A

**Security Group List**

**Contents**  
The Security Group List provides a list of security group codes, descriptions, and assigned access permissions.

**Generating**  
Produce this list in one of the following ways:

- Select the Reports menu > Other Lists > Security Group List.
- In the Maintain Security Groups window, click the Print button.

**Company List**

**Contents**  
The Company List provides a list of all the companies defined in your system and includes company codes, names, and database connections.

**Generating**  
Produce this list in one of the following ways:

- Select the Reports menu > Other Lists > Company List.
- In the Maintain Companies window, click the Print button.

**Site Profile List**

**Contents**  
This report lists the modules you have registered and activated and information about the registration. You can print this report and save it for your records.
Working with Reports

Format

The report is available in these formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Profile</td>
<td>Shows information about your license; your customer number, System Manager serial number, and System Manager unlocking key; and the modules you have registered.</td>
</tr>
<tr>
<td>Activated Modules</td>
<td>Lists the modules you have activated.</td>
</tr>
</tbody>
</table>

Generating

Generate the report by doing one of the following:

- Select Site Profile List from the Reports menu.
- Click the Print button in the Maintain Site window.

Assisted Company Setup List

Contents

The Assisted Company Setup List produces a list of all of the phases and steps of Assisted Company Setup. For each phase and step, the list shows the status, the user assigned to it, and comments.

Generating

Produce this list in one of the following ways:

- Select the Reports menu > Other Lists > Assisted Company Setup List.
- In the Assisted Company Setup window, click the Print button.
Installation and System Configuration enables you to leverage Microsoft Project for developing time and resource plans by uploading your projects directly into the Project Accounting module.

Microsoft Project Link features include:

- An easy-to-use estimate creation wizard
- The ability to generate Microsoft Project tasks from built-in Project Accounting tasks
- A reduction in the need for duplicate data entry

For information about assigning tasks and levels, and managing resources, see the Project Accounting Help system.

In this chapter
Integration with Project Accounting ....................... 166
Setup. ............................................................ 167
Integration with Project Accounting

Overview

The Project Accounting and Microsoft Project Link modules work together to integrate scheduling and costing for your projects.

Note: This documentation assumes a working knowledge of Microsoft Project and the Sage MAS 500 Project Accounting and eTimesheets modules. For more information, refer to their respective documentation.

To best use Microsoft Project Link, create your project schedules in Microsoft Project. Use phases, tasks, and resources from the Project Accounting module so that you are using the same components in both products. Then, from your project plan, you can create an estimate in Project Accounting. After your plan is used to create an estimate, the product will work independently, except that your eTimesheets’ timesheets can be used to transfer actuals to Microsoft Project and the Project Accounting module.
Setup

Introduction  This section describes the setup tasks to perform before you begin using Installation and System Configuration.

Setup steps  The Microsoft Project Link setup process requires you to complete the following tasks:

- Install Microsoft Project. For information, see the Microsoft Project documentation.
- Set up defaults in Microsoft Project. See Microsoft Project Setup on this page.
- Install the Project Accounting module and Microsoft Project Link.

Microsoft Project Setup

Setting default information  Depending on whether you will create most of your projects online or offline, it is recommended you set up the following defaults in the Microsoft Project Options window (Tools > Options > Save tab):

**For online projects (connected to the server)**
If you plan to create most of your project plans online (for example, in the office), set the default save option to the ODBC database. If you have saved your settings for the ODBC database option, but need to save a project offline, you do not need to come back to this window and change the setting.
For offline projects (not connected to the server)
If you plan to create most of your project plans offline (for example, off site while traveling or from a remote office), set the default save option as an .mpp file. If you need to save a project plan online, you do not need to come back to this window and change the setting; choose Save As from the File menu in Microsoft Project, and then click the ODBC button.

On the Schedule tab of the Options window, be sure that the Work is entered in option is set to Hours; this is because timesheets in eTimesheets are entered in hours.
This chapter provides general information and requirements for Sage MAS 500 Alerts installation and configuration.

In this chapter
SQL Server Agent .................................. 170
SQL Server Mail ..................................... 171
Appendix C

SQL Server Agent

Overview

Because SQL Server Agent is a core component of Sage MAS 500 Alerts, consider the following before you begin Sage MAS 500 Alerts installation:

- SQL Agent must be running.
- We recommend that SQL Agent be configured to auto-start when SQL Service starts.
- You should be familiar with the Jobs dialog box for SQL Agent under Enterprise Management.
- SQL Agent has multiple options for logging errors: by default, Alert jobs log to the SQL Agent Error Log.
- Changes made to job schedules in Enterprise Manager will also be mad to Sage MAS 500 Set Up Alerts.
- Do not make changes to the Job or Job Step objects for Sage MAS 500 Alerts jobs.
SQL Server Mail

Introduction

SQL Server Mail must be configured correctly to run Sage MAS 500 Alerts. Consider the following before you begin Alerts installation:

- You must configure a mail profile on the server while logged in as the same Domain User that SQL Server will use.
- We recommend you provide a dedicated e-mail account for SQL Server.
- SQL Mail (under SQL Server 2000) requires Microsoft Outlook 2000 on the database server. SQL Mail will not work with other MAPI clients.
- The SQL Server must be configured to use a Domain User account in order to use SQL Mail (that is, SQL Mail cannot be configured with the default System Account setting).
Appendix C

Installation and System Configuration
This appendix provides detailed information to help you set up network protocol with the server. For more information about network protocols and other requirements, refer to the Sage MAS 500 Compatibility and Resource Guide located on the Sage Software Web site:

http://support.sagesoftware.com/mas500/support/documents/compatibility.htm

In this appendix
- Named Pipes over TCP/IP ......................... 174
- Multi-Protocol over TCP/IP (Port 1434) ............. 176
- TCP/IP Sockets over TCP/IP Protocol ............... 178
# Named Pipes over TCP/IP

## Description
A general rule for connecting using Named Pipes is that you must be logged in to the domain in which the SQL Server resides, or have an open pipe into a resource at the SQL Server. A pipe can be opened to the IPC$ sharepoint on the server using the net view command-line utility. Connecting to any other shared resource using the browse or mapping features in Windows Explorer or the Network Neighborhood applet serves the same purpose.

## Indication of operating protocol
When you use Named Pipes over TCP/IP, you should be able to do the following:

- Ping the SQL Server at a command prompt from the client machine.
- Connect to the SQL Server using the acuity-app and acuity-sys ODBC DSN.

Use the procedures in the following sections to set up the network protocol.

## SQL Server setup procedure
Follow these steps to set up the SQL Server.

1. From the Windows Start menu, select Programs > Microsoft SQL Server group > Server Network Utility.
2. Select Add.
3. Enter the pipe name at the Pipe name field, or accept the default by selecting OK.
4. The SQL Server Network Utility returns you to the General tab page. Select OK.

## Client (including Terminal Services) setup procedure
Follow these steps to set up the client.

1. Remove the NetBEUI protocol from the client system, or specify the TCP/IP protocol as the first in the Workstation binding order.
2 From the Windows Start menu, select Settings > Control Panel. In the Control Panel window, double-click Administrative Tools. In the Administrative Tools window, double-click Data Sources (ODBC).

3 Select the acuity-app or acuity-sys DSN, and select Configure. If no Data Source Names for Sage MAS 500 appear in the list, refer to chapter 3 for installation instructions.

4 Verify that the correct server name is entered. Select Next, and select Client Configuration.

5 Select TCP/IP in the Network libraries section.

6 Type the server IP address at the Computer name field and the port number at the Port number field. Click OK to accept the changes and close the Edit Network Library Configuration window.

7 Enter a valid Sage MAS 500 user ID and password or SA as the Logon ID with the appropriate password.

8 Select Next to verify connectivity. Once verified, select Cancel.

9 Run the System Configuration Utility to check the connectivity to Sage MAS 500. Then, run the Sage MAS 500 client software.

---

**Configuration notes**

Note the following when using the protocol:

- The TCP/IP network protocol should be the first protocol bound to the Network Interface Card (NIC). To verify the protocol, use the Network applet in the Control Panel and view the settings for bindings.

- All protocols except TCP/IP may have to be removed from the client system if the protocol bindings are not modified.
### Multi-Protocol over TCP/IP (Port 1434)

#### Description
A general rule for connecting using Multi-Protocol is that you must be logged in to the domain in which the SQL Server resides, or have an open pipe into a resource at the SQL Server. A pipe can be opened to the IPC$ sharepoint on the server using the net view command-line utility. Connecting to any other shared resource using the browse or mapping features in Windows Explorer or the Network Neighborhood applet serves the same purpose.

#### Indication of operating protocol
When you use Multi-Protocol over TCP/IP, you should be able to do the following:
- Ping the SQL Server at a command prompt from the client machine.
- Connect to the SQL Server using the acuity-app and acuity-sys ODBC DSN.

Use the procedures in the following sections to set up the network protocol.

#### SQL Server setup procedure
Follow these steps to set up the SQL Server:

1. From the Windows Start menu, select Programs > Microsoft SQL Server group > Server Network Utility.
2. Select Add.
3. Enter a server alias. If you want the alias and the computer name to be different, change the name at the Computer Name field.
4. Select OK. The SQL Server Network Utility returns you to the General tab page. Select OK.
5. Stop, then restart the SQL Server Service.
Follow these steps to set up the client:

1. From the Windows Start menu, select Settings > Control Panel. In the Control Panel window, double-click Administrative Tools. In the Administrative Tools window, double-click Data Sources (ODBC).

2. Select the acuity-app or acuity-sys DSN, and select Configure. If no Data Source Names for Sage MAS 500 appear in the list, refer to chapter 3 for installation instructions.

3. Verify the correct server name is entered. Select Next, and select Client Configuration.

4. In the Client Configuration section on the Advanced tab, enter the server name or the Server alias.

5. Select TCP/IP in the Network libraries section.

6. Type the server IP address at the Computer name field and the port number at the Port number field. Click OK to accept the changes and close the Edit Network Library Configuration window.

7. Enter a valid Sage MAS 500 user ID and password or SA as the Logon ID with the appropriate password.

8. Select Next to verify connectivity. Once verified, select Cancel.

9. Run the System Configuration Utility to check the connectivity to Sage MAS 500. Then, run the Sage MAS 500 client software.
## TCP/IP Sockets over TCP/IP Protocol

### Description

When you use TCP/IP sockets over TCP/IP, you should be able to do the following:

- Ping the SQL Server at a command prompt from the client machine.
- Connect to the SQL Server using the acuity-app and acuity-sys ODBC DSN.

Use the procedures in the following sections to set up the network protocol.

### SQL Server setup procedure

Follow these steps to set up the SQL Server:

1. From the Windows Start menu, select Programs > Microsoft SQL Server group > Server Network Utility.
2. Select Add.
3. Enter a server alias. If you want the server alias and the computer name to be different, change the name at the Computer Name field.
4. Select OK. The SQL Server Network Utility returns you to the General tab page. Select OK.
5. Stop, then restart the SQL Server Service.

### Client (including Terminal Services) setup procedure

Follow these steps to set up the client:

1. From the Windows Start menu, select Settings > Control Panel. In the Control Panel window, double-click Administrative Tools. In the Administrative Tools window, double-click Data Sources (ODBC).
2. Select the acuity-app or acuity-sys DSN and select Configure. These DSNs are created automatically when you install the client software, as described in ODBC, Registry, and OLE DB Additions on page 89.
3. Verify the correct server name is entered. Select Next, and select Client Configuration.
4 In the Client Configuration section on the Advanced tab, enter the server name or the Server alias.

5 Select TCP/IP in the Network libraries section.

6 Type the server IP address at the Computer name field and the port number at the Port number field. Click OK to accept the changes and close the Edit Network Library Configuration window.

7 Enter a valid Sage MAS 500 user ID and password, or SA as the Logon ID with the appropriate password.

8 Select Next to verify connectivity. Once this has been established, select Cancel.

9 Run the System Configuration Utility to check the connectivity to Sage MAS 500. Then, run the Sage MAS 500 client software.

**IPC mechanism**

This IPC mechanism is specific to the TCP/IP protocol. Although it is not required, the connection string specifying the IP address and port number are recommended in the case that the IP name resolution service is not operating or available.
The silent installation feature enables you to install Sage MAS 500 software without having to respond to screens. Silent installation is available only for client installation.

In this appendix
- Using Silent Installation ................................. 182
- Defaults and Parameters ................................. 186
Using Silent Installation

Overview

Introduction

You perform a silent installation by issuing a command in the Command Prompt window or running it from a batch file. No screens appear while you run the installation.

One version of the command installs the software with default settings. Another version enables you to change options, such as the folder where the software is installed.

When to Use Silent Installation

Description

The silent installation feature enables you to install the software without having to respond to screens. You may want to use the silent installation feature in the following situations:

• You want to install the software in the default configuration, and you do not want to go through the installation wizard.

• You want to install the software on several systems with the same settings. You can just insert the CD-ROM and run a batch file.

Precautions

Description

Before using silent installation, do the following:

• Close any open programs.

• If you have a previous version of the software, uninstall it before running the silent installation.
**Choice of silent installation program**

When performing a silent installation with parameters, use Setup.exe to test for the presence of .NET Framework and required operating system service packs during client installation. Msiexec.exe does not check for these items, which can cause errors when running the Sage MAS 500 client software after installation. Use Msiexec.exe if you have installed the .NET Framework and the necessary service packs on the system.

---

**Installing with Defaults**

**Description**

When you use the version of the command with default settings, the following happens:

- If you do not already have Windows Installer on the system, it is installed for you.
- The software with the default settings. See the Default Settings section for the type of installation you are performing.

**Procedure**

Follow these steps:

1. Hold down the Shift key while you insert the Sage MAS 500 CD-ROM into the CD-ROM drive. This prevents the Autorun feature from starting.
2. Open the Command Prompt window.
3. Change to the drive where the Sage MAS 500 CD-ROM is installed. Then, change to the Database folder.
4. Type the following command:
   ```
   setup.exe /s /v/qn
   ```
   Note that there is no space between the v and /qn.

Once the installation is finished, perform any needed post-installation tasks as shown in the rest of this guide.
Installing with Parameters

Introduction
To change the settings used in installation, you need to run the Windows Installer executable (Msiexec.exe). You follow the msiexec.exe command with parameters to specify installation settings, such as the destination folder.

Windows Installer requirement
To install with parameters, you must have Windows Installer already on the system. If you already have Windows Installer from Windows 2000 or XP or by installing a program, Sage MAS 500 uses the version of Windows Installer that is already on your system.

If you do not already have Windows Installer on the system, you need to run Setup.exe to install it by doing either of the following:

- Install another product that uses Windows Installer.
- Use the installation wizard instead of silent installation.

Procedure
Once Windows Installer is installed, follow these steps to install the Sage MAS 500 software:

1. Hold down the Shift key while you insert the Sage MAS 500 Installation CD-ROM into the CD-ROM drive. This prevents the Autorun feature from starting.
2. Open the Command Prompt window.
3. Issue the command for Windows Installer. The basic syntax is as follows:

   Msiexec.exe /i MSIfile Property=Value /qn

   Where: MSIfile is the name of the installation package file, including path if it is in a different drive and folder and Property=Value is how you set options for the installation. The parameters /i and /qn are required.
Note the following:

- Separate multiple parameters with spaces.
- Enclose paths with spaces with double quotation marks, such as "C:\Program Files".

After the installation is completed, perform any needed post-installation tasks as shown in the rest of this guide.
Appendix E

Defaults and Parameters

Overview

Introduction

This section explains the default settings that are used if you use the default setup command (setup.exe /s /v/qn) and parameters that are available if you use the msiexec.exe command.

Client Installation

Introduction

This section explains the default settings and parameters used for the client software installation.

Default settings

When you install the client software with the default command, the following happens:

- If you do not already have Windows Installer on the system, it is installed for you.
- The client software is installed in the C:\Program Files\Sage Software\Sage MAS 500 Client folder.
- All software is installed.
- Shortcuts to the client software are added to the Windows Start menu.

Installation package file

The installation package file for client software is Sage MAS 500 Client.msi.
Parameters

The client software installation has the following parameters:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSTALLDIR</td>
<td>Folder where you will install the software.</td>
</tr>
<tr>
<td>SERVERNAME</td>
<td>The server to which you will connect the client software.</td>
</tr>
<tr>
<td>PLFILENAME</td>
<td>Project Link database name.</td>
</tr>
</tbody>
</table>

Example

If you are installing the client software into D:\Program Files\Sage Software\Sage MAS 500 Client and connect to server AcctData, you would issue the command as follows:

```
Msiexec.exe /i "Sage MAS 500 Client.msi"
INSTALLDIR="D:\Program Files\Sage Software\Sage MAS 500 Client"
SERVERNAME=AcctData /qn
```
You can launch Sage MAS 500 tasks directly from the Windows Desktop or from the command line. This section describes how to create shortcuts and includes a list of Sage MAS 500 task IDs.

In this appendix
  Command Formats ........................................... 190
  Task IDs and Programs .................................... 197
Command Formats

Overview

Introduction This section shows how to issue commands to launch Sage MAS 500 tasks directly and notes on how to use these commands.

Methods for Creating Shortcuts

Automatic and manual methods You can create shortcuts of Sage MAS 500 tasks by doing either of the following:

- Automatically from the Desktop: Right-clicking the task, and from the menu that appears, select Add to Desktop.
- Manually from a command line (either with the Run command, at the Command Prompt window, or from a batch file): By using the Desktop launching command and specifying the task’s ID.

Command Syntax

Description The following programs are used to launch or control Sage MAS 500 from the command line:

- BusinessDesktop.exe: This is the Desktop program itself. From the command prompt, you can launch it directly, have it launch a specified task, or run in a specific mode. The program is located in the Sage MAS 500 Client\Managed Applications folder.
Desktop and Command Shortcuts

- BusinessDesktopLoader.exe: This is the helper application that communicates with the Desktop. This file is located in the system32 folder in your Windows folder.

Example of command syntax

To execute a Sage MAS 500 task from a command, specify the following command:

```
path\executable parameters
```

Where:

- `path` is the complete path to the program. For BusinessDesktopLoader.exe, use `C:\windows\system 32\` where `windows` is the Windows folder. For BusinessDesktop.exe, it is the BusinessDesktop folder where the Sage MAS 500 client is located (usually `C:\Program Files\Sage Software\Sage MAS 500 Client\Managed Applications`).

- `executable` is BusinessDesktopLoader.exe or BusinessDesktop.exe.

- `parameters` are the command-line parameters you use to specify features.

Desktop commands

BusinessDesktopLoader.exe uses the following parameters.

(No parameters)

If you launch BusinessDesktop.exe with no parameters, the Desktop opens. If SQL Server authentication is used, the logon window appears. If Windows authentication is used, the Desktop appears directly and log on the current Windows user. The following is an example of the command:

```
C:\Program Files\Sage Software\Sage MAS 500 Client\Managed Applications\BusinessDesktop.exe
```

**Note:** This command is the same as launching BusinessDesktopLoader.exe with no parameters.
/Mode:Remote or /Mode:RemoteLoad

Starts the Desktop Loader, but does not log on a user. This command is used in the Startup program group to place the Desktop in the Windows System Tray so that Sage MAS 500 loads quicker. The following is an example of the command:

```
C:\Program Files\Sage Software\Sage MAS 500
  Client\Managed Applications\BusinessDesktop.exe
   /Mode:RemoteLoad
```

You can follow /RemoteLoad with /Tasks parameters to launch Sage MAS 500 tasks. The user is prompted to log on for each task.

/Mode:RemoteLogon

Starts the Desktop service and logs users on to Sage MAS 500 (either through the logon window with SQL Server authentication or automatically if Windows authentication is used), but does not open the Desktop. The following is an example of the command:

```
C:\Program Files\Sage Software\Sage MAS 500
  Client\Managed Applications\BusinessDesktop.exe
   /Mode:RemoteLogin
```

You can use /Mode:RemoteLogin with /Tasks to start individual Sage MAS 500 tasks. Users are prompted to logon only at the first time. The logon stays active even after the last specified task is shut down.

/Mode:RemoteShow

Starts the Desktop and prompts users to log on, if SQL Server authentication is used, or logs users in automatically if Windows authentication is used. When the user shuts down Sage MAS 500 tasks, the Desktop and Desktop Loader stay loaded. The following is an example of the command:

```
C:\Program Files\Sage Software\Sage MAS 500
  Client\Managed Applications\BusinessDesktop.exe
   /Mode:RemoteShow
```
Desktop and Command Shortcuts

/Mode:StandAlone

Opens the Desktop as a standard application. If SQL Server authentication is used, the logon window appears. If Windows authentication is used, the Desktop appears directly and log on the current Windows user. When you exit Sage MAS 500, both the Desktop and Desktop Loader are closed.

The following is an example of the command:

C:\Program Files\Sage Software\Sage MAS 500 Client\Managed Applications\BusinessDesktop.exe /Mode:StandAlone

/Tasks:xxxxx

Opens the Desktop service and the Sage MAS 500 task with the specified task ID number. (See Task IDs and Programs on page 197 for a list of ID numbers.) If SQL Server authentication is used, the logon window appears. If Windows authentication is used, the Desktop appears directly and log on the current Windows user. The following is an example of the command:

C:\Program Files\Sage Software\Sage MAS 500 Client\Managed Applications\BusinessDesktop.exe /Tasks:16843152

This command uses BusinessDesktop.exe to launch task ID 16843152 for Assisted Company Setup.

You can also use /Tasks with other parameters and use multiple /Tasks parameters to open several programs at once. The /Tasks parameters come after other BusinessDesktopLoader.exe parameters. For example, to launch View/Edit Invoices and the Aged Receivables Report while the system is in stand-alone mode, use the following command:

C:\Program Files\Sage Software\Sage MAS 500 Client\Managed Applications\BusinessDesktop.exe /Mode:StandAlone /Tasks:84279346 /Tasks:84479240
For a listing of task ID numbers, see *Task IDs and Programs on page 197.*

**Note:** This command is the same as launching BusinessDesktopLoader.exe with the /T parameter.

**Desktop Loader parameters**

BusinessDesktopLoader.exe uses the following parameters.

**(No parameters)**

If you launch BusinessDesktopLoader.exe with no parameters, the Desktop opens. If SQL Server authentication is used, the logon window appears. If Windows authentication is used, the Desktop appears directly and log on the current Windows user. The following is an example of the command:

```
C:\Windows\system32\BusinessDesktopLoader.exe
```

This is the command used for launching the Desktop from the Windows Start menu.

**Note:** This command is the same as launching BusinessDesktop.exe with no parameters.

**/L**

Starts the Desktop loader, but does not open the Desktop or log on any users. The following is an example of the command:

```
C:\Windows\system32\BusinessDesktopLoader.exe /L
```

**/S**

Opens the Desktop but does not show the Desktop icon in the Windows System tray. If SQL Server authentication is used, the logon window appears. If Windows authentication is used, the Desktop appears directly and log on the current Windows user. The following is an example of the command:

```
C:\Windows\system32\BusinessDesktopLoader.exe /S
```
Desktop and Command Shortcuts

/Txxxxx

Opens the Sage MAS 500 task with the specified task ID number. (See Task IDs and Programs on page 197 for a list of ID numbers.) If SQL Server authentication is used, the logon window appears. If Windows authentication is used, the Desktop appears directly and log on the current Windows user. The following is an example of the command:

C:\Windows\system32\BusinessDesktopLoader.exe /T16843152

This command uses BusinessDesktopLoader.exe to launch task ID 16843152. For a listing of task ID numbers, see Task IDs and Programs on page 197.

Note: This command is the same as launching BusinessDesktop.exe with the /Tasks parameter.

/X

Closes the Desktop and the Desktop loader in the Windows System tray. The following is an example of the command:

C:\Windows\system32\BusinessDesktopLoader.exe /X

Directly Launched Tasks and the Desktop

<table>
<thead>
<tr>
<th>Description</th>
<th>Sage MAS 500 tasks launched through shortcuts behave just like every other Sage MAS 500 task. The Desktop supports shortcuts and does not appear unless specifically launched.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logon and company used</td>
<td>If you launch a task from a shortcut, and it is the first Sage MAS 500 task to run on that machine, you are prompted with the logon window. After a successful logon, only the task invoked appears. The Desktop does not. Subsequent executions of shortcuts in this session do not launch the logon window. This limits you to working in only the company specified during the original logon. If it is necessary for you to work within multiple companies in one session, start the Desktop.</td>
</tr>
</tbody>
</table>
Appendix F

If the Desktop is running when you launch a task directly, a shortcut execution launches the task in the company currently specified in the Desktop.

If you launched an Sage MAS 500 task from a shortcut, and the Desktop is not running, a subsequent execution of the Desktop does not invoke the logon window.

**Shutting down the Desktop**

If the Desktop is shut down, all Sage MAS 500 tasks, including tasks started with a shortcut, are shut down.
Task IDs and Programs

Overview

Introduction  This section contains lists of menu titles, program names, and task IDs to identify the tasks for which to create shortcuts. The lists are organized by module.

Accounts Payable

Task list  The following table lists Accounts Payable tasks.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>1099 Activity Report</td>
<td>apzrp001</td>
<td>67698703</td>
</tr>
<tr>
<td>1099 Beginning Balances</td>
<td>apzdn001</td>
<td>67502240</td>
</tr>
<tr>
<td>1099 Box Setup</td>
<td>apzmc001</td>
<td>67174405</td>
</tr>
<tr>
<td>1099 Corrections</td>
<td>apzdm001</td>
<td>67502210</td>
</tr>
<tr>
<td>1099 Form Printing</td>
<td>apzrq001</td>
<td>67698704</td>
</tr>
<tr>
<td>Age Vendor Accounts</td>
<td>apzdg001</td>
<td>67633155</td>
</tr>
<tr>
<td>Aged Payables Report</td>
<td>apzrf001</td>
<td>67698693</td>
</tr>
<tr>
<td>Aged Payables Report (MC)</td>
<td>apzrf001</td>
<td>67698709</td>
</tr>
<tr>
<td>Analysis Report</td>
<td>apzrl001</td>
<td>67698714</td>
</tr>
<tr>
<td>Apply Payments &amp; Memos Process</td>
<td>apzdj001</td>
<td>67502130</td>
</tr>
</tbody>
</table>
### Appendix F

#### Menu Name | Program | Task ID
--- | --- | ---
Cash Requirements Report | apzrh001 | 67698695
Custom Field Value Setup | cizmd001 | 67174407
Edit Voucher 1099 Data | apzdl001 | 67502220
Import Data | apzux001 | 67960862
Manual Check Process | apzdj001 | 67502120
Options List | apzru001 | 67698707
Options Setup | apzsa001 | 67174403
Payment History Report | apzrt001 | 67698720
Post AP Batches | cizuf001 | 67567618
Print Checks | apzra001 | 67698722
Process Period End | apzpa001 | 67895298
Purchase Activity Report | apzrk001 | 67698699
Purge AP Data | apzdh001 | 67633157
Recalculate History | apztm001 | 67960863
Recurring Voucher List | apzrs001 | 67698706
Recurring Voucher Maint | apzmd001 | 67174402
Reverse Import | cizux001 | 67960843
Set Up Payment Method | apzmf001 | 67174408

---

198 Installation and System Configuration
<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor 1099 History Report</td>
<td>apzrn001</td>
<td>67698715</td>
</tr>
<tr>
<td>Vendor Class List</td>
<td>apzrr001</td>
<td>67698705</td>
</tr>
<tr>
<td>Vendor Class Maint</td>
<td>apzmb001</td>
<td>67174404</td>
</tr>
<tr>
<td>Vendor Class Purch History Rpt</td>
<td>apzib001</td>
<td>67305479</td>
</tr>
<tr>
<td>Vendor Class Purch History Rpt</td>
<td>apzib001</td>
<td>67305479</td>
</tr>
<tr>
<td>Vendor List</td>
<td>apzrb001</td>
<td>67698689</td>
</tr>
<tr>
<td>Vendor Maint</td>
<td>apzma001</td>
<td>67174401</td>
</tr>
<tr>
<td>Vendor Payment Inquiry by Vendor</td>
<td>apzie001</td>
<td>67305480</td>
</tr>
<tr>
<td>Vendor Payment Inquiry by Vendor</td>
<td>apzie001</td>
<td>67305480</td>
</tr>
<tr>
<td>Vendor Payment Process</td>
<td>apzdj001</td>
<td>67502100</td>
</tr>
<tr>
<td>Vendor Pmt History Report</td>
<td>apzrm001</td>
<td>67698700</td>
</tr>
<tr>
<td>Vendor Purchase Analysis Report</td>
<td>apzri001</td>
<td>67698696</td>
</tr>
<tr>
<td>Vendor Purchase History Report</td>
<td>apzib001</td>
<td>67305478</td>
</tr>
<tr>
<td>Vendor Purchase History Report</td>
<td>apzib001</td>
<td>67305478</td>
</tr>
<tr>
<td>Vendor Status Inquiry</td>
<td>apzih001</td>
<td>67305477</td>
</tr>
<tr>
<td>Vendor Trial Balance Report</td>
<td>apzrg001</td>
<td>67698712</td>
</tr>
</tbody>
</table>
## Accounts Receivable

### Task list

The following table lists Accounts Receivable tasks.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Age Customer Accounts</td>
<td>arztj001</td>
<td>84410376</td>
</tr>
<tr>
<td>Aged Receivables Report</td>
<td>arzrf001</td>
<td>84479240</td>
</tr>
<tr>
<td>Aged Receivables Report (MC)</td>
<td>arzrf001</td>
<td>84479244</td>
</tr>
<tr>
<td>Analysis Report</td>
<td>arzrn001</td>
<td>84479293</td>
</tr>
<tr>
<td>Apply Payments &amp; Memos Batch</td>
<td>arztl001</td>
<td>84220270</td>
</tr>
<tr>
<td>Cash Expectations Report</td>
<td>arzrk001</td>
<td>84475907</td>
</tr>
<tr>
<td>Cash Receipts Batch</td>
<td>arztl001</td>
<td>84220260</td>
</tr>
<tr>
<td>Commission Batch</td>
<td>arztl001</td>
<td>84410372</td>
</tr>
</tbody>
</table>
### Desktop and Command Shortcuts

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commission Class List</td>
<td>arzle001</td>
<td>84604778</td>
</tr>
<tr>
<td>Commission Class Maint</td>
<td>arzme001</td>
<td>83957628</td>
</tr>
<tr>
<td>Commission Plan List</td>
<td>arzl001</td>
<td>84604780</td>
</tr>
<tr>
<td>Commission Plan Maint</td>
<td>arzmh001</td>
<td>83957624</td>
</tr>
<tr>
<td>Commission Report</td>
<td>arzrp001</td>
<td>84479295</td>
</tr>
<tr>
<td>Custom Field Maint</td>
<td>cizmd001</td>
<td>83951620</td>
</tr>
<tr>
<td>Customer Class History Inquiry</td>
<td>arztr001</td>
<td>84082950</td>
</tr>
<tr>
<td>Customer Class History Inquiry</td>
<td>arztr001</td>
<td>84082950</td>
</tr>
<tr>
<td>Customer Class List</td>
<td>arzla001</td>
<td>84604774</td>
</tr>
<tr>
<td>Customer Class Maint</td>
<td>arzmb001</td>
<td>83957626</td>
</tr>
<tr>
<td>Customer History Inquiry</td>
<td>arztr001</td>
<td>84082940</td>
</tr>
<tr>
<td>Customer History Inquiry</td>
<td>arztr001</td>
<td>84082940</td>
</tr>
<tr>
<td>Customer List</td>
<td>arzra001</td>
<td>84479264</td>
</tr>
<tr>
<td>Customer Maint</td>
<td>arzma001</td>
<td>83952612</td>
</tr>
<tr>
<td>Customer Payment Activity</td>
<td>arzrj001</td>
<td>84479292</td>
</tr>
<tr>
<td>Customer Sales Analysis Report</td>
<td>arzrl001</td>
<td>84479269</td>
</tr>
<tr>
<td>Customer Statements</td>
<td>arzre001</td>
<td>84479259</td>
</tr>
</tbody>
</table>
### Menu Name and Program Information

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Status Inquiry</td>
<td>arzqa001</td>
<td>84082790</td>
</tr>
<tr>
<td>Customer Trial Balance Report</td>
<td>arzrg001</td>
<td>84479249</td>
</tr>
<tr>
<td>Customer Trial Balance Report (MC)</td>
<td>arzrg001</td>
<td>84479254</td>
</tr>
<tr>
<td>Customers</td>
<td>arzqf001</td>
<td>84083688</td>
</tr>
<tr>
<td>Finance Charge Batch</td>
<td>arztl001</td>
<td>84410374</td>
</tr>
<tr>
<td>Import Data</td>
<td>arzux001</td>
<td>84738249</td>
</tr>
<tr>
<td>Invoice Batch</td>
<td>arztl001</td>
<td>84220780</td>
</tr>
<tr>
<td>Invoice Print - Multiple Batches</td>
<td>arztc001</td>
<td>84479299</td>
</tr>
<tr>
<td>Invoice Reprint</td>
<td>arztc001</td>
<td>84479301</td>
</tr>
<tr>
<td>Invoice Summary Inquiry by Cust</td>
<td>arzqd001</td>
<td>84082890</td>
</tr>
<tr>
<td>Invoice Summary Inquiry by Cust</td>
<td>arzqd001</td>
<td>84082890</td>
</tr>
<tr>
<td>Maintain National Accounts</td>
<td>arzmj001</td>
<td>83951716</td>
</tr>
<tr>
<td>National Acct List</td>
<td>arzli001</td>
<td>84479297</td>
</tr>
<tr>
<td>Options List</td>
<td>arzlc001</td>
<td>84604440</td>
</tr>
<tr>
<td>Options Maint</td>
<td>arzmg001</td>
<td>83951917</td>
</tr>
<tr>
<td>Payment Summary Inquiry by Cust</td>
<td>arztt001</td>
<td>84082910</td>
</tr>
<tr>
<td>Payment Summary Inquiry by Cust</td>
<td>arztt001</td>
<td>84082910</td>
</tr>
</tbody>
</table>
## Desktop and Command Shortcuts

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post Batches</td>
<td>cizuf001</td>
<td>84344834</td>
</tr>
<tr>
<td>Process Period End</td>
<td>arzpa001</td>
<td>84672517</td>
</tr>
<tr>
<td>Purge AR Data</td>
<td>arzdl001</td>
<td>84410370</td>
</tr>
<tr>
<td>Recalculate History</td>
<td>arztm001</td>
<td>84738252</td>
</tr>
<tr>
<td>Recurring Invoice List</td>
<td>arzlb001</td>
<td>84604776</td>
</tr>
<tr>
<td>Recurring Invoice Maint</td>
<td>arzmc001</td>
<td>83951676</td>
</tr>
<tr>
<td>Reverse Import</td>
<td>cizux001</td>
<td>84738269</td>
</tr>
<tr>
<td>Sales Activity Report</td>
<td>arzri001</td>
<td>84475906</td>
</tr>
<tr>
<td>Sales Team List</td>
<td>arzh001</td>
<td>84604781</td>
</tr>
<tr>
<td>Sales Team Maint</td>
<td>arzmi001</td>
<td>83951949</td>
</tr>
<tr>
<td>Sales Territory List</td>
<td>arzlg001</td>
<td>84604775</td>
</tr>
<tr>
<td>Sales Territory Maint</td>
<td>arzmf001</td>
<td>83952614</td>
</tr>
<tr>
<td>Salesperson History Inquiry</td>
<td>arztu001</td>
<td>84082930</td>
</tr>
<tr>
<td>Salesperson List</td>
<td>arzld001</td>
<td>84604779</td>
</tr>
<tr>
<td>Salesperson Maint</td>
<td>arzmd001</td>
<td>83957623</td>
</tr>
<tr>
<td>Salesperson Sales Analysis Rpt</td>
<td>arzrm001</td>
<td>84479274</td>
</tr>
<tr>
<td>View/Edit Invoices</td>
<td>arzda003</td>
<td>84279346</td>
</tr>
</tbody>
</table>
## Advanced Consolidations

### Task list

The following table lists Advanced Consolidations tasks.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consolidations List</td>
<td>aczla001</td>
<td>420085790</td>
</tr>
<tr>
<td>Delete Consolidation Data By Company</td>
<td>aczuf001</td>
<td>420282573</td>
</tr>
<tr>
<td>Delete Consolidation Data By Period</td>
<td>aczug001</td>
<td>420282574</td>
</tr>
<tr>
<td>Elimination Group List</td>
<td>aczlc001</td>
<td>420085962</td>
</tr>
<tr>
<td>Import Subsidiary Data</td>
<td>aczua001</td>
<td>420282569</td>
</tr>
<tr>
<td>Maintain Consolidations</td>
<td>aczma001</td>
<td>419495956</td>
</tr>
<tr>
<td>Maintain Elimination Groups</td>
<td>aczmc001</td>
<td>419496138</td>
</tr>
<tr>
<td>Maintain Rollups</td>
<td>aczmb001</td>
<td>419496137</td>
</tr>
<tr>
<td>Options List</td>
<td>aczls001</td>
<td>420085770</td>
</tr>
<tr>
<td>Process Advanced Consolidations</td>
<td>aczaa001</td>
<td>419954698</td>
</tr>
<tr>
<td>Rollup List</td>
<td>aczlb001</td>
<td>420085961</td>
</tr>
<tr>
<td>Set Up Options</td>
<td>aczsa001</td>
<td>419495937</td>
</tr>
</tbody>
</table>
### Alerts

The following table lists the Alerts task.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Alerts</td>
<td>dazma001</td>
<td>503382116</td>
</tr>
</tbody>
</table>

### Cash Management

The following table lists Cash Management tasks.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP Check Conversion</td>
<td>cmzpd001</td>
<td>151847012</td>
</tr>
<tr>
<td>Bank Account History Inquiry</td>
<td>cmzqd001</td>
<td>151191554</td>
</tr>
<tr>
<td>Bank Account History Inquiry</td>
<td>cmzqd001</td>
<td>151191554</td>
</tr>
<tr>
<td>Bank Account Status Inquiry</td>
<td>cmzqc001</td>
<td>151191555</td>
</tr>
<tr>
<td>Bank Acct Trans Summary Inquiry</td>
<td>cmzqe001</td>
<td>151192100</td>
</tr>
<tr>
<td>Bank Acct Trans Summary Inquiry</td>
<td>cmzqe001</td>
<td>151192100</td>
</tr>
<tr>
<td>Bank Activity Report</td>
<td>cmzrd001</td>
<td>151585068</td>
</tr>
<tr>
<td>Bank Inquiry</td>
<td>cmzqh001</td>
<td>151192552</td>
</tr>
<tr>
<td>Bank Inquiry</td>
<td>cmzqh001</td>
<td>151192552</td>
</tr>
<tr>
<td>Bank Statement Inquiry</td>
<td>cmzqf001</td>
<td>151192000</td>
</tr>
<tr>
<td>Bank Transaction Batch</td>
<td>cmztl001</td>
<td>151323720</td>
</tr>
</tbody>
</table>
## Appendix F

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash Trend Analysis Report</td>
<td>cmzre001</td>
<td>151585118</td>
</tr>
<tr>
<td>Daily Cash Balance Report</td>
<td>cmzrb001</td>
<td>151584918</td>
</tr>
<tr>
<td>Daily Cash Flow Projection</td>
<td>cmzrc001</td>
<td>151584968</td>
</tr>
<tr>
<td>Deposit Generation Batch</td>
<td>cmztl001</td>
<td>151323710</td>
</tr>
<tr>
<td>Future Cash Flow List</td>
<td>cmzle001</td>
<td>151650307</td>
</tr>
<tr>
<td>Future Cash Flow Maint</td>
<td>cmzme001</td>
<td>151060482</td>
</tr>
<tr>
<td>Options List</td>
<td>cmzld001</td>
<td>151650306</td>
</tr>
<tr>
<td>Options Setup</td>
<td>cmzsa001</td>
<td>151060481</td>
</tr>
<tr>
<td>Periodic Cash Flow Projection</td>
<td>cmzra001</td>
<td>151584868</td>
</tr>
<tr>
<td>Post CM Batches</td>
<td>cizuf001</td>
<td>151388360</td>
</tr>
<tr>
<td>Process Period End</td>
<td>cmzpa001</td>
<td>151781476</td>
</tr>
<tr>
<td>Purge CM Data</td>
<td>cmzpb001</td>
<td>151519334</td>
</tr>
<tr>
<td>Reconciliation Batch</td>
<td>cmztl001</td>
<td>151323700</td>
</tr>
</tbody>
</table>
## Common Information

### Task list

The following table lists Common Information tasks.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank Account List</td>
<td>cizlv001</td>
<td>34144262</td>
</tr>
<tr>
<td>Bank Account Maint</td>
<td>cizmv001</td>
<td>33620068</td>
</tr>
<tr>
<td>Bank List</td>
<td>cizla001</td>
<td>34209942</td>
</tr>
<tr>
<td>Bank Setup</td>
<td>cizma001</td>
<td>33620168</td>
</tr>
<tr>
<td>Business Form Setup</td>
<td>cizmo001</td>
<td>33619979</td>
</tr>
<tr>
<td>Business Forms List</td>
<td>cizlo001</td>
<td>34210132</td>
</tr>
<tr>
<td>Comment Maint (EXE)</td>
<td>ciznd001</td>
<td>33620000</td>
</tr>
<tr>
<td>Comments List</td>
<td>cizli001</td>
<td>34210172</td>
</tr>
<tr>
<td>Company Tax Code List</td>
<td>cizlm001</td>
<td>34210182</td>
</tr>
<tr>
<td>Country &amp; State Setup</td>
<td>cizmk001</td>
<td>33619976</td>
</tr>
<tr>
<td>CRM Data Export</td>
<td>cizry001</td>
<td>34406910</td>
</tr>
<tr>
<td>Document Transmital Setup</td>
<td>ciznh001</td>
<td>33621171</td>
</tr>
<tr>
<td>Document Transmittal Config List</td>
<td>cizly001</td>
<td>34210202</td>
</tr>
<tr>
<td>Document Transmittal Log</td>
<td>cizr001</td>
<td>34144266</td>
</tr>
<tr>
<td>External User List</td>
<td>cizlz001</td>
<td>34210212</td>
</tr>
<tr>
<td>FOB ID Maintenance</td>
<td>cizng001</td>
<td>33620218</td>
</tr>
<tr>
<td>FOB List</td>
<td>cizog001</td>
<td>34210192</td>
</tr>
<tr>
<td>Menu Name</td>
<td>Program</td>
<td>Task ID</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>----------</td>
<td>-----------</td>
</tr>
<tr>
<td>Item History Report</td>
<td>cizrb001</td>
<td>34144258</td>
</tr>
<tr>
<td>Item List</td>
<td>imzlr001</td>
<td>34209793</td>
</tr>
<tr>
<td>Maintain Company Tax Information</td>
<td>ciznf001</td>
<td>33627168</td>
</tr>
<tr>
<td>Maintain External Users</td>
<td>cizmt001</td>
<td>33620268</td>
</tr>
<tr>
<td>Maintain Non-Stock Item Classes</td>
<td>imzmi001</td>
<td>33619988</td>
</tr>
<tr>
<td>Maintain Non-Stock Items</td>
<td>imzmr001</td>
<td>33619970</td>
</tr>
<tr>
<td>Memos List</td>
<td>cizlq001</td>
<td>34210152</td>
</tr>
<tr>
<td>Non-Stock Item Class List</td>
<td>imzli001</td>
<td>34210142</td>
</tr>
<tr>
<td>Options List</td>
<td>cizlb001</td>
<td>34210122</td>
</tr>
<tr>
<td>Options Setup</td>
<td>cizsa001</td>
<td>33619980</td>
</tr>
<tr>
<td>Payment Terms List</td>
<td>cizlh001</td>
<td>34209832</td>
</tr>
<tr>
<td>Payment Terms Setup</td>
<td>cizmh001</td>
<td>33619974</td>
</tr>
<tr>
<td>Postal Code Setup</td>
<td>cizmi001</td>
<td>33619977</td>
</tr>
<tr>
<td>Processing Cycle List</td>
<td>cizlk001</td>
<td>34210112</td>
</tr>
<tr>
<td>Processing Cycle Setup</td>
<td>cizmi001</td>
<td>33619975</td>
</tr>
<tr>
<td>Purge Item History</td>
<td>ciztb001</td>
<td>34078724</td>
</tr>
<tr>
<td>Purge Sales Tax History</td>
<td>ciztc001</td>
<td>34078722</td>
</tr>
<tr>
<td>Reason Code List</td>
<td>cizlj001</td>
<td>34210102</td>
</tr>
<tr>
<td>Reason Code Setup</td>
<td>cizmj001</td>
<td>33619985</td>
</tr>
<tr>
<td>Menu Name</td>
<td>Program</td>
<td>Task ID</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Rename IDs</td>
<td>cizua001</td>
<td>34406401</td>
</tr>
<tr>
<td>Sales Tax Class List</td>
<td>cizle001</td>
<td>34209802</td>
</tr>
<tr>
<td>Sales Tax Class Setup</td>
<td>cizme001</td>
<td>33619971</td>
</tr>
<tr>
<td>Sales Tax Code List</td>
<td>cizlf001</td>
<td>34209812</td>
</tr>
<tr>
<td>Sales Tax Code Setup</td>
<td>cizmf001</td>
<td>33619972</td>
</tr>
<tr>
<td>Sales Tax Recalculate History</td>
<td>ciztm001</td>
<td>34406900</td>
</tr>
<tr>
<td>Sales Tax Report - AP</td>
<td>cizrd001</td>
<td>34144259</td>
</tr>
<tr>
<td>Sales Tax Report - AR</td>
<td>cizrd001</td>
<td>34144278</td>
</tr>
<tr>
<td>Sales Tax Schedule List</td>
<td>cizlg001</td>
<td>34209822</td>
</tr>
<tr>
<td>Sales Tax Schedule Setup</td>
<td>cizmg001</td>
<td>33619983</td>
</tr>
<tr>
<td>Shipping Method List</td>
<td>cizln001</td>
<td>34210092</td>
</tr>
<tr>
<td>Shipping Method Setup</td>
<td>cizmn001</td>
<td>33619981</td>
</tr>
<tr>
<td>Tender Type List</td>
<td>cizlx001</td>
<td>34209992</td>
</tr>
<tr>
<td>Tender Type Setup</td>
<td>cizmx001</td>
<td>33620118</td>
</tr>
<tr>
<td>Unit of Measure List</td>
<td>cizll001</td>
<td>34210162</td>
</tr>
<tr>
<td>Unit of Measure Setup</td>
<td>cizmm001</td>
<td>33619978</td>
</tr>
</tbody>
</table>
Appendix F

Customizer

Task list

The following table lists Customizer tasks.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Form Customizations</td>
<td>czcustex</td>
<td>386269185</td>
</tr>
<tr>
<td>Form Customizations List</td>
<td>czzra001</td>
<td>386531338</td>
</tr>
<tr>
<td>Import Form Customizations</td>
<td>czcustim</td>
<td>386269186</td>
</tr>
<tr>
<td>Manage Form Customizations</td>
<td>czcustmg</td>
<td>386269187</td>
</tr>
</tbody>
</table>

Data Migrator

Task list

The following table lists the Data Migrator task:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain Migration Links</td>
<td>dmzma001</td>
<td>721485834</td>
</tr>
</tbody>
</table>

General Ledger

Task list

The following table lists General Ledger tasks.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Categories List</td>
<td>glzqlq001</td>
<td>50988058</td>
</tr>
<tr>
<td>Account Group List</td>
<td>glizr001</td>
<td>50994030</td>
</tr>
<tr>
<td>Account Group Setup</td>
<td>glzmd001</td>
<td>50403224</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Program</td>
<td>Task ID</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>Account History Inquiry</td>
<td>glzie001</td>
<td>50530276</td>
</tr>
<tr>
<td>Account List</td>
<td>glzrb001</td>
<td>50929482</td>
</tr>
<tr>
<td>Account Maint</td>
<td>glzma001</td>
<td>50399184</td>
</tr>
<tr>
<td>Account Segment Setup</td>
<td>glzme001</td>
<td>50403234</td>
</tr>
<tr>
<td>Account Segment Value List</td>
<td>glzrs001</td>
<td>50995198</td>
</tr>
<tr>
<td>Account Shortcuts List</td>
<td>glzlo001</td>
<td>50988018</td>
</tr>
<tr>
<td>Account Structure List</td>
<td>glzru001</td>
<td>50995218</td>
</tr>
<tr>
<td>Account Structure Setup (Menu)</td>
<td>glzmi001</td>
<td>50403274</td>
</tr>
<tr>
<td>Accounts</td>
<td>glzqa001</td>
<td>50529256</td>
</tr>
<tr>
<td>Activity Report</td>
<td>glzrg002</td>
<td>50929697</td>
</tr>
<tr>
<td>Allocation Journal List</td>
<td>glzrx001</td>
<td>50994048</td>
</tr>
<tr>
<td>Allocation Maint</td>
<td>glzda001</td>
<td>50401194</td>
</tr>
<tr>
<td>Allocation Process</td>
<td>glzdh001</td>
<td>50663408</td>
</tr>
<tr>
<td>Analysis</td>
<td>glzri001</td>
<td>50928512</td>
</tr>
<tr>
<td>Budget and History Report</td>
<td>glzrd001</td>
<td>50928522</td>
</tr>
<tr>
<td>Budget Revision Maint</td>
<td>glzdg001</td>
<td>50663398</td>
</tr>
<tr>
<td>Create Accounts</td>
<td>glzue001</td>
<td>51183696</td>
</tr>
</tbody>
</table>
## Menu Item Program Task ID

<table>
<thead>
<tr>
<th>Custom Field Value Setup</th>
<th>cizmd001</th>
<th>50397224</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Accounts</td>
<td>glzug001</td>
<td>51183736</td>
</tr>
<tr>
<td>Export AC Data</td>
<td>glzuh001</td>
<td>51183746</td>
</tr>
<tr>
<td>Export Data</td>
<td>glzdd001</td>
<td>51183636</td>
</tr>
<tr>
<td>Financial Report</td>
<td>glzrf001</td>
<td>50928517</td>
</tr>
<tr>
<td>Financial Report Group List</td>
<td>glzrz001</td>
<td>50994060</td>
</tr>
<tr>
<td>Financial Report Group Maint</td>
<td>glzmm001</td>
<td>50399185</td>
</tr>
<tr>
<td>Financial Report List</td>
<td>glzry001</td>
<td>50994059</td>
</tr>
<tr>
<td>Financial Report Maint</td>
<td>glzml001</td>
<td>50399422</td>
</tr>
<tr>
<td>Fiscal Year List</td>
<td>glzrq001</td>
<td>50995178</td>
</tr>
<tr>
<td>Fiscal Year Maint</td>
<td>glzmc001</td>
<td>50403214</td>
</tr>
<tr>
<td>General Ledger Worksheet</td>
<td>glzrc001</td>
<td>50929502</td>
</tr>
<tr>
<td>Import Data</td>
<td>glzra001</td>
<td>51183646</td>
</tr>
<tr>
<td>Journal List</td>
<td>glzrt001</td>
<td>50995208</td>
</tr>
<tr>
<td>Journal Maint</td>
<td>glzmf001</td>
<td>50399407</td>
</tr>
<tr>
<td>Journal Report</td>
<td>glzrh001</td>
<td>50928537</td>
</tr>
<tr>
<td>Journal Transaction Process</td>
<td>glzdh001</td>
<td>50728916</td>
</tr>
<tr>
<td>Maintain Account Shortcuts</td>
<td>glzmo001</td>
<td>50398194</td>
</tr>
<tr>
<td>Maintain Budgets</td>
<td>glzmt001</td>
<td>50398244</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Program</td>
<td>Task ID</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------</td>
<td>------------</td>
</tr>
<tr>
<td>Maintain Natural Accounts</td>
<td>glzmp001</td>
<td>50398204</td>
</tr>
<tr>
<td>Maintain Reference Codes</td>
<td>glzms001</td>
<td>50398224</td>
</tr>
<tr>
<td>Maintain Reference Groups</td>
<td>glzmr001</td>
<td>50398214</td>
</tr>
<tr>
<td>Natural Accounts List</td>
<td>glzlp001</td>
<td>50988028</td>
</tr>
<tr>
<td>Options List</td>
<td>glzrp001</td>
<td>50995168</td>
</tr>
<tr>
<td>Options Setup</td>
<td>glzmb001</td>
<td>50403204</td>
</tr>
<tr>
<td>Post GL Batches</td>
<td>cizuf001</td>
<td>50790402</td>
</tr>
<tr>
<td>Process Period End</td>
<td>glzpa001</td>
<td>51125090</td>
</tr>
<tr>
<td>Purge GL Data</td>
<td>glztd001</td>
<td>50855948</td>
</tr>
<tr>
<td>Recalculate History</td>
<td>glzui001</td>
<td>51183756</td>
</tr>
<tr>
<td>Recurring Journal List</td>
<td>glzrw001</td>
<td>50994049</td>
</tr>
<tr>
<td>Recurring Journal Maint</td>
<td>glzdb001</td>
<td>50401204</td>
</tr>
<tr>
<td>Reference Code List</td>
<td>glzls001</td>
<td>50988048</td>
</tr>
<tr>
<td>Reference Group List</td>
<td>glzlrt001</td>
<td>50988038</td>
</tr>
<tr>
<td>Renumber Accounts</td>
<td>glzuf001</td>
<td>51183726</td>
</tr>
<tr>
<td>Reverse Import</td>
<td>cizux001</td>
<td>51184850</td>
</tr>
<tr>
<td>Set Up Account Categories</td>
<td>glzmq001</td>
<td>50399186</td>
</tr>
<tr>
<td>Target Company List</td>
<td>glzrk001</td>
<td>50995228</td>
</tr>
<tr>
<td>Target Company Maint</td>
<td>glzmn001</td>
<td>50400184</td>
</tr>
</tbody>
</table>
Inventory Management

Task list

The following table lists Inventory Management tasks.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Transfer Discrepancies Batch</td>
<td>imzdh001</td>
<td>117834118</td>
</tr>
<tr>
<td>Approve Transfer Orders</td>
<td>imzdl001</td>
<td>117834098</td>
</tr>
<tr>
<td>Assemble Kits Batch</td>
<td>imzdh001</td>
<td>117833788</td>
</tr>
<tr>
<td>Bin Labels</td>
<td>imzrt001</td>
<td>118030526</td>
</tr>
<tr>
<td>Bins List</td>
<td>imzlIn001</td>
<td>118096002</td>
</tr>
<tr>
<td>Buyer List</td>
<td>imzlb001</td>
<td>118096122</td>
</tr>
<tr>
<td>Buyer Maintenance</td>
<td>imzma001</td>
<td>117506348</td>
</tr>
<tr>
<td>Calculate Projected Demand</td>
<td>imzdd001</td>
<td>268828742</td>
</tr>
<tr>
<td>Calculate Replenishment Parameters</td>
<td>imzdd002</td>
<td>268828752</td>
</tr>
<tr>
<td>Commodity Codes Listing</td>
<td>imzlo001</td>
<td>118095922</td>
</tr>
</tbody>
</table>
### Desktop and Command Shortcuts

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Inquiry</td>
<td>imzqa001</td>
<td>117637130</td>
</tr>
<tr>
<td>Cost Tier Adjustment Batch</td>
<td>imzdh001</td>
<td>117833778</td>
</tr>
<tr>
<td>Create Inventory</td>
<td>imzmy001</td>
<td>118292514</td>
</tr>
<tr>
<td>Customer Grp Pricing List</td>
<td>imzlu005</td>
<td>118096092</td>
</tr>
<tr>
<td>Customer Item CPL</td>
<td>imzlu004</td>
<td>118096082</td>
</tr>
<tr>
<td>Customer Item List</td>
<td>imzlv001</td>
<td>118096142</td>
</tr>
<tr>
<td>Customer PPG CPL</td>
<td>imzlu009</td>
<td>118096112</td>
</tr>
<tr>
<td>Customer Price Group Maintenance</td>
<td>imzmu003</td>
<td>117506278</td>
</tr>
<tr>
<td>Customer Price Group Pricing</td>
<td>imzmu005</td>
<td>117506308</td>
</tr>
<tr>
<td>Customer Price Grp Listing</td>
<td>imzlu002</td>
<td>118096052</td>
</tr>
<tr>
<td>Demand Adjustment</td>
<td>imzdd006</td>
<td>268828792</td>
</tr>
<tr>
<td>Demand Formulas Listing</td>
<td>imzlc001</td>
<td>269090856</td>
</tr>
<tr>
<td>Enter Transfer Orders</td>
<td>imzdk001</td>
<td>117834088</td>
</tr>
<tr>
<td>Freight Classes Listing</td>
<td>imzlp001</td>
<td>118095932</td>
</tr>
<tr>
<td>Global Inventory Change</td>
<td>imzud002</td>
<td>118292518</td>
</tr>
<tr>
<td>Global Item Change</td>
<td>imzud001</td>
<td>118292512</td>
</tr>
<tr>
<td>Import</td>
<td>imzua001</td>
<td>118292490</td>
</tr>
<tr>
<td>Inventory Analysis Report</td>
<td>imzrg001</td>
<td>118030386</td>
</tr>
</tbody>
</table>

Installation and System Configuration 215
# Appendix F

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Cost Report</td>
<td>imzre001</td>
<td>118030406</td>
</tr>
<tr>
<td>Inventory Inquiry</td>
<td>imzqq001</td>
<td>117638320</td>
</tr>
<tr>
<td>Inventory Inquiry</td>
<td>imzqq001</td>
<td>117638320</td>
</tr>
<tr>
<td>Inventory Listing</td>
<td>imzlt001</td>
<td>118095982</td>
</tr>
<tr>
<td>Inventory Performance Report</td>
<td>imzrn001</td>
<td>118030476</td>
</tr>
<tr>
<td>Inventory Ranks Listing</td>
<td>imzlh001</td>
<td>118095962</td>
</tr>
<tr>
<td>Inventory Status Inquiry</td>
<td>imzqk001</td>
<td>117637280</td>
</tr>
<tr>
<td>Inventory Transaction Inquiry</td>
<td>imzqf001</td>
<td>117637210</td>
</tr>
<tr>
<td>Inventory Transaction Report</td>
<td>imzrm001</td>
<td>118030446</td>
</tr>
<tr>
<td>Item Classes Listing</td>
<td>imzli001</td>
<td>118095952</td>
</tr>
<tr>
<td>Item History Inquiry</td>
<td>imzqe001</td>
<td>117637190</td>
</tr>
<tr>
<td>Item History Inquiry</td>
<td>imzqe001</td>
<td>117637190</td>
</tr>
<tr>
<td>Item Inquiry</td>
<td>imzqp001</td>
<td>117638220</td>
</tr>
<tr>
<td>Item Inquiry</td>
<td>imzqp001</td>
<td>117638220</td>
</tr>
<tr>
<td>Item Listing</td>
<td>imzlri001</td>
<td>118096022</td>
</tr>
<tr>
<td>Item Price Sheets</td>
<td>imzmu007</td>
<td>117506299</td>
</tr>
<tr>
<td>Kit Component Where Used Report</td>
<td>imzry001</td>
<td>118037368</td>
</tr>
</tbody>
</table>
### Menu Item

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Landed Costs Listing</td>
<td>imzqlq001</td>
<td>118095942</td>
</tr>
<tr>
<td>Lead Time Exception Report</td>
<td>imzrp001</td>
<td>118030486</td>
</tr>
<tr>
<td>Lead Time Formulas Listings</td>
<td>imzle001</td>
<td>269090846</td>
</tr>
<tr>
<td>Lot Serial Adjustment</td>
<td>imzub001</td>
<td>118292516</td>
</tr>
<tr>
<td>Lot Serial History Report</td>
<td>imzri001</td>
<td>118030496</td>
</tr>
<tr>
<td>Lot Summary Inquiry</td>
<td>imzqg001</td>
<td>117637150</td>
</tr>
<tr>
<td>Low Cost Report</td>
<td>imzro001</td>
<td>118030436</td>
</tr>
<tr>
<td>Maintain Contract Pricing</td>
<td>imzmu004</td>
<td>117506328</td>
</tr>
<tr>
<td>Maintain Customer Items</td>
<td>imzmv001</td>
<td>117506338</td>
</tr>
<tr>
<td>Maintain Inventory</td>
<td>imzmt001</td>
<td>117506238</td>
</tr>
<tr>
<td>Maintain Item Classes</td>
<td>imzmi001</td>
<td>117506138</td>
</tr>
<tr>
<td>Maintain Items</td>
<td>imzmr001</td>
<td>117506178</td>
</tr>
<tr>
<td>Maintain National Account Pricing</td>
<td>imzmx001</td>
<td>117506378</td>
</tr>
<tr>
<td>Maintain Price Sheet</td>
<td>imzmu001</td>
<td>117506298</td>
</tr>
<tr>
<td>Maintain Vendor Item</td>
<td>imzmg001</td>
<td>117506258</td>
</tr>
<tr>
<td>Move Stock</td>
<td>imzdf001</td>
<td>117833838</td>
</tr>
<tr>
<td>Negative On-Hand Qty Rpt</td>
<td>imzrh001</td>
<td>118030456</td>
</tr>
<tr>
<td>On Hand Lot/Serial Report</td>
<td>imzrj001</td>
<td>118030426</td>
</tr>
</tbody>
</table>
### Appendix F

#### Installation and System Configuration

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options Listing</td>
<td>imzlm001</td>
<td>118096072</td>
</tr>
<tr>
<td>Past Period Valuation Report</td>
<td>imzrf001</td>
<td>118030396</td>
</tr>
<tr>
<td>PI Batch</td>
<td>imzdh001</td>
<td>117833758</td>
</tr>
<tr>
<td>Post IM Batches</td>
<td>cizuf001</td>
<td>117899266</td>
</tr>
<tr>
<td>PPL History Inquiry</td>
<td>imzqc001</td>
<td>117637180</td>
</tr>
<tr>
<td>Price Inquiry</td>
<td>imzqb001</td>
<td>117637170</td>
</tr>
<tr>
<td>Price Sheet Listing</td>
<td>imzlu001</td>
<td>118096042</td>
</tr>
<tr>
<td>Print Suggested Orders</td>
<td>imzdd003</td>
<td>269025452</td>
</tr>
<tr>
<td>Print Transfer Order</td>
<td>imzrw001</td>
<td>118030556</td>
</tr>
<tr>
<td>Process Period End</td>
<td>imzdi001</td>
<td>118226946</td>
</tr>
<tr>
<td>Process Replenishment Orders</td>
<td>imzdd007</td>
<td>268828942</td>
</tr>
<tr>
<td>Product Category List</td>
<td>imzlw001</td>
<td>118096152</td>
</tr>
<tr>
<td>Product Grp Pricing List</td>
<td>imzlu008</td>
<td>118096102</td>
</tr>
<tr>
<td>Product Price Group Maintenance</td>
<td>imzmu002</td>
<td>117506288</td>
</tr>
<tr>
<td>Product Price Group Pricing</td>
<td>imzmu005</td>
<td>117506318</td>
</tr>
<tr>
<td>Product Price Grp Listing</td>
<td>imzlu007</td>
<td>118096062</td>
</tr>
<tr>
<td>Purchase Product Line Listing</td>
<td>imzlj001</td>
<td>118096012</td>
</tr>
<tr>
<td>Purge Data</td>
<td>imzuc001</td>
<td>117964802</td>
</tr>
</tbody>
</table>

---

218 Installation and System Configuration
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rank Inventory Items</td>
<td>imzdj001</td>
<td>117834078</td>
</tr>
<tr>
<td>Safety Stock Formula Listings</td>
<td>imzld001</td>
<td>269090826</td>
</tr>
<tr>
<td>Sales Product Lines Listing</td>
<td>imzlf001</td>
<td>118095892</td>
</tr>
<tr>
<td>Serial Summary Inquiry</td>
<td>imzqh001</td>
<td>117637140</td>
</tr>
<tr>
<td>Set Up Bins</td>
<td>imzmn001</td>
<td>117506268</td>
</tr>
<tr>
<td>Set Up Commodity Codes</td>
<td>imzmo001</td>
<td>117506108</td>
</tr>
<tr>
<td>Set Up Demand Formula</td>
<td>imzmc001</td>
<td>268501042</td>
</tr>
<tr>
<td>Set Up Freight Class</td>
<td>imzmp001</td>
<td>117506118</td>
</tr>
<tr>
<td>Set Up Inventory Ranks</td>
<td>imzrh001</td>
<td>117506088</td>
</tr>
<tr>
<td>Set Up Landed Cost</td>
<td>imzmm001</td>
<td>117506128</td>
</tr>
<tr>
<td>Set Up Lead Time Formula</td>
<td>imzme001</td>
<td>268501022</td>
</tr>
<tr>
<td>Set Up Product Categories</td>
<td>imzrm001</td>
<td>117506368</td>
</tr>
<tr>
<td>Set Up Purchase Product Line</td>
<td>imzmj001</td>
<td>117506158</td>
</tr>
<tr>
<td>Set Up Safety Stock Formula</td>
<td>imzmd001</td>
<td>268501002</td>
</tr>
<tr>
<td>Set Up Sales Product Line</td>
<td>imzmf001</td>
<td>117506068</td>
</tr>
<tr>
<td>Setup Warehouses</td>
<td>imzmk001</td>
<td>117506168</td>
</tr>
<tr>
<td>Setup Custom Field Values</td>
<td>cizmd001</td>
<td>117506358</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Program</td>
<td>Task ID</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Setup Options</td>
<td>imzmm001</td>
<td>117506148</td>
</tr>
<tr>
<td>Special Order Source Report</td>
<td>imzdd005</td>
<td>118030516</td>
</tr>
<tr>
<td>Stock Status Inquiry</td>
<td>imzqj001</td>
<td>117637200</td>
</tr>
<tr>
<td>Stock Status Report</td>
<td>imzrk001</td>
<td>118030416</td>
</tr>
<tr>
<td>Transaction Entry Batch</td>
<td>imzdh001</td>
<td>117833768</td>
</tr>
<tr>
<td>Transfer Order Line Summary Inquiry</td>
<td>imzqm001</td>
<td>117637290</td>
</tr>
<tr>
<td>Transfer Order Summary Inquiry</td>
<td>imzql001</td>
<td>117637300</td>
</tr>
<tr>
<td>Transfer Order Summary Inquiry</td>
<td>imzql001</td>
<td>117637300</td>
</tr>
<tr>
<td>Transfer Status Report</td>
<td>imzrv001</td>
<td>118030536</td>
</tr>
<tr>
<td>Transit Warehouse Variance Report</td>
<td>imzrx001</td>
<td>118030576</td>
</tr>
<tr>
<td>Unusual Usage Report</td>
<td>imzru001</td>
<td>269025450</td>
</tr>
<tr>
<td>Vendor Item Listing</td>
<td>imzlg001</td>
<td>118096032</td>
</tr>
<tr>
<td>Warehouse Inquiry</td>
<td>imzqo001</td>
<td>117638120</td>
</tr>
<tr>
<td>Warehouse Inquiry</td>
<td>imzqo001</td>
<td>117638120</td>
</tr>
<tr>
<td>Warehouse Listing</td>
<td>imzlk001</td>
<td>118095972</td>
</tr>
<tr>
<td>Warehouse Replenishment Maintenance</td>
<td>imzms001</td>
<td>268501172</td>
</tr>
</tbody>
</table>
## Manufacturing

### Introduction
This section describes task IDs and programs for the Manufacturing module.

### Manufacturing task list
The following table lists the tasks for the Manufacturing modules.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approval Type Listing</td>
<td>mfzla001</td>
<td>201981964</td>
</tr>
<tr>
<td>Approval Type Maintenance</td>
<td>mfzms001</td>
<td>604045313</td>
</tr>
<tr>
<td>BillOfMatReport</td>
<td>mfzrt001</td>
<td>201916422</td>
</tr>
<tr>
<td>BOM Cost Rollup</td>
<td>mfzxe001</td>
<td>202047497</td>
</tr>
<tr>
<td>BOM Cost Rollup Report</td>
<td>mfzrb001</td>
<td>201916425</td>
</tr>
<tr>
<td>BOM Item Replace</td>
<td>mfzuc001</td>
<td>202178567</td>
</tr>
<tr>
<td>BOM Regeneration</td>
<td>mfzub001</td>
<td>202178564</td>
</tr>
<tr>
<td>BOMWhereUsed</td>
<td>mfzru001</td>
<td>201916424</td>
</tr>
<tr>
<td>Break Time Listing</td>
<td>mfzll001</td>
<td>201981959</td>
</tr>
<tr>
<td>BreakTime</td>
<td>mfzmk001</td>
<td>201392137</td>
</tr>
<tr>
<td>Completion Entry</td>
<td>mfzdg001</td>
<td>570753031</td>
</tr>
<tr>
<td>CTP Inquiry</td>
<td>mfziz001</td>
<td>620888075</td>
</tr>
<tr>
<td>Current Activity Inquiry</td>
<td>mfzip001</td>
<td>201588765</td>
</tr>
<tr>
<td>Current Activity Inquiry</td>
<td>mfzip001</td>
<td>201588765</td>
</tr>
<tr>
<td>CurrentActivReport</td>
<td>mfzrh001</td>
<td>201916430</td>
</tr>
</tbody>
</table>
## Appendix F

### Menu Name | Program | Task ID
--- | --- | ---
Department Listing | mfzlb001 | 201981955
Department Maintenance | mfzmb001 | 201392134
Down Time Listing | mfzlk001 | 201981958
DownTime | mfzmi001 | 201392135
DowntimeReport | mfzrf001 | 201916428
ECO Past Due Approvals | mfzrw001 | 604569622
Employee Assignments | mfzeb001 | 654704642
Employee Listing | mfzlg001 | 201981953
Employee Maintenance | mfzmg001 | 201392129
Estimate Entry | mfzdu001 | 587530241
Estimate Markup Listing | mfzld001 | 201916441
Estimate Markup Maintenance | mfzmt001 | 201392147
Estimate Printing | mfzrx001 | 201916439
Estimate Quotation Printing | mfzrz001 | 201916440
Facility Listing | mfzlx001 | 201981967
Facility Maintenance | mfzm001 | 201392149
Holiday Schedule | mfzmm001 | 201392141
Holiday Schedule Listing | mfzlp001 | 201981963
### Desktop and Command Shortcuts

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Class Maintenance</td>
<td>mfzmf001</td>
<td>201392138</td>
</tr>
<tr>
<td>Job Closeout WIP Journal</td>
<td>mfzxd001</td>
<td>202047496</td>
</tr>
<tr>
<td>Job Costing Report</td>
<td>mfzrj001</td>
<td>201916419</td>
</tr>
<tr>
<td>Labor Assignments</td>
<td>mfzea001</td>
<td>654639109</td>
</tr>
<tr>
<td>Labor Entry</td>
<td>mfzdc001</td>
<td>570753026</td>
</tr>
<tr>
<td>Labor Entry Journal</td>
<td>mfzxp001</td>
<td>202047489</td>
</tr>
<tr>
<td>Labor WIP Journal</td>
<td>mfzxb001</td>
<td>202047494</td>
</tr>
<tr>
<td>LaborReports</td>
<td>mfzrm001</td>
<td>201916420</td>
</tr>
<tr>
<td>Lot Tracking Inquiry</td>
<td>mfziv001</td>
<td>201457673</td>
</tr>
<tr>
<td>Machine Listing</td>
<td>mfzlh001</td>
<td>201981957</td>
</tr>
<tr>
<td>Machine Maintenance</td>
<td>mfzmh001</td>
<td>201392130</td>
</tr>
<tr>
<td>Machine Schedule</td>
<td>mfzm001</td>
<td>201981960</td>
</tr>
<tr>
<td>Machine Schedule Listing</td>
<td>mfzlo001</td>
<td>201981962</td>
</tr>
<tr>
<td>Mat/Out/Other WIP Register</td>
<td>mfzxa001</td>
<td>202047493</td>
</tr>
<tr>
<td>Material Issues</td>
<td>mfzdd001</td>
<td>570753027</td>
</tr>
<tr>
<td>MaterialIssuesJournal</td>
<td>mfzxr001</td>
<td>202047490</td>
</tr>
<tr>
<td>MRP GenerationReport</td>
<td>mfzsc001</td>
<td>621346824</td>
</tr>
<tr>
<td>MRP Plan Orders Report</td>
<td>mfzrm001</td>
<td>621346822</td>
</tr>
<tr>
<td>MRP Projected Inventory Valuation</td>
<td>mfzrp001</td>
<td>621346823</td>
</tr>
</tbody>
</table>
### Appendix F

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>MRP Report</td>
<td>mfzrv001</td>
<td>621346817</td>
</tr>
<tr>
<td>Open WIP</td>
<td>mfzro001</td>
<td>201916423</td>
</tr>
<tr>
<td>Operation Listing</td>
<td>mfzlc001</td>
<td>201981956</td>
</tr>
<tr>
<td>Operation Maintenance</td>
<td>mfzmc001</td>
<td>201392132</td>
</tr>
<tr>
<td>Operation Where Used Report</td>
<td>mfzsh001</td>
<td>201916445</td>
</tr>
<tr>
<td>Other Issues</td>
<td>mfzdd001</td>
<td>570753029</td>
</tr>
<tr>
<td>Other Issues Journal</td>
<td>mfzxf001</td>
<td>202047492</td>
</tr>
<tr>
<td>Outside Issues</td>
<td>mfzdd001</td>
<td>570753028</td>
</tr>
<tr>
<td>Outside Shipments</td>
<td>mfzdl001</td>
<td>570753033</td>
</tr>
<tr>
<td>OutsideIssuesJournal</td>
<td>mfzxsl001</td>
<td>20047491</td>
</tr>
<tr>
<td>Parameters Maintenance</td>
<td>mfzmd001</td>
<td>201392133</td>
</tr>
<tr>
<td>Production Entry</td>
<td>mfzdz001</td>
<td>201654281</td>
</tr>
<tr>
<td>Production Entry Report</td>
<td>mfzse001</td>
<td>201916447</td>
</tr>
<tr>
<td>Progress WIP Journal</td>
<td>mfzxc001</td>
<td>202047495</td>
</tr>
<tr>
<td>Routing Data Entry</td>
<td>mfzda001</td>
<td>201392155</td>
</tr>
<tr>
<td>Routing Inquiry</td>
<td>mfzda001</td>
<td>201588767</td>
</tr>
<tr>
<td>Routing Report</td>
<td>mfzra001</td>
<td>201916417</td>
</tr>
<tr>
<td>ScheduleGeneration</td>
<td>mfzmn001</td>
<td>637599745</td>
</tr>
<tr>
<td>SchItemInquiry</td>
<td>mfzja001</td>
<td>201457676</td>
</tr>
</tbody>
</table>
### Desktop and Command Shortcuts

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>SchMachUtilizationReport</td>
<td>mfzrs001</td>
<td>201916437</td>
</tr>
<tr>
<td>SchWCUtilizationReport</td>
<td>mfzrq001</td>
<td>201916436</td>
</tr>
<tr>
<td>Scrap Listing</td>
<td>mfzlm001</td>
<td>201981960</td>
</tr>
<tr>
<td>ScrapReason</td>
<td>mfzmrj001</td>
<td>201392136</td>
</tr>
<tr>
<td>ScrapReport</td>
<td>mfzrg001</td>
<td>201916429</td>
</tr>
<tr>
<td>Serial Tracking Inquiry</td>
<td>mfzjb001</td>
<td>201457678</td>
</tr>
<tr>
<td>Shipments Status Report</td>
<td>mfzrc001</td>
<td>201916426</td>
</tr>
<tr>
<td>Shop Floor Control</td>
<td>mfzdk001</td>
<td>654639107</td>
</tr>
<tr>
<td>Standard Routing Assignment</td>
<td>mfzdr001</td>
<td>201392157</td>
</tr>
<tr>
<td>Start Job Entry</td>
<td>mfzdi001</td>
<td>654639105</td>
</tr>
<tr>
<td>Start Job Maintenance</td>
<td>mfzdi001</td>
<td>654639108</td>
</tr>
<tr>
<td>Stop Job Entry</td>
<td>mfzdj001</td>
<td>654639106</td>
</tr>
<tr>
<td>Tool Listing</td>
<td>mfzlf001</td>
<td>201981965</td>
</tr>
<tr>
<td>Tool Machine Listing</td>
<td>mfzli001</td>
<td>201981966</td>
</tr>
<tr>
<td>Tool Schedule Report</td>
<td>mfzsa001</td>
<td>201916443</td>
</tr>
<tr>
<td>Tools Maintenance</td>
<td>mfzmu001</td>
<td>201392148</td>
</tr>
<tr>
<td>Warehouse Consolidation</td>
<td>mfzdv001</td>
<td>620822530</td>
</tr>
<tr>
<td>WC Schedule</td>
<td>mfzma001</td>
<td>201392139</td>
</tr>
<tr>
<td>WC Schedule Report</td>
<td>mfzrr001</td>
<td>201916435</td>
</tr>
</tbody>
</table>
### Appendix F

<table>
<thead>
<tr>
<th><strong>Menu Name</strong></th>
<th><strong>Program</strong></th>
<th><strong>Task ID</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>WCSchedule Listing</td>
<td>mfzln001</td>
<td>201981961</td>
</tr>
<tr>
<td>WIP Batch Setup</td>
<td>mfzud001</td>
<td>202178568</td>
</tr>
<tr>
<td>WIP Costing Report</td>
<td>mfzre001</td>
<td>201916427</td>
</tr>
<tr>
<td>WO Schedule Report</td>
<td>mfzrl001</td>
<td>201916432</td>
</tr>
<tr>
<td>WOPriority Report</td>
<td>mfzrk001</td>
<td>201916431</td>
</tr>
<tr>
<td>Work Center Listing</td>
<td>mfzle001</td>
<td>201981954</td>
</tr>
<tr>
<td>Work Center Where Used</td>
<td>mfzry001</td>
<td>201916442</td>
</tr>
<tr>
<td>Work Order Inquiry</td>
<td>mfzjc001</td>
<td>570621953</td>
</tr>
<tr>
<td>Work Order Inquiry</td>
<td>mfzjc001</td>
<td>570621953</td>
</tr>
<tr>
<td>Work Order Pick List</td>
<td>mfzsf001</td>
<td>571015169</td>
</tr>
<tr>
<td>Work Order Report</td>
<td>mfzri001</td>
<td>201916418</td>
</tr>
<tr>
<td>Work Order Transaction</td>
<td>mfzia001</td>
<td>201588769</td>
</tr>
<tr>
<td>WorkCenter Maintenance</td>
<td>mfzme001</td>
<td>201392159</td>
</tr>
<tr>
<td>WorkOrderCompletion</td>
<td>mfzrd001</td>
<td>201916421</td>
</tr>
<tr>
<td>WorkOrderCreation</td>
<td>mfzdh001</td>
<td>570753032</td>
</tr>
<tr>
<td>WorkOrderEntry</td>
<td>mfzdb001</td>
<td>570753025</td>
</tr>
<tr>
<td>WorkOrderPurge</td>
<td>mfzua001</td>
<td>201850882</td>
</tr>
<tr>
<td>WorkOrderStatusReport</td>
<td>mfzsd001</td>
<td>201916446</td>
</tr>
</tbody>
</table>
The following table lists Product Configurator tasks.

<table>
<thead>
<tr>
<th>Menu Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configurator Inquiry</td>
<td>pczib001</td>
<td>218234883</td>
</tr>
<tr>
<td>Configurator Inquiry</td>
<td>pczib001</td>
<td>218234883</td>
</tr>
<tr>
<td>Definition Inquiry</td>
<td>pczia001</td>
<td>218234882</td>
</tr>
<tr>
<td>Definition Inquiry</td>
<td>pczia001</td>
<td>218234882</td>
</tr>
<tr>
<td>Item Where Used</td>
<td>pczrc001</td>
<td>218693635</td>
</tr>
<tr>
<td>Operation Maintenance</td>
<td>mfzmc001</td>
<td>218169346</td>
</tr>
<tr>
<td>Options</td>
<td>pczma001</td>
<td>218169345</td>
</tr>
<tr>
<td>Options and Values</td>
<td>pczdc001</td>
<td>218431489</td>
</tr>
<tr>
<td>Options and Values Report</td>
<td>pczra001</td>
<td>218693633</td>
</tr>
<tr>
<td>Options Where Used</td>
<td>pczrd001</td>
<td>218693636</td>
</tr>
<tr>
<td>Preferences Listing</td>
<td>pczla001</td>
<td>218759169</td>
</tr>
<tr>
<td>Product Configuration Maint</td>
<td>pczda001</td>
<td>218431490</td>
</tr>
<tr>
<td>Product Configuration Report</td>
<td>pczrb001</td>
<td>218693634</td>
</tr>
<tr>
<td>Product Configurator</td>
<td>pczdb001</td>
<td>218431491</td>
</tr>
<tr>
<td>Regenerate Configurations</td>
<td>pczxa001</td>
<td>218497025</td>
</tr>
</tbody>
</table>
Appendix F

## Multicurrency Management

### Task list

The following table lists Multicurrency Management tasks.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts Payable Revaluation</td>
<td>mczdb001</td>
<td>168165378</td>
</tr>
<tr>
<td>Accounts Receivable Revaluation</td>
<td>mczdc001</td>
<td>168165377</td>
</tr>
<tr>
<td>Currency List</td>
<td>mczla001</td>
<td>168427524</td>
</tr>
<tr>
<td>Currency Setup</td>
<td>mczma001</td>
<td>167837698</td>
</tr>
<tr>
<td>Exchange Rate List</td>
<td>mczlb001</td>
<td>168427521</td>
</tr>
<tr>
<td>Exchange Rate Maint</td>
<td>mczmb001</td>
<td>167837699</td>
</tr>
<tr>
<td>GL Account Revaluation</td>
<td>mczda001</td>
<td>168165379</td>
</tr>
<tr>
<td>GL Account Trial Balance Report</td>
<td>glzrl001</td>
<td>168361994</td>
</tr>
<tr>
<td>Options List</td>
<td>mczlc001</td>
<td>168427522</td>
</tr>
<tr>
<td>Options Setup</td>
<td>mczsao01</td>
<td>167837697</td>
</tr>
<tr>
<td>Process Period End</td>
<td>mczpa001</td>
<td>168558593</td>
</tr>
<tr>
<td>Purge MC Data</td>
<td>mczue001</td>
<td>168296449</td>
</tr>
</tbody>
</table>
### Project Accounting

#### Task list

The following table lists Project Accounting tasks.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Level List</td>
<td>pazlm001</td>
<td>319422599</td>
</tr>
<tr>
<td>Committed Costs Inquiry</td>
<td>pazqn001</td>
<td>319030282</td>
</tr>
<tr>
<td>Committed Costs Report</td>
<td>pazrt001</td>
<td>319357062</td>
</tr>
<tr>
<td>Contract Rate Lst</td>
<td>pazll001</td>
<td>319422584</td>
</tr>
<tr>
<td>Contract Rate Maint By Job Title</td>
<td>pazmj003</td>
<td>318832820</td>
</tr>
<tr>
<td>Contract Rate Maint By Project</td>
<td>pazmj001</td>
<td>318832800</td>
</tr>
<tr>
<td>Contract Rate Maint By Resource</td>
<td>pazmj002</td>
<td>318832810</td>
</tr>
<tr>
<td>Cost Transaction Report</td>
<td>pazry001</td>
<td>319357073</td>
</tr>
<tr>
<td>Division Lst</td>
<td>pazlc001</td>
<td>319422570</td>
</tr>
<tr>
<td>Division Maint</td>
<td>pazmc001</td>
<td>318832765</td>
</tr>
<tr>
<td>Enter Writeoffs</td>
<td>pazaj001</td>
<td>319160490</td>
</tr>
<tr>
<td>Expense Claim Approval Report</td>
<td>pazrp001</td>
<td>319357048</td>
</tr>
<tr>
<td>Expense Claim Billing List</td>
<td>pazlu001</td>
<td>319422644</td>
</tr>
<tr>
<td>Expense Claim Inquiry</td>
<td>pazqj001</td>
<td>319030292</td>
</tr>
<tr>
<td>Expense Claim Line Inquiry</td>
<td>pazqm001</td>
<td>319030294</td>
</tr>
<tr>
<td><strong>Menu Item</strong></td>
<td><strong>Program</strong></td>
<td><strong>Task ID</strong></td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Expense Item List</td>
<td>pazlo001</td>
<td>319422589</td>
</tr>
<tr>
<td>Expense Payment Types List</td>
<td>pazlp001</td>
<td>319422594</td>
</tr>
<tr>
<td>General Ledger Reconciliation</td>
<td>pazra001</td>
<td>319357064</td>
</tr>
<tr>
<td>Generate Purchase Orders</td>
<td>pazac001</td>
<td>319160350</td>
</tr>
<tr>
<td>Inventory Transactions Report</td>
<td>pazrz001</td>
<td>319357070</td>
</tr>
<tr>
<td>Invoice Descriptions</td>
<td>pazmi001</td>
<td>318832780</td>
</tr>
<tr>
<td>Invoice Descriptions Lst</td>
<td>pazlk001</td>
<td>319422583</td>
</tr>
<tr>
<td>Job Title Lst</td>
<td>pazlh001</td>
<td>319422574</td>
</tr>
<tr>
<td>Job Title Maint</td>
<td>pazmg001</td>
<td>318832745</td>
</tr>
<tr>
<td>Maintain Access Levels</td>
<td>pazmk001</td>
<td>318832865</td>
</tr>
<tr>
<td>Maintain Exp Items</td>
<td>pazml001</td>
<td>318832875</td>
</tr>
<tr>
<td>Maintain Expense Claim Billing</td>
<td>pazmr001</td>
<td>318832900</td>
</tr>
<tr>
<td>Maintain Expense Payment Types</td>
<td>pazmm001</td>
<td>318832880</td>
</tr>
<tr>
<td>Maintain Project Rosters</td>
<td>pazmq001</td>
<td>318832895</td>
</tr>
<tr>
<td>Maintain Team Rosters</td>
<td>pazmo001</td>
<td>318832890</td>
</tr>
<tr>
<td>Master Project Lst</td>
<td>pazlb001</td>
<td>319422573</td>
</tr>
<tr>
<td>Master Project Maint</td>
<td>pazma001</td>
<td>319160542</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Program</td>
<td>Task ID</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Misc Project Transaction Inquiry</td>
<td>pazqa001</td>
<td>319030296</td>
</tr>
<tr>
<td>Options Lst</td>
<td>pazlf001</td>
<td>319422572</td>
</tr>
<tr>
<td>Options Maint</td>
<td>pazmf001</td>
<td>318832740</td>
</tr>
<tr>
<td>Percent Complete Report</td>
<td>pazrx001</td>
<td>319357069</td>
</tr>
<tr>
<td>Phase List</td>
<td>pazld001</td>
<td>319422569</td>
</tr>
<tr>
<td>Phase Maint</td>
<td>pazmd001</td>
<td>318832760</td>
</tr>
<tr>
<td>Post PA Batches</td>
<td>pazpc001</td>
<td>319225858</td>
</tr>
<tr>
<td>Posted Expense Claim Report</td>
<td>pazlq001</td>
<td>319422610</td>
</tr>
<tr>
<td>Posted Timesheet Lst</td>
<td>pazlj001</td>
<td>319422585</td>
</tr>
<tr>
<td>Print Posted Expense Claims</td>
<td>pazrq001</td>
<td>319357059</td>
</tr>
<tr>
<td>Print Unposted Expense Claims</td>
<td>pazrb001</td>
<td>319357058</td>
</tr>
<tr>
<td>Process Expense Claims</td>
<td>paztm001</td>
<td>319160450</td>
</tr>
<tr>
<td>Process Inventory Transactions</td>
<td>paztp001</td>
<td>319160530</td>
</tr>
<tr>
<td>Process Project Invoices</td>
<td>pazto001</td>
<td>319094884</td>
</tr>
<tr>
<td>Process Project Transcations</td>
<td>paztq001</td>
<td>319160510</td>
</tr>
<tr>
<td>Process Timesheets</td>
<td>paztl001</td>
<td>319160410</td>
</tr>
<tr>
<td>Profit History Rpt</td>
<td>pazrm001</td>
<td>319357033</td>
</tr>
<tr>
<td>Profit Recognition</td>
<td>pazoc001</td>
<td>319225860</td>
</tr>
</tbody>
</table>
### Appendix F

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Chargeability Rpt</td>
<td>pazrn001</td>
<td>319357035</td>
</tr>
<tr>
<td>Project Class Lst</td>
<td>pazla001</td>
<td>319422578</td>
</tr>
<tr>
<td>Project Class Maint</td>
<td>pazmb001</td>
<td>318832755</td>
</tr>
<tr>
<td>Project Completion</td>
<td>pazag001</td>
<td>319160360</td>
</tr>
<tr>
<td>Project Entry</td>
<td>pazaa001</td>
<td>319160330</td>
</tr>
<tr>
<td>Project Forecast Estimate Rpt</td>
<td>pazrd001</td>
<td>319357031</td>
</tr>
<tr>
<td>Project Lst</td>
<td>pazlg001</td>
<td>319422568</td>
</tr>
<tr>
<td>Project Profit and Loss Report</td>
<td>pazrv001</td>
<td>319357063</td>
</tr>
<tr>
<td>Project Profit Rpt</td>
<td>pazrl001</td>
<td>319357032</td>
</tr>
<tr>
<td>Project Rosters List</td>
<td>pazls001</td>
<td>319422613</td>
</tr>
<tr>
<td>Project Status Inq</td>
<td>pazqd001</td>
<td>319030280</td>
</tr>
<tr>
<td>Project Summary Rpt</td>
<td>pazrk001</td>
<td>319357038</td>
</tr>
<tr>
<td>Project Transaction Detail Inquiry</td>
<td>pazql001</td>
<td>319030286</td>
</tr>
<tr>
<td>Project Transaction Ledger</td>
<td>pazre001</td>
<td>319357034</td>
</tr>
<tr>
<td>Project Transaction Report</td>
<td>pazraa01</td>
<td>319357078</td>
</tr>
<tr>
<td>Project Trx Inq</td>
<td>pazqi001</td>
<td>319030284</td>
</tr>
<tr>
<td>Project WIP Rpt</td>
<td>pazrh001</td>
<td>319357037</td>
</tr>
<tr>
<td>Resource Lst</td>
<td>pazli001</td>
<td>319422566</td>
</tr>
<tr>
<td>Resource Maint</td>
<td>pazmh001</td>
<td>318832775</td>
</tr>
</tbody>
</table>
### Desktop and Command Shortcuts

<table>
<thead>
<tr>
<th><strong>Menu Item</strong></th>
<th><strong>Program</strong></th>
<th><strong>Task ID</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Expense Claims For Approval</td>
<td>pazai001</td>
<td>319160470</td>
</tr>
<tr>
<td>Select Timesheets For Approval</td>
<td>pazai002</td>
<td>319160472</td>
</tr>
<tr>
<td>Task Lst</td>
<td>pazle001</td>
<td>319422575</td>
</tr>
<tr>
<td>Task Maint</td>
<td>pazme001</td>
<td>318832770</td>
</tr>
<tr>
<td>Team Rosters List</td>
<td>pazlr001</td>
<td>319422612</td>
</tr>
<tr>
<td>Timesheet Approval Report</td>
<td>pazrp002</td>
<td>319357050</td>
</tr>
<tr>
<td>Timesheet Inq</td>
<td>pazqf001</td>
<td>319030288</td>
</tr>
<tr>
<td>Timesheet Line Inquiry</td>
<td>pazqk001</td>
<td>319030290</td>
</tr>
<tr>
<td>Unbilled Project Rpt</td>
<td>pazrj001</td>
<td>319357030</td>
</tr>
<tr>
<td>Unposted Timesheet Lst</td>
<td>pazlj002</td>
<td>319422586</td>
</tr>
<tr>
<td>Unposted Timesheet Rpt</td>
<td>pazri001</td>
<td>319357029</td>
</tr>
<tr>
<td>Utilization/Realization Rpt</td>
<td>pazru001</td>
<td>319357068</td>
</tr>
</tbody>
</table>
The following table lists Purchase Order tasks.

<table>
<thead>
<tr>
<th>Task Name</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Ordered Purchase Orders Report</td>
<td>pozrl001</td>
<td>185139850</td>
</tr>
<tr>
<td>Blanket Order Maintenance</td>
<td>pozmc001</td>
<td>184615212</td>
</tr>
<tr>
<td>Blanket Order Report</td>
<td>pozrk001</td>
<td>185139800</td>
</tr>
<tr>
<td>Buyer List</td>
<td>imzlb001</td>
<td>185205886</td>
</tr>
<tr>
<td>Buyer Maint</td>
<td>imzma001</td>
<td>184616012</td>
</tr>
<tr>
<td>Change Order Report</td>
<td>pozrh001</td>
<td>185139650</td>
</tr>
<tr>
<td>Change Order Summary DA</td>
<td>pozqj001</td>
<td>184746584</td>
</tr>
<tr>
<td>Custom Field Maintenance</td>
<td>cizmd001</td>
<td>184615112</td>
</tr>
<tr>
<td>Department List</td>
<td>pozlb001</td>
<td>185204936</td>
</tr>
<tr>
<td>Department Maintenance</td>
<td>pozmb001</td>
<td>184615062</td>
</tr>
<tr>
<td>Expected Delivery Report</td>
<td>pozrg001</td>
<td>185139600</td>
</tr>
<tr>
<td>Open Purchase Order Item Report</td>
<td>pozrb001</td>
<td>185139350</td>
</tr>
<tr>
<td>Options List</td>
<td>pozlg001</td>
<td>185204836</td>
</tr>
<tr>
<td>Options Setup</td>
<td>pozmg001</td>
<td>184615012</td>
</tr>
<tr>
<td>Post PO Batches</td>
<td>pozuf001</td>
<td>185401544</td>
</tr>
<tr>
<td>Print Receiving Tickets</td>
<td>pozri001</td>
<td>185139700</td>
</tr>
</tbody>
</table>
### Desktop and Command Shortcuts

<table>
<thead>
<tr>
<th><strong>Menu Item</strong></th>
<th><strong>Program</strong></th>
<th><strong>Task ID</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Requisitions</td>
<td>poztb001</td>
<td>184942943</td>
</tr>
<tr>
<td>Process Period End</td>
<td>pozdk001</td>
<td>185335810</td>
</tr>
<tr>
<td>Purchase Analysis</td>
<td>pozrf001</td>
<td>185139550</td>
</tr>
<tr>
<td>Purchase Order Entry</td>
<td>pozda001</td>
<td>184942742</td>
</tr>
<tr>
<td>Purchase Order Inquiry</td>
<td>pozqa001</td>
<td>184746085</td>
</tr>
<tr>
<td>Purchase Order Inquiry</td>
<td>pozqa001</td>
<td>184746085</td>
</tr>
<tr>
<td>Purchase Order Issue</td>
<td>poztc001</td>
<td>184942692</td>
</tr>
<tr>
<td>Purchase Order Line Summary</td>
<td>pozqb001</td>
<td>184746134</td>
</tr>
<tr>
<td>Purchases Clearing Report</td>
<td>pozrj001</td>
<td>185139750</td>
</tr>
<tr>
<td>Purchases Journal</td>
<td>pozrd001</td>
<td>185139500</td>
</tr>
<tr>
<td>Purge</td>
<td>pozdh001</td>
<td>185073766</td>
</tr>
<tr>
<td>Receipt of Goods Batch</td>
<td>poztl001</td>
<td>184943092</td>
</tr>
<tr>
<td>Receipt Line Summary Inquiry DA</td>
<td>pozqi001</td>
<td>184746534</td>
</tr>
<tr>
<td>Receipt Summary Inquiry DA</td>
<td>pozqf001</td>
<td>184746484</td>
</tr>
<tr>
<td>Receipt Summary Inquiry DA</td>
<td>pozqf001</td>
<td>184746484</td>
</tr>
<tr>
<td>Requisition Entry</td>
<td>pozde001</td>
<td>184942925</td>
</tr>
<tr>
<td>Requisition Line Summary</td>
<td>pozqe001</td>
<td>184746234</td>
</tr>
<tr>
<td>Requisition Summary</td>
<td>pozqd001</td>
<td>184746184</td>
</tr>
</tbody>
</table>
## Appendix F

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return Line Summary DA</td>
<td>pozqh001</td>
<td>184746684</td>
</tr>
<tr>
<td>Return Summary DA</td>
<td>pozqg001</td>
<td>184746634</td>
</tr>
<tr>
<td>Return Summary DA</td>
<td>pozqg001</td>
<td>184746634</td>
</tr>
<tr>
<td>Returns Batch Processing</td>
<td>poztl001</td>
<td>184943142</td>
</tr>
<tr>
<td>Standard Cost Analysis</td>
<td>pozrc001</td>
<td>185139400</td>
</tr>
<tr>
<td>Status Report</td>
<td>pozra001</td>
<td>185139300</td>
</tr>
<tr>
<td>Tagged Orders Report</td>
<td>pozrm001</td>
<td>185139900</td>
</tr>
<tr>
<td>Tagged Orders Report</td>
<td>pozrm001</td>
<td>185139900</td>
</tr>
<tr>
<td>Tolerance Code Maint</td>
<td>pozma001</td>
<td>184615162</td>
</tr>
<tr>
<td>Tolerance Codes List</td>
<td>pozla001</td>
<td>185204986</td>
</tr>
<tr>
<td>Vendor - Item Xref List</td>
<td>imzla001</td>
<td>185205836</td>
</tr>
<tr>
<td>Vendor - Item Xref Maint</td>
<td>imzmg001</td>
<td>184616062</td>
</tr>
<tr>
<td>View Vendor Returns</td>
<td>pozdj001</td>
<td>184943392</td>
</tr>
<tr>
<td>View/Edit Change Orders</td>
<td>pozdl001</td>
<td>184943442</td>
</tr>
<tr>
<td>View/Edit Receiver</td>
<td>pozdg001</td>
<td>184943342</td>
</tr>
<tr>
<td>Voucher Batch</td>
<td>poztl001</td>
<td>184942792</td>
</tr>
</tbody>
</table>
## Sales Order

**Task list**
The following table lists Sales Order tasks.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aged Orders</td>
<td>sozrx001</td>
<td>134808102</td>
</tr>
<tr>
<td>Available To Ship Report</td>
<td>sozrz001</td>
<td>134808532</td>
</tr>
<tr>
<td>BackOrders</td>
<td>sozra001</td>
<td>134807902</td>
</tr>
<tr>
<td>Blanket Order Report</td>
<td>sozrc001</td>
<td>134807752</td>
</tr>
<tr>
<td>Cancel Picks</td>
<td>sozdx001</td>
<td>134611844</td>
</tr>
<tr>
<td>Change Order Report</td>
<td>sozrv001</td>
<td>134808452</td>
</tr>
<tr>
<td>Change Order Summary</td>
<td>sozqa001</td>
<td>134414436</td>
</tr>
<tr>
<td>Confirm Picks</td>
<td>sozdg001</td>
<td>134611244</td>
</tr>
<tr>
<td>Create Pick List</td>
<td>sozdd001</td>
<td>134611044</td>
</tr>
<tr>
<td>Cust Returns Batch</td>
<td>soztb001</td>
<td>134630000</td>
</tr>
<tr>
<td>Cust SO Summary</td>
<td>sozqt001</td>
<td>134414911</td>
</tr>
<tr>
<td>Cust SO Summary</td>
<td>sozqt001</td>
<td>134414911</td>
</tr>
<tr>
<td>Custom Field Maintenance</td>
<td>cizmd001</td>
<td>134283514</td>
</tr>
<tr>
<td>Customer Return Report</td>
<td>sozra002</td>
<td>134807802</td>
</tr>
<tr>
<td>Enter Quotes</td>
<td>sozdb001</td>
<td>134611164</td>
</tr>
<tr>
<td>Entry</td>
<td>sozdj001</td>
<td>134611094</td>
</tr>
<tr>
<td>Expected Shipments</td>
<td>sozrh001</td>
<td>134808002</td>
</tr>
</tbody>
</table>
### Appendix F

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gen Shipments Batch</td>
<td>soztb001</td>
<td>134620000</td>
</tr>
<tr>
<td>Import Sales Orders</td>
<td>sozry001</td>
<td>135069796</td>
</tr>
<tr>
<td>Maintain Blankets</td>
<td>sozda001</td>
<td>134283516</td>
</tr>
<tr>
<td>Open Order Items Report</td>
<td>sozrn001</td>
<td>134807702</td>
</tr>
<tr>
<td>Options List</td>
<td>sozle001</td>
<td>134873243</td>
</tr>
<tr>
<td>Picking Inquiry</td>
<td>sozqv001</td>
<td>134414846</td>
</tr>
<tr>
<td>Post SO Batches</td>
<td>cizuf001</td>
<td>134676482</td>
</tr>
<tr>
<td>Print / Acknowledge</td>
<td>soztc001</td>
<td>134808547</td>
</tr>
<tr>
<td>Print / EMail RMA</td>
<td>soztd001</td>
<td>134808543</td>
</tr>
<tr>
<td>Process Period End</td>
<td>sozdo001</td>
<td>135004162</td>
</tr>
<tr>
<td>Projected Sales</td>
<td>sozrj001</td>
<td>134808352</td>
</tr>
<tr>
<td>Quote Expiration Report</td>
<td>sozri001</td>
<td>134808052</td>
</tr>
<tr>
<td>Quote Summary</td>
<td>sozqb001</td>
<td>134414586</td>
</tr>
<tr>
<td>Quote Summary</td>
<td>sozqb001</td>
<td>134414586</td>
</tr>
<tr>
<td>Reprint Pick List</td>
<td>sozdu001</td>
<td>134808545</td>
</tr>
<tr>
<td>Return Summary</td>
<td>sozqm001</td>
<td>134414836</td>
</tr>
<tr>
<td>ReturnLineSum</td>
<td>sozqn001</td>
<td>134414886</td>
</tr>
<tr>
<td>RMA Entry</td>
<td>sozde001</td>
<td>134611069</td>
</tr>
<tr>
<td>RMA Inquiry</td>
<td>sozqu001</td>
<td>134414916</td>
</tr>
<tr>
<td>RMA Report</td>
<td>sozra003</td>
<td>134807912</td>
</tr>
<tr>
<td>Sales Analysis Report</td>
<td>sozrk001</td>
<td>134808152</td>
</tr>
</tbody>
</table>
### Desktop and Command Shortcuts

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Order History</td>
<td>sozru001</td>
<td>134807910</td>
</tr>
<tr>
<td>Sales Order Line Summary</td>
<td>sozql001</td>
<td>134414536</td>
</tr>
<tr>
<td>Sales Order Profitability Report</td>
<td>sozrq001</td>
<td>134808302</td>
</tr>
<tr>
<td>Sales Order Purge Process</td>
<td>sozdm001</td>
<td>134611444</td>
</tr>
<tr>
<td>Sales Order Status Report</td>
<td>sozrm001</td>
<td>134808202</td>
</tr>
<tr>
<td>Sales Order Summary</td>
<td>sozqk001</td>
<td>134414486</td>
</tr>
<tr>
<td>Sales Order Summary</td>
<td>sozqk001</td>
<td>134414486</td>
</tr>
<tr>
<td>Set Up Sources</td>
<td>sozmf001</td>
<td>134283414</td>
</tr>
<tr>
<td>Setup Options</td>
<td>sozme001</td>
<td>134283464</td>
</tr>
<tr>
<td>Shipment Line Summary</td>
<td>sozqi001</td>
<td>134414736</td>
</tr>
<tr>
<td>Shipment Summary</td>
<td>sozqh001</td>
<td>134414686</td>
</tr>
<tr>
<td>Shipment Summary</td>
<td>sozqh001</td>
<td>134414686</td>
</tr>
<tr>
<td>Short Stock Report</td>
<td>sozrz002</td>
<td>134808541</td>
</tr>
<tr>
<td>Source List</td>
<td>sozlf001</td>
<td>134873238</td>
</tr>
<tr>
<td>View Change Orders</td>
<td>sozdi001</td>
<td>134611219</td>
</tr>
<tr>
<td>View Customer Returns</td>
<td>sozd003</td>
<td>134611054</td>
</tr>
<tr>
<td>View Shipments</td>
<td>sozdr001</td>
<td>134611744</td>
</tr>
</tbody>
</table>
## System Manager

### Task list

The following table lists System Manager tasks.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assisted Company Setup List</td>
<td>smzla001</td>
<td>17432586</td>
</tr>
<tr>
<td>Change Business Date</td>
<td>smzmg001</td>
<td>17631534</td>
</tr>
<tr>
<td>Company List</td>
<td>smzrc001</td>
<td>17432578</td>
</tr>
<tr>
<td>Company Maint</td>
<td>smzmc001</td>
<td>16842761</td>
</tr>
<tr>
<td>Company Profile</td>
<td>smzrj001</td>
<td>17374075</td>
</tr>
<tr>
<td>Deferred Printing</td>
<td>smzth001</td>
<td>17629300</td>
</tr>
<tr>
<td>Easy Setup Maint</td>
<td>smphasel</td>
<td>16843152</td>
</tr>
<tr>
<td>Launch Pad Customization</td>
<td>sota.cus</td>
<td>17631536</td>
</tr>
<tr>
<td>Maintain Site</td>
<td>smzme001</td>
<td>16847199</td>
</tr>
<tr>
<td>Maintenance Audit Log</td>
<td>smzrl001</td>
<td>17374077</td>
</tr>
<tr>
<td>Order Business Forms</td>
<td>smzmf001</td>
<td>17631524</td>
</tr>
<tr>
<td>Purge Activity Log</td>
<td>smztf001</td>
<td>17301508</td>
</tr>
<tr>
<td>Register Modules Report</td>
<td>smzre001</td>
<td>17374071</td>
</tr>
<tr>
<td>System Activity Log</td>
<td>smzri001</td>
<td>17374073</td>
</tr>
<tr>
<td>System Status</td>
<td>smzia001</td>
<td>17631529</td>
</tr>
<tr>
<td>User Group List</td>
<td>smzrb001</td>
<td>17432579</td>
</tr>
<tr>
<td>User Group Maint</td>
<td>smzmb001</td>
<td>16842962</td>
</tr>
</tbody>
</table>
### Obtaining the Task ID

**Description**

In a query tool, such as SQL Server Query Analyzer, run the queries on the system database as shown in this section to get task IDs and program names. The queries shown here sort and present the information in different ways.

**Listing tasks for a specific module**

The following query lists only the tasks for a specific module. Tasks are organized by menu title, with the & symbol used to indicate shortcut characters is considered in the sort.

```sql
SELECT tsmMenu.MenuTitle, tsmTask.TaskOleProgID, tsmTask.TaskID
FROM tsmTask, tsmMenu
WHERE UPPER(TaskOleProgID) LIKE 'AP%' AND tsmTask.TaskID = tsmMenu.TaskID
ORDER BY MenuTitle
```

Replace AP with the abbreviation of the module you want. For example, to get a listing of SM tasks, change the fourth line to the following:

```sql
WHERE UPPER(TaskOleProgID) LIKE 'SM%' AND
```

---

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Program</th>
<th>Task ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Group Permission List</td>
<td>smzrm001</td>
<td>17374078</td>
</tr>
<tr>
<td>User List</td>
<td>smzra001</td>
<td>17432577</td>
</tr>
<tr>
<td>User Maint</td>
<td>smzma001</td>
<td>16842757</td>
</tr>
<tr>
<td>User Preferences</td>
<td>smzsb001</td>
<td>16842942</td>
</tr>
</tbody>
</table>
This query will return all tasks with program names that start with the module abbreviation (such as an IM query that returns Imzmr001). The query does not return tasks added to one module that are based on a program for another module. For example, CI uses Imzmr001 for Maintain Non-Inventory items, but this will not appear in a CI query.

The following query lists all tasks in order of module and includes long task names. The query lists tasks assigned to a module that come from other modules, such as Imzmr001 for the CI Maintain Non-Inventory Item task.

```sql
SELECT SUBSTRING(tsmTaskStrDef.TaskLongName,1,2) "Module",
RTRIM(SUBSTRING(tsmTaskStrDef.TaskLongName,4,40)) "Menu Item",
LOWER(SUBSTRING(tsmTask.OleProgID,1,8)) "Program Name",tsmTask.TaskID "Task ID"
FROM tsmTask,tsmMenu,tsmTaskStrDef
WHERE tsmTask.TaskID = tsmMenu.TaskID
AND tsmTask.TaskID = tsmTaskStrDef.TaskID
ORDER BY tsmTaskStrDef.TaskLongName
```
This appendix explains errors messages that might appear and recommends solutions for solving them.

In this appendix
- Setup and Configuration Errors .......................... 244
- Registration Errors ........................................ 245
- System Configuration Errors .............................. 249
- Additional Error Messages ................................. 251
Appendix G

Setup and Configuration Errors

Description

This section describes messages that appear as a result of setup and configuration errors. Check the system and Sage MAS 500 configuration to verify everything is correct.

Messages

An error occurred while trying to start Sage MAS 500. Check the tracker log file for details regarding the problem.

This problem may be caused by a problem with the client workstation. To verify that the problem is only with a specific client system, try logging on to Sage MAS 500 from another system. If you can log on successfully, try the following on the defective client system:

- Run the Desktop Configuration Utility to verify the ODBC setup.
- Verify that the client can connect to the SQL Server. Use ISQL or Enterprise Manager to check server communication.
- Verify that the Sage MAS 500 installation did not encounter any errors.
- Run a disk diagnostic tool such as Scandisk to verify that there are no drive errors.

If you cannot log on to Sage MAS 500 from any client system, there might be a problem with the databases. Do the following:

- View the generated log file located in Sage MAS 500 Client\SM\date.tracklog (where date is the current date) in Notepad or any text editor. This file lists information about the error.
- Run database consistency check commands (DBCC) to check the databases. If there are no database errors, refer the problem to your system administrator who can contact your Sage Software business partner (reseller) or Sage Software Customer Support Services for further assistance.
Error Messages

Unable to load <path>sotainst.dll

Verify the SQL Server and communications components have properly installed. ODBC access should be available to the SQL Server where Sage MAS 500 is located.

Unable to register sotaview.dll

Install Crystal Reports, and then reinstall Sage MAS 500.

Registration Errors

Description

The following messages provide information about the registration status. For instructions about registration, see Registering the Software on page 97.

Messages

Your Sage MAS 500 is not registered or the registration has expired. You have xx day(s) to register Sage MAS 500. After the expiration date, you will not be able to access application tasks.

This message appears during the grace period. For information, see Registration Grace Period on page 19. When you register the software, the message stops appearing until the registration expires and a new grace period begins.

Your Sage MAS 500 is not registered or the registration has expired. Please use SM Maintain Site to register the software. If you need assistance, please contact your Sage Software business partner or Sage Software Support.

The 45-day grace period has expired. You do not have access to the system until you register the software.

Your Sage MAS 500 installation is not registered to use the name module. Unable to start the task.

The indicated module is not registered, and the 45-day grace period has expired. You must register the module to use it.
You have reached your Sage MAS 500 license limit of xx concurrent users. Please either close one of the Sage MAS 500 instances currently running on another workstation or purchase more Sage MAS 500 licenses.

You have exceeded the maximum number of concurrent users granted by your license. Another user needs to log off before that user can log on.

Your business date cannot exceed your registration expiration date plus 45 days.

You cannot set the business date, either from the software or in the back end, past the grace period on a system that is unregistered or has an expired registration. Change to a business date within the grace period or register the software.

Your Sage MAS 500 license allows you to run on SQL Server edition SQL Desktop or SQL Standard only. Please contact your Sage Software business partner or Sage Software Support to resolve.

The version of SQL Server you are using with Sage MAS 500 is unregistered. Register SQL Server before using it with Sage MAS 500.

The server side registration component is missing. Please resolve this by installing the Sage MAS 500 database utility on the server.

The database installation is incomplete. Use the Custom installation of the Database Utilities and install the License Server Component. Then, try the registration again. For information about installing the Database Utilities, see Installing the Database Utilities on page 41.
Your Site Information in the Registration Message does not match the data in your current configuration. To resolve, verify the Customer Number, SM Serial Number, and SM Unlocking Key and reregister.

This is caused by either of the following:

- You copied a registration message from a different site into a copy of Sage MAS 500. Submit a registration request from this site.
- SQL Server Scheduler is not set up correctly. Verify that it is set up correctly before attempting automatic registration.

The URL to Sage MAS 500 Registration Web Service site is missing. Please contact your Sage Software business partner or Sage Software Support to resolve.

The URL was deleted from the database when modifications were made on the back end. Contact your Authorized Sage Software Channel Partner or Sage MAS 500 Support for instructions on correcting the deletion.

The requested site is not known by Enterprise Registration Web Services. Please contact your Sage Software business partner or Sage Software Support to resolve.

Verify that you have entered the customer number, System Manager serial number, and System Manager unlocking key correctly. If you have entered them correctly but still get this error, contact Sage Software for assistance.

The requested site is not active in Enterprise Registration Web Services. Please contact your Sage Software business partner or Sage Software Support to resolve.

Contact Sage Software for assistance.
Site information (UserCustomerNo, SMSerialNo or SMUnlockKey) is missing. Please use SM Maintain Site to enter the proper values.

The system attempted to send your registration automatically through SQL Server Agent, but you have not entered the registration information. Enter your customer number, System Manager serial number, and System Manager unlocking key in Maintain Site before attempting to sending the registration information.

The Internet connection is not setup on your Sage MAS 500 database server. Please contact your system administrator to resolve.

The system attempted to send registration information when the Internet connection was down. Verify that your Internet connection is up before sending the registration information. If you have a dial-up connection or trouble with your Internet connection, consider using manual registration.

Your database server cannot connect to Enterprise Registration Web Services through the internet. Please contact your Sage Software business partner or Sage Software Support to resolve.

The system was unable to connect with the Enterprise Registration Web Services database because of a problem at Sage Software or in the Internet connection. Try registering the software again later.
System Configuration Errors

Description
The following messages refer to errors with Sage MAS 500 configuration. Check security settings and installation to resolve these problems.

Message
Security group must be different than the default security group.

In Maintain Users, the default security group must be different than the groups entered into the Company/Group table.

Unable to start the selected task. The task is either not active or not installed on your machine.

Verify the programs for the module you are attempting to access have been installed at the client machine. If necessary, reinstall the client software.

Sage MAS 500 does not support this client’s current regional setting

The client system is set to a regional setting different from the Sage MAS 500 databases. By default, Sage MAS 500 databases are set to English (United States), code 1033. It is recommended that client systems use this locale.

If you need the client workstations to be of a different locale, change the locale of the Sage MAS 500 to one of the following. Only these English-language locales are supported.

<table>
<thead>
<tr>
<th>Locale</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>English (Australian)</td>
<td>3081</td>
</tr>
<tr>
<td>English (Belize)</td>
<td>10249</td>
</tr>
<tr>
<td>English (Canadian)</td>
<td>4105</td>
</tr>
<tr>
<td>English (Caribbean)</td>
<td>9225</td>
</tr>
</tbody>
</table>
Appendix G

Installation and System Configuration

To change the locale, run the following SQL command in Query Analyzer:

```
spChangeLocaleID 'SageAppDB', CurrentLocale, NewLocale
```

Where `SageAppDB` is the application database, `CurrentLocale` is the current locale code (default 1033), and `NewLocale` is the code of the locale to which you want to use. The single quotes around the application database name are required.

For example, to change MAS500_app to English (Australia), execute the following command:

```
spChangeLocaleID 'MAS500_iapp', 1033, 3081
```

Once you have changed the database locale, all of the client systems must be changed to match the locale.

<table>
<thead>
<tr>
<th>Locale</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>English (Ireland)</td>
<td>6153</td>
</tr>
<tr>
<td>English (Jamaica)</td>
<td>8201</td>
</tr>
<tr>
<td>English (New Zealand)</td>
<td>5129</td>
</tr>
<tr>
<td>English (South Africa)</td>
<td>7177</td>
</tr>
<tr>
<td>English (Trinidad)</td>
<td>11273</td>
</tr>
<tr>
<td>English (United Kingdom)</td>
<td>2057</td>
</tr>
<tr>
<td>English (United States)</td>
<td>1033</td>
</tr>
</tbody>
</table>

To change the locale, run the following SQL command in Query Analyzer:

```
spChangeLocaleID 'SageAppDB', CurrentLocale, NewLocale
```

Where `SageAppDB` is the application database, `CurrentLocale` is the current locale code (default 1033), and `NewLocale` is the code of the locale to which you want to use. The single quotes around the application database name are required.

For example, to change MAS500_app to English (Australia), execute the following command:

```
spChangeLocaleID 'MAS500_iapp', 1033, 3081
```

Once you have changed the database locale, all of the client systems must be changed to match the locale.
**Additional Error Messages**

**Description**  
In addition to error messages from Sage MAS 500, you might see error messages from other software applications that work in conjunction with Sage MAS 500. Following is a list of other areas or software applications that might display error messages while you are using Sage MAS 500:

- Microsoft Windows
- Microsoft SQL Server
- Microsoft Visual Basic
- Microsoft Office
- Crystal Reports for Sage MAS 500
- FRx for Windows
- Any ODBC software applications

See the documentation or the product’s support Web site for information about resolving the error.
Index

A
Activation
  correcting unregistered modules 110
modules 109
Admin login
  creating 48
logging in with 94
  password 95
  Windows authentication 96
Adobe Acrobat Reader, installation 6
Advanced Consolidations
demo company 39
  DLL file for 82
Allow read access option 121
Application database
  comparing 60
  creating 51
  creating multiple 132
description of 11
  name of 47
  selecting for login 95
  upgrade script for 54
  upgrading 62
  where to install 46
Application roles (AppRoles) 121
ApplicationAppRole 121
Assisted Company Setup
copying company data 131
  list 163
Automatic registration 100
B
Backup
  for duplicating databases 133
  prior to upgrading 57
  setting up periodic 68
  starting 68
C
CAD software demo, installing 81
Checklist, client installation 76
Client Configuration Utility. See Desktop Configuration Utility
Client installation
  preliminary steps 74
  silent installation 186
  starting 78
Client workstations
  changing installed modules 83
  connecting to moved or duplicated databases 130
description of 12
  file locations 88
Index

Client workstations (continued)
  ODBC and Registry additions 89
  options for software installation 74
  regional setting 249
  reinstalling software 83
  SQL Server and 75
  starting software as administrator 94
  Terminal Services installation 85
  uninstalling software 83

Command-line parameters 190

Companies
  copying data between 131
  creating 106
  deleting 111
  demo 39
  editing 110
  home currency 107
  listing of 162
  multiple in a database set 106
  report on 160
  selecting for login 95

Company List 162

Company Profile report 160

Company User Group Permissions report
  160

Comparisons, database upgrades
  options for 59
  performing 60
  when to do 59

Crystal Decisions. See Crystal Reports

Crystal Reports
  runtime 90
  uninstalling for upgrade 75

Customizations
  database upgrades and 54
  preserving during upgrades 75

Database backup (continued)
  prior to upgrading 57
  setting up periodic 68

Database Creation Utility
  database sizes 51
  description of 45
  selecting databases to install 49
  starting 49

Database Maintenance wizard
  starting after a wizard 52, 65
  starting by itself 66

Database software. See Database Utilities

Database Synchronization Utility, using
  126

Database Upgrade Utility
  performing upgrades 62
  running after Database Utilities instal-
  lation 41
  starting 53, 58
  supported previous versions 53
  when to do a comparison 59

Database Utilities
  creating databases 45
  creating databases without 34
  installing 41
  prerequisites for installing 38
  uninstalling during upgrade 42
  upgrading with 53

Databases
  adding 55
  comparing for upgrade 59
  creating multiple sets 132
  creating new 45
  duplicating 134
  express installation 34
  invalid names 47
  maintenance of 66
  master 12
  naming convention of 47
  populating 46
  preliminary steps 38
  protecting during upgrades 57
  setting size of 51

Data Migrator and DataPorter, grace period
  restriction 20, 104

Data Source Names (DSN) 89

Database backup
  for duplicating databases 133
Databases (continued)
   specifying sizes for 51
   SQL Server upgrades and 57
   tempdb 12
   upgrade log file 65
   upgradeable versions 53
   which to install 46
DBError.log 65
Debugging 152
Default administrative login. See Admin login
Demo data
   contents of 39
   installing 50
Desktop
   application of customizations 138
   loading options 190
   shortcuts and 196
   supported customizations 138
   task menus 139
   user’s task menu 141
Desktop Configuration Utility
   changing client settings with 89
   effects on Terminal Services 85
   location in Windows Start menu 88
   Windows authentication 96
Distributed Management Objects (DMO) 38

E
eCustomer
   restrictions on login names 116
   eCustomer database
      description of 11
      name of 47
   eTimesheets 11
Express installation
   running 27
   system requirements 26
   when to use 24

F
Fail-over clustering 19

G
Grace period
   access during initial period 20
   description 19
   registration expiration 104
Groups, selecting Windows 120

H
Hardware changes, effect on registration 18
Home currency 107

I
Installation
   Adobe Acrobat Reader 6
      checklist 76
      client software 78
      client with Terminal Services 85
   Crystal Reports 90
   Crystal Reports Designer 91
   database express 34
      express 24–32
      manual start of 6
      overview 14
   silent 181
   starting 6
   supplemental software 21
   third-party utilities 7
   web browser 6
Installation and System Configuration guide,
   links in 2
Installation window, using 6
Internet Applications database. See eCustomer database

L
LaunchPad
   activating modules and 110
   starting 96
LaunchPad. See Desktop
License
   number of systems 20
   selecting 99
   types 20
Index

License (continued)
viewing 103
See also Registration
Links, Installation and System Configuration
guide 2
Lists
  Assisted Company Setup 163
  Company 162
  Security Group 162
  Site Profile 162
  User 161
Log file, database upgrades 65
Logging in
  administrative 94
  first-time 95
  restrictions on names 116
  shortcuts and 195
  window for 95
Logs
  Maintenance Audit 159
  purging system activity 158
  System Activity 158
M
Maintain Lookup Views 148
Maintain Lookups 146
Maintain site window 99
Maintain Users 249
Maintenance and support agreements, renewal of 18
Maintenance Audit log 159
Maintenance, database 66
Manual registration
  procedure 101
  when to use 105
Manufacturing
  CAD software demo 81
  prerequisite upgrade steps 76
Master database
  description of 12
Microsoft Office
  registering DLL for 82
Microsoft Project Link
  setup 167
Microsoft Windows
  protocol configurations for 174
Modules
  activation and LaunchPad 110
  changing installed 83
  fixing unregistered 110
  launching directly 191
  security events 115
  tasks 114
MS Project Link, DLL file for 82
Multi-Protocol 176
N
Named Pipes 174
NT authentication. See Windows authentication
O
ODBC, additions for client software 89
P
Packing list, use in registration 97
Passwords
  administrator 95
  clearing 122
  requiring 122
ProcessWebSOUser 123
Production license 21
Program groups 88
Project Link database
  description of 11
  name of 47
Protocols
  Multi-Protocol 176
  Named Pipes 174
  TCP/IP sockets 178
Public security group 114
Purge Activity Log 158
Purging, system activity log 158
Index

R
Read-only access 121
Regional setting
changing 249
selecting 50
Registration
automatic 100
database changes and 127
description 16, 97
fixing activated unregistered modules
110
grace period 19
hardware changes 18
license settings 103
log 102
maintenance and support agreement
renewals 18
manual 101
performing 99
prerequisite steps 97
renewing 104
troubleshooting automatic 105
unlocking information 97
upgrades 16
See also License
Registry, additions for client software 89
Removal. See Uninstallation
Reports
Company Profile 160
Company User Group Permissions 160
using as maintenance tools 157, 165, 169
See also Lists and Logs

S
ScheduleBoardX, upgrading 76
Scripts, upgrade
generating 54
names of generated 54
selecting one for upgrade 62
using generated 63, 64
Security
application roles (AppRoles) 121
Security (continued)
description 13
groups 112
module-specific events 115
read-only access 121
Security events 115
Security Group list 162
Security groups
changing permissions 115
changing settings 122
default 119
deleting 115
description of 13
Desktop customizations and 138
high-level access 114
listing by company 160
listing of 162
order of 113
setting up 112
troubleshooting 249
Serial number 97
Server
in Sage MAS 500 structure 10
See also SQL Server
Server license component 105
Service packs, provided 7
Shortcuts
commands for 191
logging in with 195
Silent installation
client installation 186
Database Utilities 181
using 182
Site Profile list
description 162
using 103
Sockets 178
SQL Server
client software on 75
creating logins 116
creating multiple databases on different 132
Index

SQL Server (continued)

creating multiple databases on same 132
default administrative logins 94
deleting users from 123
duplicate databases on separate 134
fail-over clustering 19
registering after changing 127
reviewing database maintenance in 69
selecting for login 95
upgrading 57
Windows authentication and 13
SQL Server Agent, running 72
SQL Server authentication
default logins 94
Starting client software as administrator 94
Support
contact information 4
debugging information for 152
SysAdmin security group 114
System Activity log 158
System requirements
express installation 26
System Status 152

T

Task IDs
list of 197–240
obtaining 241
Task menus, Desktop 139
Tasks
assigning to security groups 114
launching directly 191, 193, 195
list of 197–240
obtaining ID of 241
TCP/IP
Multi-Protocol 176
Named Pipes 174
TCP/IP sockets 178
Technical support
contact information 4
debugging information for 152
Tempdb
description of 12
Terminal Services
client installation 85
installation with Add/Remove Programs 85
setting changes and 85
when to use 74
Test systems
license for 20
Tracker 152
Transaction logs
creating 51
description of 11
naming convention for 48
Troubleshooting
automatic registration 105
database naming problems 47
maintenance plans 71
Two-tier architecture 10

U

Uninstallation
client software 83
Crystal Reports runtime 75
during client upgrade 75
during Database Utilities upgrade 42
Unlocking keys
entering 99
where to find 97
Upgrade scripts. See Scripts, upgrade
Upgrades
client 75
customized databases 54
Database Utilities 42
log file for databases 65
overview 15
preliminary client software tasks 75
registration 16
uninstalling the client before 75
User list 161
Users
adding to SQL Server 116
Users (continued)
clear passwords 122
deleting 123
listing of 161
restrictions on login names 116
security groups for 112
selecting groups 120
selecting Windows 120
task menu setting 141
viewing logged in 152

W
Web browser, installation 6
Windows authentication
admin login 96
selecting users 120
setting up users 13
Windows Installer, description of 38, 76